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Capitolo 1. Introduzione a GnuCash

Cos’è GnuCash?



GnuCash è un’applicazione per la gestione delle finanze personali e di piccole attività. È progettato per essere facile da usare, ma comunque potente e flessibile. GnuCash permette di registrare le entrate e le uscite, di riconciliare i conti bancari, di monitorare le azioni e di amministrare le finanze della propria attività professionale. È basato sulle leggi fondamentali della contabilità per assicurare registrazioni in bilancio e resoconti accurati.

Capitolo 2. Utilizzare questo documento e ottenere assistenza



Questo documento è consultabile in due modi:
	tramite le descrizioni dei componenti dell’interfaccia grafica (GUI) si accede alle spiegazioni delle opzioni disponibili e alle loro funzioni, con collegamenti alle descrizioni più approfondite e alle istruzioni di utilizzo; Capitolo 4, Panoramica delle finestre e delle opzioni del menu di GnuCash;

	classificando operazioni, compiti, o funzioni a seconda che si tratti di un conto, di una transazione, di un resoconto o altre operazioni particolari. Per esempio possono essere:
	Operazioni sui conti - Capitolo 5, Impostare, modificare e lavorare con i conti

	Operazioni con transazioni e registro - Capitolo 6, Operazioni comuni per le transazioni

	Strumenti e assistenti - Capitolo 8, Strumenti e assistenti

	Resoconti e grafici - Capitolo 9, Resoconti e diagrammi

	Personalizzazione - Capitolo 10, Personalizzare GnuCash






Accedere all’aiuto



Questa finestra viene visualizzata accedendo al menu Aiuto e scegliendo o Guida ai concetti e manuale oppure Sommario (F1). la sezione chiamata «Struttura dei conti - Menu Aiuto»
La finestra di aiuto ha una barra degli strumenti il cui significato è descritto nel seguito.
	Indietro mostra l’argomento visualizzato in precedenza.

	Avanti mostra l’argomento visualizzato in precedenza.

	Aiuto permette di accedere alle pagine di aiuto di GNOME.

	Cerca Inserire qui il termine da ricercare nell’Aiuto di GNOME. Non cerca nell’aiuto di GnuCash.



Il lato destro della finestra di aiuto mostra la pagina attualmente aperta. Il lato sinistro contiene invece la lista degli argomenti. Selezionando uno degli argomenti dell’aiuto, la corrispondente pagina verrà aperta nella finestra di destra.


Guida ai concetti e manuale di GnuCash



La guida è il complemento a questo aiuto; spiega infatti i concetti utilizzati in GnuCash e presenta un esempio che accompagna l’utente attraverso tutte le fasi dell’utilizzo di GnuCash per gestire i propri conti. La guida verrà aperta se si sceglie Aprire la guida per i nuovi utenti nella finestra di Benvenuto in GnuCash!.
Per aprire questa guida selezionare Aiuto → Guida ai concetti e manuale dal menu.
Si raccomanda di leggere questa guida se si sta utilizzando GnuCash per la prima volta o se non si ha familiarità con i concetti della contabilità.

Assistenza on-line di GnuCash



There are several online channels you can access for more assistance.
GnuCash has several mailing lists:
      
	Lista degli utenti <gnucash-user@gnucash.org>: è indirizzata alle domande degli utenti e alle discussioni in generale. Gli sviluppatori e alcuni utenti molto disponibili, si ritrovano qui.

	Lista degli sviluppatori <gnucash-devel@gnucash.org>: vengono discusse le questioni riguardanti la progettazione e lo sviluppo di GnuCash, e la presentazione di patch.



Or you can chat live with the developers on IRC.
        Join them on #gnucash at irc.gnome.org.
The GnuCash web site 
        has more details on these channels. You will also find pointers there
        to additional useful resources such as the GnuCash wiki
        and bug tracking system.

Capitolo 3. Per iniziare



Avviare GnuCash



GnuCash può essere avviato dal menu principale del proprio sistema selezionando la relative voce del menu.
In alternativa può essere avviato da linea di comando con il comando gnucash.
Durante l’avvio di GnuCash verrà mostrata la schermata di avvio di GnuCash in cui sono visualizzate alcune informazioni relative al programma e al processo di caricamento.
Schermata di Benvenuto in GnuCash!



Next you will be presented with
      the Welcome to GnuCash! dialog with three choices:
	Create a new set of accounts: Runs the
          New Account Hierarchy Setup assistant (see la sezione chiamata «Impostare una nuova struttura dei conti»). Select
          this option if you want to be assisted in creating a set of accounts.

	Import my QIF files: Runs the
          Import QIF Files assistant (see la sezione chiamata «Importare i file QIF»). Select this option
          if you already have Quicken files (.qif files) from another
          financial application and wish to import them into GnuCash.

	Open the new user tutorial:
            Opens the GnuCash Tutorial and Concepts Guide. Select this
            option if you are completely new to GnuCash and
            accounting concepts.



Nota
È possibile eseguire le operazioni elencate anche dopo aver effettuato una scelta nella finestra, ma il menu di Benvenuto in GnuCash! non verrà visualizzato di nuovo. Per provare le altre scelte in un secondo momento, consultare la sezione chiamata «Impostare una nuova struttura dei conti», la sezione chiamata «Importare i file QIF» e la sezione chiamata «Guida ai concetti e manuale di GnuCash» per sapere come avviarle dal menu di GnuCash.

Questa schermata è stata pensata per consentire all’utente di GnuCash di iniziare immediatamente a utilizzare il programma. Il pulsante Annulla permette di chiudere la schermata. Premendolo verrà richiesto se Mostrare di nuovo la finestra di benvenuto. Per non far visualizzare di nuovo la schermata di Benvenuto in GnuCash! fare clic sul pulsante No. Fare clic su Sì o premere il tasto Invio della tastiera per selezionare l’opzione predefinita che prevede la riapertura al prossimo avvio della schermata di Benvenuto in GnuCash!.
Nota
Qualsiasi opzione venga selezionata, verrà aperta una finestra di GnuCash minimale. Le operazioni disponibili in questa finestra sono descritte in Capitolo 4, Panoramica delle finestre e delle opzioni del menu di GnuCash.




Impostare una nuova struttura dei conti



Questa procedura assiste l’utente nella creazione di un gruppo di conti in GnuCash. Apparirà se verrà selezionato Crea nuova struttura conti nel menu di Benvenuto in GnuCash!.
Verrà così creato un nuovo file vuoto di GnuCash e avviato automaticamente l’assistente per l’Impostazione di una nuova struttura dei conti.
Suggerimento
Per avviare l’assistente manualmente, andare in File → Nuovo per creare un nuovo file. Per avviare l’assistente all’interno di un file aperto, andare in Operazioni → Nuova struttura conti... quando è visualizzata la scheda della struttura dei conti.

	L’assistente per l’Impostazione di una nuova struttura dei conti si apre con una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.
	Cancel: exit the process and cancel creating
        a new set of accounts.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Back: brings up the previous screen so
        that you can change a previous selection until the first screen.

	Forward: brings up the next
        screen so you can continue through the assistant.




	La schermata successiva permette la Scelta della valuta da utilizzare come predefnita per i conti.
	La lista a comparsa Valuta: è impostata al valore configurato nella scheda Conti delle Preferenze di GnuCash  (la sezione chiamata «Conti»). Per assegnare ai propri conti una valuta predefinita differente, basta selezionarla dalla lista.

	Il tasto Avanti è utilizzato per confermare la selezione e procedere alla schermata successiva.




	La schermata successiva riguarda la Scelta dei conti da creare.
Verrà visualizzata una schermata suddivisa in tre parti
	La parte in alto a sinistra presenta una lista di Categorie per le strutture di conti più comunemente utilizzate. Selezionare dalla lista quella che si desidera utilizzare. È possibile selezionare tutte le categorie che si desidera.

	La porzione in basso a sinistra presenta una Descrizione della categoria che mostra una descrizione dettagliata della categoria selezionata.

	La porzione di destra riporta la lista dei Conti che verranno creati dalla categoria selezionata.

	Il pulsante Seleziona tutto permette di includere tutte le categorie disponibili.

	Il pulsante Cancella tutto permette di deselezionare tutte le categorie selezionate.




	La schermata successiva riguarda l’Impostazione dei conti selezionati che prevede l’inserimento dei Bilanci di apertura e l’eventuale marcatura dei conti come Segnaposto.
Nota
I conti dei capitali non hanno un bilancio di apertura pertanto questo campo è bloccato e impostato a zero da GnuCash.

Nota
I conti segnaposto sono utili per creare una struttura dei conti e normalmente non hanno né transazioni né bilancio di apertura.

Seguire le istruzioni a video su come selezionare un conto e inserire il bilancio di apertura. Un singolo clic permette di selezionare un conto.
	Sul lato sinistro della schermata, c’è una lista dei Nomi dei conti. Selezionare un conto con un singolo sul clic sul suo nome: verrà così aperto il campo del nome per applicare dei cambiamenti.

	Il lato destro fornisce delle opzioni selezionabile attraverso le quali è possibile indicare se il conto è un Segnaposto e un campo per aggiungere il Bilancio d’apertura per il conto selezionato. Anche qui un singolo clic nella colonna del Bilancio d’apertura o nella colonna Segnaposto apre il relativo campo per effettuare dei cambiamenti.




	La schermata di Conclusione della configurazione dei conti è l’ultima e fornisce una descrizione delle tre scelte possibili per terminare l’assistente.
	Cancel: exits the assistant and cancels creating
        a new set of accounts.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Back: brings up the previous screen so
        that you can change a previous selection until the first screen.

	Apply: creates the accounts you have selected.






Si dovrebbe ora avere una struttura dei conti nella finestra principale di GnuCash.

Importare i file QIF



Questo assistente assiste nell’importazione di file Quiken (QIF). Verrà aperto se si seleziona Importare file QIF nella finestra di Benvenuto in GnuCash!.
Per avviare manualmente l’assistente, andare in File → Importa... → Importa QIF....
Nel seguito tutte le schermate che possono essere visualizzate in questo assistente sono descritte in ordine di apparizione.
	L’ assistente per l’Importazione dei file QIF si avvia presentando una finestra contenente una breve descrizione delle sue funzionalità. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.
	Cancel: exit the process and cancel importing
        QIF files.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Back: brings up the previous screen so
        that you can change a previous selection until the first screen.

	Forward: brings up the next
        screen so you can continue through the assistant.




	Nella schermata successiva verrà richiesto di Scegliere un file QIF da caricare. Il pulsante Seleziona... in questa finestra permette di accedere alla lista di file e cartelle aprendo il dialogo per Scegliere il file QIF.
Navigare fino alla posizione in cui sono stati salvati i propri file QIF; selezionare il primo fra quelli che si desidera importare e premere Importa. La schermata successiva visualizzerà il nome del file nella finestra per Scegliere il file QIF da importare..
Nota
Se il file che si sta caricando non possiede una data QIF verrà visualizzata la finestra per Impostare un formato di data per il file QIF. Selezionare quello appropriato dal menu a comparsa e continuare.

Nota
Se il file che si sta caricando non contiene un nome del conto verrà visualizzata la finestra per Impostare il nome predefinito del conto QIF. Diversamente verrà invece visualizzata la finestra descritta nella prossima sezione dove saranno visualizzati i file QIF caricati.
	Il campo del Nome del conto: permette di impostare un nome del conto per il file QIF.





	La pagina successiva visualizza i File QIF che sono stati caricati. È possibile tornare alla pagina precedente e selezionare altri file QIF. Qui è anche possibile eliminare qualsiasi file che sia stato caricato per errore.
	Il pannello superiore visualizza l’elenco dei file QIF che sono stati caricati.

	Il pulsante Carica un altro file riporta alla schermata precedente per aggiungere alla lista un ulteriore file QIF.

	Il pulsante Scarta il file selezionato permette, dopo aver selezionato un file nell’elenco presente nel riquadro superiore, di rimuoverlo dall’elenco.



Quando sono stati selezionati tutti i file QIF da importare, fare clic sul pulsanti Avanti.

	A seconda del tipo di dati contenuti nei file QIF da importare, verranno visualizzate una o più delle seguenti schermate:
	Conti e azioni
	Questa schermata fornisce una descrizione del processo di associazione di Conti e azioni che avverrà nella schermata successiva relativa all’Associazione dei conti QIF ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione dei conti QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi dei conti QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare il conto QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.




	Categorie di entrate e uscite
	Questa schermata fornisce una descrizione del processo di associazione delle Categorie di entrate e uscite nella schermata successiva relativa all’Associazione delle categorie QIF ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione delle categorie QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi della categoria QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare la categoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.




	Beneficiari e promemoria
	Questa schermata fornisce una descrizione del processo di associazione di Beneficiari e promemoria che avverrà nella schermata di Associazione di beneficiari e promemoria ai conti di GnuCash.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione di beneficiari e promemoria ai conti di GnuCash. Verrà mostrata una lista di Nomi di beneficiari e promemoria QIF a sinistra e, a destra, i Nomi dei conti di GnuCash suggeriti. Il conto predefinito di GnuCash utilizzato in questa fase ha un nome Non specificato. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.
Per cambiare il conto di GnuCash è necessario selezionare il beneficiario e promemoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
	Selezionare un conto dalla lista per utilizzarne uno già esistente.

	Il pulsante Nuovo conto permette di inserire un nuovo nome di conto come sottoconto del conto selezionato.

	Il pulsante OK permette di confermare la selezione.

	Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.







	La schermata successiva consente di Immettere la valutadel file QIF. La lista a comparsa fornisce la valuta predefinita configurata nella scheda Conti (la sezione chiamata «Conti»)delle Preferenze di GnuCash. Per utilizzarne una diversa, selezionarla dalla lista.
Dopo aver selezionato la valuta, premere Avanti.

	A seconda del tipo di dati contenuti nei file QIF da importare, potrebbero essere visualizzate una o più delle seguenti schermate:
	Commodity scambiabili
	Questa schermata fornisce una descrizione del processo delle Commodity scambiabili.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

Una serie di schermate per ogni azione, fondo comune o commodity, visualizza il cambio, il nome comnpleto e il simbolo per ogni commodity elencata nel file QIF che si sta importando in modo che sia possibile controllarne le informazioni prima di procedere.

	Transazioni corrispondenti
	Questa schermata fornisce una descrizione del processo di associazione delle Transazioni corrispondenti che avverrà nella seguente schermata di Selezione dei possibili duplicati.
Suggerimento
Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (la sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La schermata successiva permette di Selezionare  i possibili duplicati tra le transazioni. Le transazioni importate sono visualizzate nel riquadro di sinistra e le possibili transazioni corrispondenti sono riportate a destra.
	Il riquadro di sinistra mostra l’elenco delle transazioni importate tra cui selezionare i duplicati.

	Il riquadro di destra mostra l’elenco dei possibili duplicati delle transazioni selezionate per l’importazione. Selezionare quella con la corrispondenza più adatta







	L’ultima schermata, Aggiornare i conti di GnuCash, fornisce una lista di tre scelte possibili per uscire dall’assistente.
	Cancel: exit the process and cancel importing
        QIF files.
Avvertimento
Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.


	Back: brings up the previous screen so
        that you can change a previous selection until the first screen.

	Forward: imports the data and creates the
        accounts you have specified.






A questo punto i conti dovrebbero essere stati importati correttamente.
Suggerimento
Imported transactions might need to be reconciled.
        This process is described in the GnuCash Tutorial and Concepts guide.


Suggerimento del giorno



La finestra del Suggerimento del giorno si apre all’avvio di GnuCash a meno che questa funzione non sia stata disabilitata. I suggerimenti del giorno forniscono dei consigli sulle caratteristiche e sull’utilizzo di GnuCash. In basso nella finestra sono presenti tre pulsanti che permettono di muoversi tra i suggerimenti.
	Chiudi
	Dismiss the Tip of the Day screen

	Prev
	Shows the previous tip

	Avanti
	Shows the next tip



L’opzione Visualizza i suggerimenti all’avvio è utile per abilitare o disattivare il Suggerimento del giorno all’avvio di GnuCash.
È anche possibile configurare l’opzione di avvio del Suggerimento del giorno nella scheda Generali delle Preferenze di GnuCash. Il Suggerimento del giorno può anche essere avviato manualmente dal menu Aiuto → Suggerimento del giorno.

Capitolo 4. Panoramica delle finestre e delle opzioni del menu di GnuCash



La finestra principale di GnuCash mostra i conti, i resoconti, le voci dei menu e gli strumenti disponibili per l’elaborazione dei propri dati finanziari. Questa sezione fornisce una panoramica delle differenti finestre e sezioni di finestre che si incontreranno utilizzando GnuCash.
I collegamenti nelle varie tabelle forniranno ulteriori dettagli sull’argomento.
Finestre e menu di GnuCash



Finestra principale di GnuCash



L’accesso alle schermate secondarie utilizzate più comunemente e agli strumenti del conto, avviene attraverso questa finestra.
Figura 4.1. La finestra principale di GnuCash
[image: GnuCash le parti principali della finestra]Le parti in cui è suddivisa la finestra principale di GnuCash.





All’avvio di GnuCash, dopo un paio di finestre (Schermata di avvio e suggerimento del giorno) apparirà la finestra principale. Questa è suddivisa nelle seguenti sezioni (vedere Figura 4.1, «La finestra principale di GnuCash» per un riferimento):
	Barra del titolo
	Mostra il nome del file aperto e il nome della scheda visualizzata

	Barra del menu
	Visualizza le voci di menu disponibili

	Barra degli strumenti
	Visualizza i pulsanti della barra degli strumenti disponibili

	Barra delle schede
	Elenca i resoconti, i registri e le strutture dei conti aperti

	Riquadro principale
	Lo spazio di visualizzazione principale in cui viene mostrato il contenuto della scheda selezionata

	Barra di riepilogo
	Mostra un riepilogo dei dati finanziari

	Barra di stato
	Contiene una breve descrizione delle voci di menu e una barra di avanzamento



Nota
I contenuti e le opzioni all’interno dei vari menu secondari delle varie sezioni della finestra principale di GnuCash potranno variare in funzione della finestra attiva.

La struttura dei conti è individuata con il nome Conti nella barra delle schede; qui, vengono visualizzati tutti i propri conti e un riepilogo dei rispettivi saldi. I conti sono raggruppati a seconda della tipologia basandosi sullo standard utilizzato nella contabilità.
Suggerimento
Per aprire un ulteriore finestra della struttura dei conti, andare in Visualizza → Nuova pagina dei conti; verrà aperta la struttura dei conti nella finestra esistente.

Suggerimento
Per aprire una nuova finestra con una struttura dei conti, andare in Finestre → Apri la pagina in una nuova finestra.




La scheda dei conti



Figura 4.2. Una visualizzazione della struttura ad albero dei conti.
[image: Schermata della struttura ad albero dei conti]Questa è un’immagine della scheda Conti.






Struttura dei conti - Menu



La barra del menu per la finestra della struttura dei conti contiene le seguenti opzioni:
Struttura dei conti - Menu File



La tabella seguente descrive le opzioni del menu File.
Premendo l’opzione File sulla barra del menu, comparirà un menu «a discesa» contenente le opzioni descritte in Tabella 4.1, «Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».
Tabella 4.1. Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.
	Voce del menu
	Descrizione
	
                  Nuovo file (Ctrl+N)
                
	
                  Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)

	
                  Apri... (Ctrl+O)
                
	
                  Apre un file dei dati di GnuCash già esistente.

	Importa → 
	
                  Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.

	 	
                  Import QIF...
	
                  Avvia il processo di importazione di file QIF.

	 	
                  Import OFX/QFX...
	
                  Avvia il processo di importazione di file OFX/QFX.

	 	
                  Import Accounts from CSV...
	
                  Starts the CSV Account file import process. The file to import must be
                  in the same format as the one exported by GnuCash.

	 	
                  Import Transactions from CSV...
	
                  Starts the CSV Transactions file import process. The file to import must be
                  a delimited file.

	 	
                  Ripeti file log di GnuCash...
	
                  Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.

	 	
                  Importa MT940
	
                  .

	 	
                  Importa MT942
	
                  .

	 	
                  Importa DTAUS
	
                  .

	 	
                  Importa DTAUS e invia
	
                  .

	 	
                  Import Bills & Invoices...
	
                  Open the Import Transactions from text file window.

	 	
                  Import Customers and Vendors ...
	
                  Open the Import Customers and Vendors from text file window.

	
                  Salva (Ctrl+S)
                
	
                  Salva il file attualmente aperto.

	
                  Salva come... (Maiusc+Ctrl+S)
                
	
                  Salva il file attualmente aperto con un altro nome.

                    Avvertimento
NON salvare i file dei dati in ~/.gnucash/books.


                
	
                  Revert

                	
                  Reload the last saved version of the currently opened file. Useful if you need to discard changes
                  made to the data and not yet saved.

                
	
                  Stampa
	
                  Grayed out option.

	
                  Imposta pagina... (Maiusc+Ctrl+P)
                
	
                  Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.

                
	Apre il menu secondario con le voci relative all’esportazione dei conti. → 
	
                  Apre il menu per l’esportazione.

	 	
                  Export Accounts Tree to CSV
	
                  Exports your account hierarchy to a delimited CSV file. Does not
                  export data.

	 	
                  Export Transactions to CSV
	
                  Exports transactions to a delimited CSV file.

	 	
                  Esporta conti
	
                  Exports your account hierarchy to a new GnuCashfile. Does not
                  export data.

	
                  Proprietà (Alt+Inserisci)
                
	
                  Impostazione delle opzioni per il file di GnuCash corrente.

	File aperti di recente
	
                  Lista numerata dei file aperti più di recente daGnuCash.

	
                  Chiudi (Ctrl+W)
                
	
                  Close the current tab.

                  Nota
In the initial Account tree this item is not
                    available - it will be grayed out.


                
	
                  Esci (Ctrl+Q)
                
	
                  Esce da GnuCash.






Struttura dei conti - Menu Modifica



Tabella 4.2. Struttura dei conti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.
	Voce del menu
	
                  Descrizione

	
                  Taglia (Ctrl+X)
                
	
                    Esegue una operazione standard di Taglio.

                  
	
                  Copia (Ctrl+C)
                
	
                    Esegue una operazione standard di Copia.

                  
	
                  Incolla (Ctrl+V)
                
	
                    Esegue una operazione standard di incollaggio.

                  
	
                  Modifica conto (Ctrl+E)
                
	
                  Modifica il nome e le caratteristiche del conto selezionato. la sezione chiamata «Modificare un conto»

                
	
                  Cancella conto... (Cancella)
                
	
                  Rimuove un conto. Consultare la la sezione chiamata «Cancellare un conto»

	Rinumera sottoconti...
	
                 Avvia l’assistente per la rinumerazione dei conti. Consultare la sezione chiamata «Rinumerare i sottoconti».

                  Nota
Questa voce è disponibile solo se è stato selezionato un conto che possiede almeno un sotto-conto.


	Apri conto
	
                 Apre la finestra del registro per il conto selezionato.

	Apri sottoconti
	
                 Apre una finestra del registro che visualizza tutte le transazioni per il conto selezionato e per tutti i suoi sottoconti.

	
                  Trova... (Ctrl+F)
                
	
                  Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.

	Preferences
                (GnuCash → Preferences on Mac OS X).
	
                  Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare la sezione chiamata «Impostare le preferenze».

	Fogli di stile
	
                  Permette di modificare e personalizzare i fogli di stile. Vedere la la sezione chiamata «Modificare i fogli di stile».

	Opzioni resoconto tasse
	
                  Imposta le caratteristiche delle tasse per uno o più conti (solo per Stati Uniti).

                





Struttura dei conti - Menu Visualizza



Tabella 4.3. Struttura dei conti - Menu Visualizza - modifica la vista della finestra.
	Voce del menu
	Descrizione

	Barra degli strumenti
	Selezione per abilitare o disabilitare la visualizzazione della barra degli strumenti.

	Barra di riepilogo
	Selezione per abilitare o disabilitare la visualizzazione della barra di riepilogo.

	Barra di stato
	Selezione per abilitare o disabilitare la visualizzazione della barra di stato.

	Filtra per...
	Imposta il filtro per i conti visualizzati nella finestra della struttura dei conti.

	
                  Aggiorna (Ctrl+R)
                
	Ridisegna la schermata visualizzata.

	Nuova pagina dei conti
	Apre una nuova scheda in cui è visualizzata la struttura dei conti.






Struttura dei conti - Menu Operazioni



Tabella 4.4. Struttura dei conti - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.
	Voce del menu
	Descrizione
	Operazioni online → 
	Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash
	 	
                  Ricevi saldo
	
                  

	 	
                  Ricevi transazioni
	
                  Scarica le transazioni dai conti online

	 	
                  Inoltra transazione...
	
                  Invia una o più transazioni a un conto online

	 	
                  Issue SEPA Transaction...
	
                  

	 	
                  Transazione interna...
	
                  

	 	
                  Addebito diretto...
	
                  

	 	
                  Show log window...
	
                  Open the Online Banking Connection Window

	Transazioni pianificate → 
	menu secondari della voce «transazioni pianificate»
	 	
                  Editor transazioni pianificate
	
                  Richiama lo strumento di modifica di una transazione pianificata. Vedere la la sezione chiamata «Finestra di modifica della transazione pianificata»

	 	
                  Dall’ultimo avvio
	
                  Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. la sezione chiamata «Assistente dall’ultimo avvio»

	 	
                  Rimborso di mutui e ipoteche...
	
                  Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. la sezione chiamata «Assistente per mutui e ipoteche»

                
	Bilancio → 
	Menu secondario per l’impresa
	 	
                  Nuovo bilancio preventivo
	
                  Apre la finestra per la creazione di un nuovo bilancio preventivo.

	 	
                  Apri bilancio preventivo
	
                  Apre un bilancio esistente.

	 	
                  Copy Budget
	
                  Copy a budget.

	Nuovo conto...	
                  Crea un nuovo conto e apre la finestra delle proprietà del conto.

	Nuova struttura conti...	
                  Avvia l’assistente per la creazione di una Nuova struttura conti.

	
                  Trasferimenti... (Ctrl+T)
                
	
                  Avvia la procedura di trasferimento tra conti.

	Riconcilia...
	
                  Open the Reconcile window.   la sezione chiamata «Riconciliare un conto a un estratto conto»

	Liquidazione automatica...
	
                  Apre la schermata di liquidazione automatica dove è possibile inserire le informazioni per la liquidazione automatica.

	Frazionamento azionario...
	
                  Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella la sezione chiamata «Registrare un frazionamento azionario».

	Visualizza lotti...
	
                  Apre la schermata dei lotti nel conto.

	
                Controlla e ripara → 
	
                  Menu secondari della voce Controlla e ripara

	 	
                  Controlla e ripara conto
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.

	 	
                  Controlla e ripara sottoconti
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato e nei suoi sottoconti.

	 	
                  Controlla e ripara tutti
	
                  Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane in tutti i conti.

	Ripristina avvisi...
	
                  GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.

                
	Rinomina pagina
	
                  Apre la casella per rinominare la scheda o la pagina corrente.






Struttura dei conti - Menu Impresa



Tabella 4.5. Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.
	Voce del menu
	
                  Descrizione

	Cliente → 
	
                  Seleziona le operazioni relative al cliente.

	 	
                  Customers Overview
	
                  Apre una pagina con la panoramica dei clienti.

	 	
                  Nuovo cliente...
	
                  Avvia la scheda per la creazione di un nuovo cliente.

	 	
                  Trova cliente...
	
                  Avvia la procedura di ricerca di un cliente.

	 	
                  Nuova fattura...
	
                  Avvia la scheda per la creazione di una nuova fattura.

	 	
                  Trova fattura...
	
                  Avvia la procedura di ricerca di una fattura.

	 	
                  Nuovo lavoro...
	
                  Avvia la scheda per la creazione di un nuovo lavoro.

	 	
                  Trova lavoro...
	
                  Avvia la procedura di ricerca di un lavoro.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Venditore → 
	
                  Seleziona le operazioni relative al venditore.

	 	
                  Vendors Overview
	
                  Apre una pagina con la panoramica dei venditori.

	 	
                  Nuovo venditore...
	
                  Avvia la scheda per la creazione di un nuovo venditore.

	 	
                  Trova venditore...
	
                  Avvia la procedura di ricerca di un venditore.

	 	
                  Nuova ricevuta...
	
                  Avvia la scheda per la creazione di una nuova ricevuta.

	 	
                  Trova ricevuta...
	
                  Avvia la procedura di ricerca di una ricevuta.

	 	
                  Nuovo lavoro...
	
                  Avvia la scheda per la creazione di un nuovo lavoro.

	 	
                  Trova lavoro...
	
                  Avvia la procedura di ricerca di un lavoro.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Dipendente → 
	
                  Seleziona le operazioni relative al dipendente.

	 	
                  Employees Overview
	
                  Apre una pagina con la panoramica dei dipendenti.

	 	
                  Nuovo dipendente...
	
                  Avvia la scheda per la creazione di un nuovo dipendente.

	 	
                  Trova dipendente...
	
                  Avvia la procedura di ricerca di un dipendente.

	 	
                  Nuova nota spese...
	
                  Avvia la scheda per la creazione di una nuova nota spese.

	 	
                  Trova nota spese...
	
                  Avvia la procedura di ricerca di una nota spese.

	 	
                  Procedura di pagamento...
	
                  Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.

	Tabella imposte di vendita
	
                 Visualizza e permette di modificare la lista di tabelle delle imposte.

	Editor termini di pagamento
	
                 Visualizza e permette di modificare la lista dei termini di pagamento.

	Promemoria scadenze ricevute
	
                 Visualizza e permette di modificare la lista dei promemoria delle scadenze per le ricevute.






Struttura dei conti - Menu Resoconti



This is a brief listing of each of the available reports and
        graphs. See la sezione chiamata «Reports Listed By Class» for specific report
        details. Each report or graph may be customized by selecting a different
        Stylesheet or by pressing the Options
        button in the Toolbar.
Tabella 4.6. Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.
	Voce del menu
	
                  Descrizione

	Attività e passività → 
	
                  

	 	
                  Portafoglio avanzato
	
                  

	 	
                  Istogramma delle attività
	
                  

	 	
                  Grafico a torta delle attività
	
                  

	 	
                  Saldo medio
	
                  

	 	
                  Stato patrimoniale
	
                  

	 	
                  Stato patrimoniale usando eguile-gnc
	
                  

	 	
                  Giornale generale
	
                  

	 	
                  Libro mastro generale
	

                
	 	
                  Portafoglio degli investimenti
	
                  

	 	
                  Istogramma delle passività
	
                  

	 	
                  Grafico a torta delle passività
	
                  

	 	
                  Istogramma del patrimonio netto
	
                  

	 	
                  Net Worth Linechart
	
                  

	 	
                  Grafico a dispersione del prezzo
	
                  

	Resoconti per gli affari → 
	
                  

	 	
                  Resoconto venditori
	
                  

	 	
                  Customer Summary
	
                  

	 	
                  Fattura semplice
	
                  

	 	
                  Resoconto dipendenti
	
                  

	 	
                  Fattura elaborata
	
                  

	 	
                  Resoconto di lavoro
	
                  

	 	
                  Payable Aging
	
                  

	 	
                  Fattura stampabile
	
                  

	 	
                  Receivable Aging
	
                  

	 	
                  Tax Invoice
	
                  

	 	
                  Resoconto clienti
	
                  

	Entrate e Uscite → 
	
                  

	 	
                  Flusso di liquidi
	
                  

	 	
                  Prospetto dei capitali
	
                  

	 	
                  Istogramma delle uscite
	
                  

	 	
                  Grafico a torta delle uscite
	
                  

	 	
                  Expenses vs. Day of Week
	
                  

	 	
                  Grafico delle entrate e delle uscite
	
                  

	 	
                  Istogramma delle entrate
	
                  

	 	
                  Grafico a torta delle entrate
	
                  

	 	
                  Prospetto delle entrate
	
                  

	 	
                  Income vs. Day of Week
	
                  

	 	
                  Profitti e perdite
	
                  

	 	
                  Bilancio di previsione
	
                  

	
                  Esempi e personalizzazioni → 
	
                  

	 	
                  Resoconto di benvenuto di esempio
	
                  

	 	
                  Resoconto multicolonna personalizzato
	
                  

	 	
                  Semplice resoconto con esempi
	
                  

	Bilancio → 
	
                  

	 	
                  Budget Balance Sheet
	
                  

	 	
                  Budget Barchart
	
                  

	 	
                  Budget Flow
	
                  

	 	
                  Budget Income Statement
	
                  

	 	
                  Budget Profit & Loss
	
                  

	 	
                  Budget Report
	
                  

	
                  Sommario del conto
	
                  Questo resoconto mostra il saldo del conto selezionato.

	
                  Future Scheduled Transactions Summary
	
                  Report showing a summary of future transactions.

	
                  Resoconto tasse ed esportazione TXF
	
                  Crea un resoconto per le tasse (US) e/o esporta i dati per un software di elaborazione delle tasse (TXF).

	
                  Resoconto delle transazioni
	
                  

	
                  Saved Report Configurations
	
                  Open the screen to manage saved user configured reports.






Struttura dei conti - Menu Strumenti



Tabella 4.7. Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor
	Voce del menu
	Descrizione

	Impostazione dell’Online Banking...
	
                  Avvia la procedura guidata per la configurazione dell’Online Banking se GnuCash è stato compilato con il supporto per l’online banking. la sezione chiamata «Procedura guidata per l’HBCI (Online Banking)»

                
	Editor prezzi
	Strumento per la modifica o l’immissione dei prezzi di titoli e fondi. Maggiori dettagli nella la sezione chiamata «Editor prezzi»

	Editor titoli
	Strumento per la modifica o l’immissione di azioni e commodity. Ulteriori dettagli nella la sezione chiamata «Editor titoli»

	Calcolatore di prestiti
	Ulteriori dettagli nella la sezione chiamata «Calcolatore di prestiti»

	Chiudi libro
	Apre una schermata in cui è possibile inserire le informazioni necessarie alla chiusura del libro contabile corrente.

	Giornale generale
	See la sezione chiamata «Giornale generale»






Struttura dei conti - Menu Finestre



Tabella 4.8. Struttura dei conti - Menu Finestre
	Voce del menu
	Descrizione

	Nuova finestra
	Apre una nuova finestra vuota di GnuCash.

	Apri la pagina in una nuova finestra
	Sposta la scheda corrente in una nuova finestra.

	Opened windows
	A numbered list of open windows.






Struttura dei conti - Menu Aiuto



Tabella 4.9. Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.
	Voce del menu
	Descrizione

	Guida ai concetti e manuale
	Spiegazione dei principi di contabilità e di come applicarli in GnuCash

	Suggerimento del giorno
	Mostra delle brevi note relative a funzioni che potrebbero non essere conosciute.

	Sommario
	Apre questo documento.

	Informazioni
	Mostra la schermata delle informazioni contenente la versione, la licenza e i ringraziamenti di GnuCash.








Struttura dei conti - Pulsanti e icone della barra degli strumenti




La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può essere facilmente nascosta o visualizzata selezionando la voce Visualizza → Barra degli strumenti. Le opzioni visualizzate nella barra variano a seconda delle operazioni disponibili nella scheda attiva.
Una breve descrizione della funzione di pulsante della barra degli strumenti viene visualizzata quando il puntatore del mouse viene mantenuto al di sopra di esso per qualche secondo.
Tabella 4.10. Barra degli strumenti - Finestra dell struttura dei conti
	Pulsanti della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.

	
                  Chiudi (Ctrl+W)
                
	Chiude la pagina dei conti attualmente visualizzata

              Nota
Questa icona non è disponibile se è aperta una sola scheda; è disponibile per quelle successive che vengono aperte.


              
	Apri
	Apre il registro delle transazioni per il conto selezionato.

	Modifica
	Permette di variare le caratteristiche del conto selezionato. la sezione chiamata «Modificare un conto»

	Nuovo
	Avvia la procedura per la creazione di un nuovo conto. la sezione chiamata «Creare un nuovo conto».

	Cancella
	Rimuove il conto selezionato. la sezione chiamata «Cancellare un conto»






Barra delle schede



La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per la struttura dei conti aperti.

Riquadro principale - Struttura dei conti



La schermata della struttura dei conti visualizza la struttura dei conti in ordine gerarchico. Questo permette l’organizzazione dei conti in base alla tipologia.
Suggerimento
Il triangolo (o il segno "+") a fianco del nome del conto, è utilizzato per aprire o chiudere la struttura dei conti. Quando si preme su di esso, l’orientamento della punta cambia da rivolta verso destra a rivolta verso il basso (diventa un segno "-"), per indicare che la struttura ad albero è aperta. Più a destra rispetto al nome del conto principale, saranno visibili uno o più sottoconti che potranno a loro volta avere, a fianco del loro nome, un altro simbolo triangolare (segno "+"); questo indica la presenza di un altro livello di sottoconti.

Nel riquadro principale sono mostrate, di default, quattro colonne: Nome del conto, Tipo, Descrizione e Totale. Per ogni conto, queste informazioni, se disponibili, sono 
Suggerimento
Le colonne visualizzate nella struttura dei conti possono essere personalizzate. Fare clic sull’icona all’estrema destra del riquadro della struttura dei conti per visualizzare una lista a comparsa delle colonne attivabili. Fare clic sul nome della colonna per aggiungerla alla finestra. Fare clic di nuovo sul nome per nasconderla.

Lo stile di visualizzazione predefinito per la finestra della struttura dei conti, è quello a "fascicolatore". Questo è indicato dalla presenza di una scheda nella riga delle schede della finestra principale. Altre schede appariranno a fianco di questa allorché vengano aperti anche dei resoconti, dei registri del conto o altre strutture dei conti.

Barra di riepilogo



La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo attuale, qualsiasi saldo futuro, un saldo per le operazioni liquidate e un saldo di riconciliazione. I conti per le azioni, comunque, visualizzano le quote totali e il loro valore. La barra di riepilogo può essere nascosta o visualizzata selezionando la voce Visualizza → Barra di riepilogo dal menu.

Barra di stato



La barra di stato visualizza dei suggerimenti che forniscono maggiori dettagli sulla voce del menu selezionata e mostra anche una barra di avanzamento quando si sta aprendo o salvando un file o generando un resoconto. La barra di stato può essere nascosta o resa visibile selezionando la voce Barra di stato presente nel menu Visualizza.


Account Register/General Journal



Account Register & General Journal Window



Questa finestra è utilizzata per l’inserimento e la modifica dei dati del conto; fornisce anche degli strumenti per la pianificazione futura delle transazioni, per cercare e per creare dei resoconti sulle transazioni e per la stampa degli assegni.
Per aprire la finestra del registro di un conto, selezionare quest’ultimo nella struttura dei conti e poi andare in File → Apri conto  o premere Ctrl+O: verrà aperta una nuova finestra con il registro del conto. Il pulsante Apri nella barra degli strumenti della finestra della struttura dei conti o il pulsante Salta nella finestra del registro, sono delle possibili alternative.
Figura 4.3. La visualizzazione del registro del conto.
[image: Schermata del registro del conto]Questa è una schermata della scheda Registro del conto.






Suggerimento
L’aspetto del registro del conto è personalizzabile (vedere la sezione chiamata «Cambiare la visualizzazione del registro»).

Nota
I metodi di inserimento delle transazioni sono descritti in maggior dettaglio in la sezione chiamata «Pianificare le transazioni»


Menu del registro dei conti



La barra del menu per la finestra del registro delle transazioni, contiene le seguenti opzioni:
Registro del conto - Menu File



La tabella seguente descrive le opzioni del menu File.
Selezionando la voce File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte in Tabella 4.11, «Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».
Tabella 4.11. Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.
	Voce del menu
	Descrizione
	
                  Nuovo file (Ctrl+N)
                
	
                  Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)

	
                  Apri... (Ctrl+O)
                
	
                  Apre un file dei dati di GnuCash già esistente.

	Importa → 
	
                  Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.

	 	
                  Importa QIF...
	
                  Avvia il processo di importazione di file QIF.

	 	
                  Importa OFX/QFX...
	
                  Avvia il processo di importazione di file OFX/QFX.

	 	
                  Import Accounts from CSV...
	
                  Starts the CSV Account file import process. The file to import must be
                  in the same format as the one exported by GnuCash.

	 	
                  Import Transactions from CSV...
	
                  Starts the CSV Transactions file import process. The file to import must be
                  a delimited file.

	 	
                  Ripeti file log di GnuCash...
	
                  Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.

	 	
                  Importa MT940
	
                  .

	 	
                  Importa MT942
	
                  .

	 	
                  Importa DTAUS
	
                  .

	 	
                  Importa DTAUS e invia
	
                  .

	 	
                  Import Bills & Invoices...
	
                  Open the Import Transactions from text file window.

	 	
                  Import Customers and Vendors ...
	
                  Open the Import Customers and Vendors from text file window.

	
                  Salva (Ctrl+S)
                
	
                    Salva il file attualmente aperto.

                  
	
                  Salva come... (Maiusc+Ctrl+S)
                
	
                    Salva il file attualmente aperto con un altro nome.

                    Avvertimento
NON salvare i file dei dati in ~/.gnucash/books.


                  
	
                  Stampa assegni... (Ctrl+P)
                
	
                    Avvia l’assistente per la stampa degli assegni. Consultare la sezione chiamata «Stampare gli assegni».

                  
	
                  Imposta pagina... (Maiusc+Ctrl+P)
                
	
                  Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.

                
	Apre il menu secondario con le voci relative all’esportazione dei conti. → 
	
                  Apre il menu secondario con le voci relative all’esportazione dei conti.

	 	
                  Export Accounts Tree to CSV
	
                  Exports your account hierarchy to a delimited CSV file. Does not
                  export data.

	 	
                  Export Transactions to CSV
	
                  Exports transactions to a delimited CSV file.

	 	
                  Esporta conti
	
                  Exports your account hierarchy to a new GnuCashfile. Does not
                  export data.

	
                  Proprietà (Alt+Inserisci)
                
	
                    Impostazione delle opzioni per il file di GnuCash corrente.

                  
	File aperti di recente
	
                    Lista numerata dei file aperti più di recente daGnuCash.

                  
	
                  Chiudi (Ctrl+W)
                
	
                    Closes the currently opened transaction register.

                  
	
                  Esci (Ctrl+Q)
                
	
                    Esce da GnuCash.

                  





Registro del conto - Menu Modifica



Tabella 4.12. Registro del conto - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.
	Voce del menu
	
                    Descrizione

                  
	
                  Taglia (Ctrl+X)
                
	
                    Esegue una operazione standard di Taglio.

                  
	
                  Copia (Ctrl+C)
                
	
                    Esegue una operazione standard di Copia.

                  
	
                  Incolla (Ctrl+V)
                
	
                    Esegue una operazione standard di incollaggio.

                  
	Assign as payment...
	
                    Assign as payment the selected transaction.

                  
	Modifica conto
	
                    Apre la scheda per la modifica delle caratteristiche e dei parametri del conto.

                  
	
                  Trova... (Ctrl+F)
                
	
                    Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.

                  
	Preferences
                  (GnuCash → Preferences on Mac OS X).
	
                    Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare la sezione chiamata «Impostare le preferenze».

                  
	Fogli di stile
	
                    Permette di modificare e personalizzare i fogli di stile.

                  
	Opzioni resoconto tasse
	
                    Imposta le caratteristiche delle tasse per uno o più conti (US). Assign tax form and line to account.

                  





Registro del conto - Menu Visualizza



Tabella 4.13. Registro del conto - Menu Visualizza - Modifica le opzioni di visualizzazione della finestra di GnuCash.
	Voce del menu
	
                    Descrizione

                  
	Barra degli strumenti
	
                    Selezione per abilitare o disabilitare la visualizzazione della barra degli strumenti.

                  
	Barra di riepilogo
	
                    Opzione per abilitare o disabilitare la visualizzazione della barra di riepilogo.

                  
	Barra di stato
	
                    Opzione per abilitare o disabilitare la visualizzazione della barra di stato.

                  
	Libro mastro basilare
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Mastro a espansione automatica
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Giornale della transazione
	
                Opzione per la scelta dello stile di visualizzazione del registro.

	Doppia linea
	
                Opzione per abilitare o disabilitare la visualizzazione a doppia linea.

	Sort by...
	
                Imposta il criterio di ordinamento della schermata delle transazioni. Fare clic per aprire la scheda delle opzioni. Per chiudere la scheda delle opzioni premere i pulsanti Annulla o OK.

	 	
                Ordine standard
	
                Mantiene l’ordine normale del conto

	 	
                Data
	
                Ordina per data

	 	
                Data di immissione
	
                Ordina per data di immissione.

	 	
                Data dell’estratto conto
	
                Ordina per data dell’estratto conto (elementi non riconciliati per ultimi).

	 	
                Numero
	
                Ordina per numero.

	 	
                Importo
	
                Ordina per importo.

	 	
                Promemoria
	
                Ordina per promemoria.

	 	
                Descrizione
	
                Ordina per descrizione.

	 	
                Operazioni
	
                Ordina per operazione

	 	
                Note
	
                Ordina per campo delle note

	 	
                Reverse Order
	
                Reverse the sort order.

	 	
                Save Sort Order
	
                Save the sort order between sessions.

	Filtra per...
	Imposta il filtro per i conti visualizzati nella struttura dei conti o nella schermata del registro delle transazioni.

	
                  Aggiorna (Ctrl+R)
                
	Ridisegna la schermata visualizzata.

                  
	Nuova pagina dei conti
	Apre una nuova scheda in cui è visualizzata la struttura dei conti.
	 





Registro del conto - Menu Transazione



Tabella 4.14. Registro del conto - Menu Transazione - accede alle operazioni di modifica della transazione.
	Voce del menu
	Descrizione
	Taglia transazione
	Taglia la transazione selezionata e la mantiene in memoria.

	Copia transazione
	Copia la transazione selezionata nella memoria.

	Incolla transazione
	Incolla la transazione selezionata dalla memoria.

	Duplica transazione
	Inserisce nel registro una copia della transazione selezionata.

	Elimina transazione
	Cancella la transazione selezionata.

	Remove Other Splits
	Rimuove tutte le suddivisioni dalla transazione selezionata.

	Inserisci transazione
	Inserisce nel registro la transazione a cui si sta lavorando

	Annulla transazione
	Blanks all fields in the selected transactions if it has not yet been recorded.

	Invalida transazione
	Invalida la transazione selezionata.

	Riconvalida transazione
	Riconvalida la transazione selezionata.

	Aggiungi transazione di inversione
	Add a copy of the selected transaction with an inverted amount.

	Associate File with Transaction
	Associate a file to the selected transaction.

	Associate Location with Transaction
	Associate a URL to the selected transaction.

	Open Associated File/Location
	Open the file or location associated with the transaction. Available if a
                  file or location was associated to the currently selected transaction.






Registro del conto - Menu Operazioni



Tabella 4.15. Registro del conto - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.
	Voce del menu
	Descrizione
	Operazioni online → 
	Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash
	 	
                  Ricevi saldo
	
                  

	 	
                  Ricevi transazioni
	
                  Scarica le transazioni dai conti online

	 	
                  Inoltra transazione...
	
                  Invia una o più transazioni a un conto online

	 	
                  Issue SEPA Transaction...
	
                  

	 	
                  Transazione interna...
	
                  

	 	
                  Addebito diretto...
	
                  

	 	
                  Show log window...
	
                  Open the Online Banking Connection Window

	Transazioni pianificate → 
	menu secondari della voce «transazioni pianificate»
	 	
                  Editor transazioni pianificate
	
                  Richiama lo strumento di modifica di una transazione pianificata. Vedere la la sezione chiamata «Finestra di modifica della transazione pianificata»

	 	
                  Dall’ultimo avvio
	
                  Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. la sezione chiamata «Assistente dall’ultimo avvio»

	 	
                  Rimborso di mutui e ipoteche...
	
                  Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. la sezione chiamata «Assistente per mutui e ipoteche»

                
	Bilancio → 
	Menu secondario per l’impresa
	 	
                  Nuovo bilancio preventivo
	
                  Apre la finestra per la creazione di un nuovo bilancio preventivo.

	 	
                  Apri bilancio preventivo
	
                  Apre un bilancio esistente.

	 	
                  Copy Budget
	
                  Copy a budget.

	
                  Trasferimenti... (Ctrl+T)
                
	
                  Avvia la procedura di trasferimento tra conti.

	Riconcilia...
	
                  Start the Reconcile process for the selected account.   la sezione chiamata «Riconciliare un conto a un estratto conto»

                
	Frazionamento azionario...
	
                  Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella la sezione chiamata «Registrare un frazionamento azionario».

	Visualizza lotti...
	
                  Apre la schermata dei lotti nel conto.

	Transazione vuota
	
               Sposta la selezione alla transazione vuote sul fondo del registro

              
	Transazione suddivisa
	Espande la transazione selezionata mostrandone le suddivisioni.

	Modifica tasso di cambio
	
               Modifica il tasso di cambio della transazione selezionata.

	Pianifica...
	
               Crea una transazione pianificata utilizzando questa transazione come modello.

	Salta
	
               Salta alla transazione corrispondente nell’altro conto.

	Controlla e ripara → 
	
                    Menu secondari della voce Controlla e ripara

                  
	 	
                    Tutte le transazioni

                  	
                    Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.

                  
	 	
                    Questa transazione

                  	
                    Controlla e ripara le suddivisioni in questa transazione.

                  
	Ripristina avvisi...
	
                  GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.

                  
	Rinomina pagina
	
                   Apre la casella per rinominare la scheda o la pagina corrente.

                  





Registro del conto - Menu Impresa



Gli elementi visualizzati nel menu Impresa sono gli stessi elencati in Tabella 4.5, «Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.».

Registro del conto - Menu Resoconti



Gli elementi visualizzati nel menu Resoconti sono gli stessi elencati in Tabella 4.6, «Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.» a cui si aggiungono quelli elencati nel seguito.
	Resoconto del conto

	Resoconto delle transazioni del conto




Registro del conto - Menu Strumenti



Gli elementi visualizzati nel menu Strumenti sono gli stessi elencati in Tabella 4.7, «Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor».

Registro del conto - Menu Finestre



Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti - Menu Finestre».

Registro del conto - Menu Aiuto



Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».


Registro del conto - Icone e pulsanti della barra degli strumenti



La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può essere facilmente nascosta o visualizzata selezionando la voce Barra degli strumenti dal menu Visualizza. Le opzioni visualizzate nella barra variano a seconda delle operazioni eseguibili nella scheda attiva.
Nota
Le opzioni specifichevisualizzate nella barra degli strumenti variano in funzione delle operazioni disponibile nella scheda corrente.

Una breve descrizione della funzione di un pulsante è visualizzata quando il puntatore del mouse viene mantenuto al di sopra di essa per qualche secondo.
Tabella 4.16. Barra degli strumenti della finestra del registro del conto (registro delle transazioni)
	Pulsanti della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.

	Chiudi
	Chiude il registro.

	Duplica
	Permette di creare una copia della transazione selezionata.

	Cancella
	Cancella dal registro la transazione selezionata.

	Inserisci
	Registra la transazione corrente.

	Annulla
	Annulla la transazione corrente.

	Vuota
	Sposta il cursore nella transazione vuota alla fine del registro.

	Suddivisione
	Mostra tutte le suddivisioni nella transazione selezionata. Questo pulsante è disattivato se è stato scelta l’opzione Visualizza → Mastro a espansione automatica

	Salta
	Salta alla transazione corrispondente nell’altro conto

              
	Pianifica
	Crea una transazione pianificata utilizzando questa transazione come modello.

	Trasferimento
	Avvia l’assistente per il trasferimento di fondi da un conto a un altro.

	Riconcilia
	Start the Reconcile process for the selected account.   la sezione chiamata «Riconciliare un conto a un estratto conto»
               

              





Barra delle schede



La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per le strutture dei conti aperti.

Elenco delle transazioni



L’elenco delle transazioni visualizza tutti i movimenti che sono stati inseriti e un saldo corrente. Presenta anche una transazione vuota da utilizzare per inserire dei nuovi movimenti. Le intestazioni delle colonne variano in funzione del tipo di conto a cui il registro si riferisce. Le intestazioni più comunemente visualizzate sono Data, Descrizione, Trasferimento e Saldo.
Il menu Visualizza permette di modificare lo stile di visualizzazione dell’elenco delle transazioni variando il numero di elementi visualizzati, utilizzando un criterio di ordinamento differente oppure cambiando lo stile per poter visualizzare più facilmente le transazioni. Il pulsante Suddivisione permette di mostrare velocemente tutte le parti di una transazione.

Barra di riepilogo



La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo Attuale, il saldo Futuro, un saldo per le operazioni liquidate, un saldo di riconciliazione e un saldo Minimo previsto. I conti per le azioni, inoltre, visualizzano le quote totali e il loro valore. La barra di riepilogo puVisualizzaBarra di riepilogo dal menu.

Barra di stato



La barra di stato funziona esattamente come già descritto in la sezione chiamata «Barra di stato».


Finestra del resoconto



Finestra di visualizzazione del resoconto



Questa finestra è visualizzata ogni qualvolta viene selezionato un resoconto o un grafico dal menu Resoconti.
Per aprire la finestra del resoconto, selezionare una tipologia di resoconto dalla lista fornita nel menu Resoconti. Verrà aperta una nuova finestra dove sarà visualizzato il resoconto selezionato con uno stile simile a quello di una pagina internet in cui sono visualizzati dei collegamenti attivabili ai dati del conto.
Nota
In funzione della tipologia selezionata, potrebbe essere necessario attendere qualche istante prima che la generazione del resoconto sia terminata. Nella Barra di stato è comunque possibile vedere lo stato di avanzamento della generazione tramite la barra di progressione se questa non è stata nascosta in precedenza.

Figura 4.4. La finestra del resoconto
[image: Schermata del resoconto]Questa è un’immagine del Grafico di entrate e uscite.







Menu Resoconti



La barra del menu per la finestra dei resoconti contiene le seguenti opzioni.
Resoconti - Menu File



La tabella seguente descrive le opzioni del menu File.
Premendo l’opzione File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte in Tabella 4.17, «Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».
Tabella 4.17. Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.
	Voce del menu
	Descrizione
	
                  Nuovo file (Ctrl+N)
                
	
                  Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)

	
                  Apri... (Ctrl+O)
                
	
                  Apre un file dei dati di GnuCash già esistente.

	Importa → 
	
                    Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.

	 	
                    Importa QIF...
	
                    Avvia il processo di importazione di file QIF.

	 	
                    Importa OFX/QFX...
	
                    Avvia il processo di importazione di file OFX/QFX.

	 	
                  Import Accounts from CSV...
	
                  Starts the CSV Account file import process. The file to import must be
                  in the same format as the one exported by GnuCash.

	 	
                  Import Transactions from CSV...
	
                  Starts the CSV Transactions file import process. The file to import must be
                  a delimited file.

	 	
                    Ripeti file log di GnuCash...
	
                    Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.

	 	
                    Importa MT940
	
                    .

	 	
                    Importa MT942
	
                    .

	 	
                    Importa DTAUS
	
                    .

	 	
                    Importa DTAUS e invia
	
                    .

	 	
                  Import Bills & Invoices...
	
                  Open the Import Transactions from text file window.

	 	
                  Import Customers and Vendors ...
	
                  Open the Import Customers and Vendors from text file window.

	
                  Salva (Ctrl+S)
                
	
                    Salva il file attualmente aperto.

                  
	
                  Salva come... (Maiusc+Ctrl+S)
                
	
                    Salva il file attualmente aperto con un altro nome.

                    Avvertimento
NON salvare i file dei dati in ~/.gnucash/books.


                  
	
                  Revert

                	
                  Reload the last saved version of the currently opened file. Useful if you need to discard changes
                  made to the data and not yet saved.

                
	
                  Stampa resoconto... (Ctrl+P)
                
	
                    Stampa il resoconto selezionato.

                  
	
                  Imposta pagina... (Maiusc+Ctrl+P)
                
	
                  Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.

                
	Export as PDF → 
	
                  Exports the displayed report as a PDF file.

	Apre il menu secondario con le voci relative all’esportazione dei conti. → 
	
                  Apre il menu per l’esportazione.

	 	
                  Export Accounts Tree to CSV
	
                  Exports your account hierarchy to a delimited CSV file. Does not
                  export data.

	 	
                  Export Transactions to CSV
	
                  Exports transactions to a delimited CSV file.

	 	
                  Esporta resoconto
	
                  Esporta il resoconto corrente in un file in formato HTML.

	 	
                  Esporta conti
	
                  Exports your account hierarchy to a new GnuCashfile. Does not
                  export data.

	
                  Proprietà (Alt+Inserisci)
                
	
                    Impostazione delle opzioni per il file di GnuCash corrente.

                  
	File aperti di recente
	
                    Lista numerata dei file aperti più di recente daGnuCash.

                  
	
                  Chiudi (Ctrl+W)
                
	
                    Chiude il resoconto corrente.

                  
	
                  Esci (Ctrl+Q)
                
	
                    Esce da GnuCash.

                  





Resoconti - Menu Modifica



Tabella 4.18. Resoconti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.
	Voce del menu
	
                    Descrizione

                  
	
                  Taglia (Ctrl+X)
                
	
                    Esegue una operazione standard di Taglio.

                  
	
                  Copia (Ctrl+C)
                
	
                    Esegue una operazione standard di Copia.

                  
	
                  Incolla (Ctrl+V)
                
	
                    Esegue una operazione standard di incollaggio.

                  
	
                  Trova... (Ctrl+F)
                
	
                    Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.

                  
	Preferences
                  (GnuCash → Preferences on Mac OS X).
	
                    Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare la sezione chiamata «Impostare le preferenze».

                  
	Fogli di stile
	
                    Permette di modificare e personalizzare i fogli di stile.

                  
	Opzioni del resoconto
	
                    Open form to edit/modify report selection criteria, stylesheets,
                     date ranges, and many other parameters.

                  
	Opzioni resoconto tasse
	
                    Imposta le caratteristiche delle tasse per uno o più conti (US). Assign tax form and line to account.

                  





Resoconti - Menu Visualizza



A eccezione di Filtra per..., le voci presenti nel menu Visualizza sono le stesse elencate in Tabella 4.3, «Struttura dei conti - Menu Visualizza - modifica la vista della finestra.».

Resoconti - Menu Operazioni



Tabella 4.19. Menu Operazioni - Permette l’impostazione delle transazioni pianificate.
	Voce del menu
	Descrizione
	Operazioni online → 
	Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash
	 	
                  Show log window...

                	
                  Open the Online Banking Connection Window

                
	Transazioni pianificate → 
	menu secondari della voce «transazioni pianificate»
	 	
                  Editor transazioni pianificate
	
                  Richiama lo strumento di modifica di una transazione pianificata. Vedere la la sezione chiamata «Finestra di modifica della transazione pianificata»

	 	
                  Dall’ultimo avvio
	
                  Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. la sezione chiamata «Assistente dall’ultimo avvio»

	 	
                  Rimborso di mutui e ipoteche...
	
                  Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. la sezione chiamata «Assistente per mutui e ipoteche»

                
	Bilancio → 
	Menu secondario per l’impresa
	 	
                  Nuovo bilancio preventivo
	
                  Apre la finestra per la creazione di un nuovo bilancio preventivo.

	 	
                  Apri bilancio preventivo
	
                  Apre un bilancio esistente.

	 	
                  Copy Budget
	
                  Copy a budget.

	Ripristina avvisi...
	
                  GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.

                  
	Rinomina pagina
	
                   Apre la casella per rinominare la scheda o la pagina corrente.

                  





Resoconti - Menu Impresa



Gli elementi visualizzati nel menu Impresa sono gli stessi elencati in Tabella 4.5, «Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa.».

Resoconti - Menu Resoconti



The items shown in the Reports menu are the same listed in Tabella 4.6, «Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.»
            with the addition of:
          
Tabella 4.20. Report - Reports Menu.
	Voce del menu
	
                  Descrizione

	
                  Save Report Configuration
	
                  Save the current report configuration. If you are not
                    working with a saved report configuration, you will be asked
                    to give it a name.  You will be able to run the exact same
                    report again by using the Reports
                     → Saved Report Configurations
                     menu item.

	
                  Save Report Configuration As...
	
                  Save the current report configuration with a new name.






Resoconti - Menu Strumenti



Gli elementi visualizzati nel menu Strumenti sono gli stessi elencati in Tabella 4.7, «Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor».

Resoconti - Menu Finestre



Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti - Menu Finestre».

Resoconti - Menu Aiuto



Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».


Resoconti - Icone dei pulsanti della barra degli strumenti



La finestra del resoconto è dotata di una barra degli strumenti che permette un rapido accesso alle funzioni utilizzate per i resoconti. La barra degli strumenti può essere nascosta o visualizzata selezionando Visualizza → Barra degli strumenti.
Tabella 4.21. Resoconti - Pulsanti della barra degli strumenti
	Pulsante della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	

	
                  Chiudi (Ctrl+W)
                
	Chiude il resoconto attualmente visualizzato.

	Indietro
	Sposta un passo indietro nella cronologia

	Avanti
	Sposta un passo avanti nella cronologia

	Ricarica
	Ricarica (aggiorna) il resoconto corrente.

	Stop
	Stops the HTML requests.

	Save Report Configuration
                  
	Saves the displayed report. You will be able to
                run the exact same report again by using the Reports → Saved Report Configurations menu item.

	Save Report Configuration As...
                  
	Saves the displayed report in a configuration file
                with a given name. You will then be able to run the exact same
                report again by using the Reports → Saved Report Configurations menu item.

	Apre il menu secondario con le voci relative all’esportazione dei conti.
	Esporta il resoconto in un file di formato HTML.

	Opzioni
	Modifica le opzioni per il tipo specifico di resoconto.

	
                  Stampa (Ctrl+P)
                
	Invia alla stampante il resoconto corrente.

	Export as PDF
	Exports the selected report as a PDF file.






Barra delle schede



La «barra delle schede» visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per le strutture dei conti aperti.

Schermata principale del resoconto



Qui viene visualizzato il resoconto o il grafico selezionato. Le proprietà di questa finestra sono modificabili in due modi. Selezionando il pulsante Opzioni sulla barra degli strumenti, è possibile modificare ciò che viene mostrato dal resoconto e da quale conto vengono prelevate le informazioni. Selezionando Modifica → Fogli di stile... si possono modificare le proprietà della pagina web che visualizza il resoconto.
Il resoconto è in grado di agire come una pagine internet se contiene dei collegamenti a delle pagine esterne. I pulsanti della barra degli strumenti permettono di muoversi Avanti e Indietro attraverso le pagine. Facendo clic sui collegamenti ai nomi dei conti contenuti nel resoconto verranno anche aperte le informazioni nella finestra del registro.
È inoltre possibile esportare il proprio resoconto e effettuarne la stampa attraverso i pulsanti della barra degli strumenti.

Barra di riepilogo



La Barra di riepilogo non è mostrata quando è visualizzato un resoconto.

Barra di stato



La barra di stato funziona esattamente come già descritto in la sezione chiamata «Barra di stato».


Finestra di riconciliazione



Per semplificarne la consultazione, si riporta l’elenco degli argomenti affrontati in questa sezione: la sezione chiamata «Finestra di riconciliazione», la sezione chiamata «Menu», la sezione chiamata «Pulsanti della Barra degli strumenti».
La spiegazione dettagliata del processo di riconciliazione di un conto è fornita in la sezione chiamata «Riconciliare un conto a un estratto conto».
Finestra di riconciliazione



Per aprire la finestra di Riconciliazione, selezionare Operazioni → Riconciliazione... dalla barra del menu o il pulsante Riconciliazione dalla barra degli strumenti in una finestra del registro. Verrà aperta una schermata di Riconciliazione in cui è necessario inserire la Data dell’estratto conto e il Saldo finale. Se si seleziona l’opzione Includi i sottoconti, tutte le transazioni incluse nei sottoconti verranno prese in considerazione per l’operazione di riconciliazione. Premendo il pulsante OK verrà aperta la finestra di Riconciliazione vera e propria in cui è possibile confrontare le transazioni di deposito e di prelievo con il proprio estratto conto.
Tabella 4.22. Componenti della finestra di riconciliazione.
	Componenti
	Descrizione

	Barra del menu
	Contiene i menu utilizzati nella finestra di riconciliazione.

	Barra degli strumenti (icone e/o testo)
	Contiene dei pulsanti utili per accedere alle funzioni più comunemente utilizzate nella finestra di riconciliazione del conto.

	Fondi in entrata
	Questo riquadro a sinistra contiene un elenco di transazioni che depositano sul conto.

	Fondi in uscita
	Questo riquadro a destra contiene un elenco di transazioni che prelevano dal conto.

	Pannello del saldo
	Questo riquadro in basso a destra contiene un elenco dei saldi utili per completare la riconciliazione.





Menu



La tabella seguente descrive le voci di menu presenti nella finestra di riconciliazione.
Tabella 4.23. Menu Riconcilia - permette l’accesso alle informazioni di riconciliazione e ai comandi utili per terminare la riconciliazione o rinviarla.
	Voce del menu
	Descrizione

	Informazioni di riconciliazione...
	Apre la finestra delle informazioni di riconciliazione.

	
                  Termina (Ctrl+F)
                
	Completa la riconciliazione di questo conto.

	
                  Posticipa (Ctrl+P)
                
	Rinvia la riconciliazione di questo conto.

	Annulla
	Annulla la riconciliazione di questo conto.





Tabella 4.24. Menu Conto - permette l’accesso alle operazioni relative al conto.
	Voce del menu
	Descrizione

	Apri conto
	Apre il registro delle transazioni per i conti

	Modifica conto
	Modifica il nome e le caratteristiche del conto selezionato. la sezione chiamata «Modificare un conto»

	
                  Trasferimenti... (Ctrl+T)
                
	Apre la procedura di trasferimento di una transazione tra due conti.

                  
	Controlla e ripara
	Verifica e ripara il conto selezionato se necessario.





Tabella 4.25. Menu Transazione - accede alle operazioni di modifica della transazione.
	Voce del menu
	Descrizione

	Nuovo
	Aggiunge una nuova transazione al conto.

	Saldo
	Apre il registro del conto con una transazione di bilanciamento pre-compilata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.





Tabella 4.26. Menu Aiuto - accesso all’aiuto.
	Voce del menu
	Descrizione

	Aiuto
	Apre questo documento di aiuto.






Pulsanti della Barra degli strumenti



La finestra di riconciliazione è dotata di una barra degli strumenti che facilita l’accesso ad alcune delle funzioni più comunemente utilizzate per la riconciliazione.
Tabella 4.27. Barra degli strumenti della finestra di Riconciliazione
	Pulsante della Barra degli strumenti
	Descrizione

	Nuovo
	Aggiunge una nuova transazione al conto.

	Saldo
	Apre il registro del conto con una transazione di bilanciamento pre-compilata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.

	Apri
	Apre il registro del conto contenente la transazione.

	Termina
	Completa la riconciliazione di questo conto.

                  Nota
Questo pulsante non è attivato finché il valore della Differenza nel riquadro del saldo (in basso a destra) è 0.


                  
	Posticipa
	Rinvia la riconciliazione di questo conto.

	Annulla
	Annulla la riconciliazione di questo conto.








Finestra della transazione pianificata



Per semplificarne la consultazione, si riporta l’elenco degli argomenti affrontati in questa sezione: la sezione chiamata «Menu Pianifica», la sezione chiamata «Pulsanti della Barra degli strumenti per la finestra delle Transazioni pianificate», la sezione chiamata «Finestra della transazione pianificata». la sezione chiamata «Finestra di modifica della transazione pianificata»,
La descrizione dettagliata di cosa si intende per transazione pianificata, è fornita in la sezione chiamata «Pianificare le transazioni».
Finestra principale delle transazioni pianificate



Questa finestra è mostrata quando si seleziona la voce Operazioni → Transazioni pianificate → Editor transazioni pianificate dalla barra del menu. Verrà aperta una finestra che visualizzerà la transazione pianificata.
Componenti principali della finestra per le transazioni pianificate




Tabella 4.28. Componenti della finestra per le transazioni pianificate.
	Componenti
	Descrizione

	Barra del menu
	Contiene il menu utilizzato nella finestra della transazioni pianificate. Fornisce la lista standard delle opzioni della barra del menu e in più la voce Pianifica, che contiene i comandi Nuovo, Modifica e Cancella. Se non è selezionata alcuna transazione, le voci Modifica e Cancella non saranno selezionabili.

	Barra degli strumenti (icone e/o testo)
	Contiene dei pulsanti utilizzabili per accedere alle operazioni relative alle transazioni pianificate.

	Schede
	Permettono di muoversi tra le schermate aperte.

	Transazioni
	Il riquadro Transazioni contiene un elenco di transazioni pianificate e delle relative caratteristiche.

	Prossime scadenze
	Il riquadro delle Prossime scadenze contiene un calendario dei mesi successivi. In questo calendario sono evidenziati i giorni in cui sono pianificate una o più transazioni.

                È possibile modificare l’intervallo di date visualizzato nel calendario selezionando un periodo diverso dalla lista a comparsa Visualizza sulla destra.

                Suggerimento
Fare clic con il mouse nel riquadro e verranno visualizzati i dettagli relativi alle transazioni pianificate per la data selezionata.


                





Menu Pianifica



La tabella seguente descrive le opzioni del menu Pianifica disponibile nella Barr del menu all’interno della finestra delle Transazioni pianificate.
Tabella 4.29. Menu Pianifica - permette di accedere alle operazioni di modifica della transazione pianificata.
	Voce del menu
	Descrizione

	Nuovo
	Aggiunge una nuova transazione pianificata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.






Pulsanti della Barra degli strumenti per la finestra delle Transazioni pianificate



La finestra per le Transazioni pianificate presenta una barra degli strumenti utile per accedere velocemente alle funzioni più comunemente utilizzate per la pianificazione.
Tabella 4.30. Barra degli strumenti della finestra Transazioni pianificate
	Pulsante della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Modifica la transazione selezionata.

	
                  Chiudi (Ctrl+W)
                
	Chiude la finestra delle Transazioni pianificate.

	Nuovo
	Salva la pianificazione della transazione selezionata.

	Modifica
	Modifica la transazione selezionata.

	Cancella
	Rimuove la transazione selezionata.








Budget Window



Actions → Budget → Open Budget will open the
          default budget or offer you a choice if there is more than one budget.
       A new tab will open with the budget displayed.
Budget Window Menus



Here are some menu items that are particularly useful to working with budgets.
Budget Window - Edit menu



Tabella 4.31. Edit Menu - Special items for the budget window.
	Voce del menu
	Descrizione

	Estimate Budget
	Estimate a budget value for the selected
                  accounts from past transactions.

	Delete Budget
	Delete this budget.

	Budget Options
	Edit this budget’s options.






Budget Window - Actions menu




Tabella 4.32. Actions Menu - Items in the standard menu that relate to budgets.
	Voce del menu
	Descrizione
	Bilancio → 
	
                  Opens the Budget sub-menu to select budget actions.

	 	
                  Nuovo bilancio preventivo
	
                  Create a new budget and open it in a new tab.

                
	 	
                  Apri bilancio preventivo
	
                  If no budget exists, create a new budget and open it.
                  If only one budget exists, open it; otherwise user selects one to open.

                
	 	
                  Copy Budget
	
                  If no budgets exist yet, just open a new budget.
                  If only one budget exists, create a copy of it; otherwise user selects one to copy.
                  If a copy is made, then the copy is opened in a new tab.

                





Budget Window - Reports menu



Using more than one budget

        When there is more than one budget, the reports will use the
        budget selected in book options by default. See
        la sezione chiamata «Book Options» and
        la sezione chiamata «Budgeting Book Options Tab» for more details.
        After the report is displayed, the budget it uses can be changed
        in the report options General tab.

Tabella 4.33. Reports Menu - Items in the standard menu that relate to budgets.
	Voce del menu
	Descrizione
	Bilancio → 
	
                  Opens the Budget sub-menu to select a budget report.

	 	
                  Budget Balance Sheet
	
                  

                
	 	
                  Budget Barchart
	
                  

                
	 	
                  Budget Flow
	
                  This report includes information from one budget period at a time.
                  The left column of numbers shows the budgeted amounts, and the right column
                  of numbers shows the actual amounts. It only shows certain accounts, those that
                  have no sub-accounts.

                
	 	
                  Budget Income Statement
	
                  

                
	 	
                  Budget Profit & Loss
	
                  This report is identical to the Budget Income Statement report.

                
	 	
                  Budget Report
	
                  The budget report shows all accounts and all periods. For each period
                  it gives the budgeted amount and the actual amount. There is an option to add
                  another column showing the difference (budgeted - actual).

                






Budget Window Toolbar Buttons



The Budget window has a
          Toolbar to quickly access
          common functions used with budgeting.
Tabella 4.34. Budget Window Toolbar
	Pulsante della Barra degli strumenti
	Descrizione

	
                  Salva (Ctrl+S)
                
	Save the current budget.

	
                  Chiudi (Ctrl+W)
                
	Close the Budget window.

	Opzioni
	Edit this budget’s options.

	Estimate
	Estimate a budget value for the selected
                  accounts from past transactions.

	Cancella
	Delete this budget.






Budget Window Main Display



The budget window contains a list of accounts down the left
      hand side, and a set of columns down the right hand side that
      represent budget values. Each column corresponds to a budget
      period.
      The number of periods for a budget can be changed using the
      Budget Options dialog.
Procedura 4.1. Entering a budget value
	Click the row corresponding to the
      account you wish to budget

	Choose the period this value is for, and click
      in the cell corresponding to that period

	Type the value in the cell

	Press Enter to
      finish editing the value.




Budget Options



Tabella 4.35. Budget options
	Option
	Descrizione

	Budget Name
	The budget name is used in the tab’s name
                  and also in any reports you create with the budget.

	Note
	A description of the budget.

	Budget Period
	The budget period includes when the budget
                  starts (start date) and how long each budget period lasts.

	Number of Periods
	The number of periods in the budget.







Business Windows



Customers Overview



To open the Customers Overview window, click
            Business → Customer
             → Customers Overview.
Tabella 4.36. Customers Overview - Toolbar Buttons
	Toolbar Buttons
	Descrizione

	Nuovo
	Create a new customer

	Modifica
	Edit the selected customer

	New Invoice
	Create a new invoice (by default it is for the selected customer)

	Customer Listing
	Show customer aging overview for all customers





Tabella 4.37. Customer context menu
	Context menu item
	Descrizione

	Rinomina pagina
	

	Edit Customer
	Edit the selected customer

	New Invoice
	Create a new invoice

	Resoconto venditori
	Show customer report





Nota
The customer context menu appears if you right click on a customer in the list.


Vendors Overview



To open the Vendors Overview window, click
            Business → Vendor
             → Vendors Overview.
Tabella 4.38. Vendors Overview - Toolbar Buttons
	Toolbar Buttons
	Descrizione

	Nuovo
	Create a new vendor

	Modifica
	Edit the selected vendor

	New Bill
	Create a new bill (by default it is for the selected vendor)

	Vendor Listing
	Show vendor aging overview for all vendors





Tabella 4.39. Vendor context menu
	Context menu item
	Descrizione

	Rinomina pagina
	

	Edit Vendor
	Edit the selected vendor

	New Bill
	Create a new bill

	Resoconto clienti
	Show vendor report





Nota
The vendor context menu appears if you right click on a vendor in the list.


Employees Overview



To open the Employees Overview window, click
            Business → Employee
             → Employees Overview.
Tabella 4.40. Employees Overview - Toolbar Buttons
	Toolbar Buttons
	Descrizione

	Nuovo
	Create a new employee

	Modifica
	Edit the selected employee

	New Voucher
	Create a new voucher (by default it is for the selected employee)





Tabella 4.41. Employee context menu
	Context menu item
	Descrizione

	Rinomina pagina
	

	Edit Employee
	Edit the selected employee

	New Voucher
	Create a new voucher

	Resoconto dipendenti
	Show employee report





Nota
The employee context menu appears if you right click on a employee in the list.



Capitolo 5. Impostare, modificare e lavorare con i conti



In questa sezione è descritto il processo di impostazione, modifica e funzionamento dei conti di GnuCash. In GnuCash un conto è uno strumento essenziale per organizzare la registrazione della provenienza e della destinazione del denaro. GnuCash estende inoltre il concetto di conto reale, quali il conto bancario o un conto di prestito, per abbracciare anche entrate e uscite. Questo permette di conoscere immediatamente dove il denaro è stato speso e a quanto ammontano entrate ed uscite. GnuCash imposta il tipo di conto (come descritto nella sezione seguente) per assistere nell’organizzazione e nel raggruppamento dei conti. I tipi di conti possono essere utilizzati per creare una struttura dei conti.
Tipi di conti in GnuCash



GnuCash supporta un certo numero di tipi di conti differenti. Si raccomanda di scegliere un tipo di conto appropriato basandosi sull’elenco riportato di seguito.
Avvertimento
The Accounts Payable and Accounts Receivable types are
              used internally by GnuCash’s business features. Transactions involving these accounts  should not be added,
              changed or deleted in any way other than by using
              
	post/unpost bill/invoice/voucher or

	process payment




	   

Tabella 5.1. Tipi di conti in GnuCash.
	Tipo di conto
	Descrizione

	Debiti correnti
	I conti per i debiti correnti sono utilizzati nella contabilità per le imprese allo scopo di registrare gli importi che devono essere pagati. Esempio: l’impresa ha comprato un bene, ma non ha pagato la ricevuta fino a ora.

                  Nota
Le versioni precedenti di questo aiuto definivano D/C e C/C al contrario.


                
	Crediti correnti
	I conti per i crediti correnti registrano gli importi per cui il denaro non è ancora stato ricevuto. Esempio: un’impresa ha venduto un bene ed ha emesso una fattura ma il cliente non ha pagato fino a ora.

                  Nota
Le versioni precedenti di questo aiuto definivano D/C e C/C al contrario.


                
	Attività
	I conti delle attività sono utilizzati per tenere traccia di ciò che ha un valore e può essere utilizzato o venduto per pagare dei debiti (normalmente è un conto segnaposto).

	Banca
	I conti di questo tipo denotano i risparmi o il conto corrente accesi presso una banca o altra istituzione finanziaria. Alcuni di questi conti possono produrre interessi. Questa è anche la tipologia di conto appropriata per il libretto degli assegni il quale preleva direttamente da un conto corrente.

	Liquidi
	Il conto liquidi è utilizzato per indicare il denaro tenuto nel portafoglio, nella scatola delle scarpe, nel salvadanaio o sotto al materasso.

	Carta di credito
	Il conto carta di credito è utilizzato per identificare i conti delle carte di credito. The Credit Card account type is used to denote credit card accounts, both for cards that allow floating lines of credit (e.g. VISA, MasterCard, or Discover) and with cards that do not permit continuing balances (e.g. American Express)

	Valuta
	I conti della valuta erano utilizzati per scambiare le valute, ma sono stati sostituiti dal riquadro per il tarsferimento di valuta presente nella finestra di trasferimento fondi (la sezione chiamata «Transfer Funds Dialog Box»).

	Capitale
	I conti del capitale sono utilizzati per registrare i bilanci di apertura quando si utilizza GnuCash per la prima volta o quando si inizia un nuovo periodo contabile.

	Uscite
	Qualsiasi spesa come il cibo, l’abbigliamento, le tasse ecc... Questa tipologia di conto è identificata come una categoria in Quicken.

	Entrate
	Qualsiasi entrata ricevuta da fonti quali stipendio, interessi, dividendi ecc... Questa tipologia di conti è indicata come una categoria in Quicken.

	Passività
	I conti di passività sono utilizzati per registrare i debiti o le obbligazioni finanziarie. (Normalmente è un conto segnaposto).

	Fondo comune
	Un portafoglio di azioni e bond gestiti da professionisti o altri investimenti comunque divisi in quote.

	Azioni
	Una condivisione di proprietà in una corporazione, che impegna il proprietario a tutti i rischi e premi che questo comporta.





L’assistente per la Creazione di una nuova struttura conti descritto nella prima sezione di questo documento, è un modo pratico per impostare un gruppo di conti da utilizzare come ossatura dei tipi di conti.
Quando vengono creati dei nuovi conti, le scelte disponibili dei tipi di conti vengono colorate in grigio in accordo con il tipo di conto padre. La lista seguente elenca le scelte possibili.
	Debiti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Crediti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Patrimonio: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Banca: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Liquidi: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Carta di credito: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Valuta: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Capitale: solo il conto capitale può essere un conto figlio.

	Uscite: solo i conti di uscite o entrate possono essere conti figli.

	Entrate: solo i conti di uscite o entrate possono essere conti figli.

	Passività: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Fondi comuni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

	Azioni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.





Creare una struttura dei conti



La struttura dei conti è come una indice delle proprie finanze. Il miglior modo per concettualizzare una struttura dei conti è di pensarla come un albero. I rami principali rappresentano intere categorie o gruppi, mentre le foglie dell’albero rappresentano conti bancari o categorie di uscite. Quando viene richiesto un resoconto sommario, tipicamente solo i rami principali vengono riportati, invece che i conti individualmente. Per esempio, una struttura dei conti potrebbe assomigliare alla seguente:


300 Uscite | +--310 Bollette | | | +--311 Birra | | | +--312 Abbonamento TV | +--320 Uscite di lavoro | | | +--321 Dichetti | | | +--322 Dischi Blue Ray | | : :



Codici dei conti
I conti non hanno solo dei nomi; possono avere anche dei codici, per essere ordinati. Quando viene generato un resoconto, l’ordinamento è determinato dalla numerazione. È consuetudine che i numeri dei sottoconti non terminino con zero, mentre i conti padre abbiano numeri crescenti dallo zero.

Avvertimento
GnuCash non impedisce che vengano utilizzati dei numeri duplicati, comunque se ne scoraggia l’utilizzo. I codici dei conti sono trattati come numeri in base 36, quindi, se si terminano i numeri, è possibile utilizzare le lettere dalla a alla z.


Modificare una struttura dei conti



Le modifiche alla struttura dei conti possono essere effettuate direttamente dal riquadro del Conto padre presente nella finestra di Modifica conto. È possibile spostare un conto in qualsiasi parte della struttura. Si raccomanda comunque di mantenere i conti raggruppati a seconda del tipo come descritto in la sezione chiamata «Tipi di conti in GnuCash»; questo aiuta a preservare lo schema della struttura dei conti..
Per spostare il conto selezionato in un differente conto padre è sufficiente selezionare il conto nel riquadro del Conto padre. Se viene selezionato Nuovo conto di livello principale allora il conto verrà spostato al livello principale.

Creare un nuovo conto



Per creare un nuovo conto selezionare Operazioni → Nuovo conto... o fare clic sul pulsante Nuovo della barra degli strumenti quando è visualizzata la finestra della struttura dei conti. Verrà aperta la finestra per la creazione di un Nuovo conto.
La finestre di dialogo delle proprietà per un Nuovo conto consta di due schede, quella delle preferenze Generali e quella del Bilancio d’apertura. 
Creare un nuovo conto richiede la pianificazione di alcuni dettagli che dovranno essere inseriti nella finestra di dialogo per il nuovo conto.
	Il tipo di conto di cui si ha bisogno.

	Dove si deve posizionare nella struttura dei conti.

	Se è previsto un bilancio preventivo.

	Se c’è la necessità di una commodity (titolo/valuta) per il conto.

	Se si ha bisogno dell’aggiornamento online del prezzo della commodity.



Questi dettagli sono descritti nel seguito.
Scheda delle informazioni generali



La scheda Generali permette l’accesso alle informazioni di base del conto. Fornisce un modo di collegare il conto alle informazioni sulle azioni se si tratta di un tipo di conto per la valuta, per i fondi comuni o per le azioni. Qui, il conto può anche essere marcato come segnaposto; viene inoltre mostrato se il conto è identificato come relativo alle tasse (che è configurato attraverso il menu Modifica → Opzioni resoconto tasse).
Sono presenti sette riquadri nella sezione Identificazione di questa scheda.
	Nome conto: il nome per il conto (ad esempio Conto Corrente Banca).

	Codice conto: un codice del conto opzionale come descritto in Codici dei conti.

	Descrizione: una descrizione opzionale per il conto.

	Titolo/valuta: 
Nota
Il campo Tipo alla voce Seleziona titolo dipende dalla selezione fatta nel pannello Tipo di conto nella schermata Nuovo conto.

	Per i conti diversi da Azioni e Fondi comuni questa dovrebbe essere la valuta predefinita cioè EUR (Euro) o il simbolo della propria valuta locale. Se questo conto è per una valuta estera, premere il pulsante Seleziona... per scegliere una valuta differente dalla lista a comparsa delle valute.

	Per i conti contenenti azioni e fondi comuni; selezionare dapprima Azioni o Fondi comuni nel riquadro del Tipo di conto, poi il Conto padre, infine usare il pulsante Seleziona..., per scegliere il Tipo (normalmente il mercato dove il titolo viene scambiato) e il Titolo dalla finestra di Scelta del titolo.
Se il titolo o il fondo di cui si ha bisogno non compare nell’elenco ma se ne conosce il Tipo, è possibile creare il titolo o il fondo. Per creare una commodity per i fondi comuni e per le azioni, selezionare Nuovo..., nella schermata di Scelta del titolo, per aprire la schermata del Nuovo titolo:. Le opzioni presenti sono descritte in la sezione chiamata «Editor titoli». Inserire un Nome, il simbolo, selezionare il Tipo e infine premere il pulsante Chiudi per creare il titolo. Dopo che il titolo è stato creato, selezionare il Tipo: (normalmente la borsa dove il titolo viene scambiato) e il nome nella lista a comparsa Valuta/titolo: e premere Chiudi per chiudere la finestra.




	Frazione minima: la frazione minima che verrà registrata.

	Colore del conto: il colore da assegnare alla scheda del registro relativo a questo conto. Fare clic sul pulsante del colore per aprire la schermata di Selezione del colore. Per ripristinare il colore del conto fare clic sul pulsante Predefinito.

	Notes: This is a free form text box that can be used for any additional notes about
               the account.



Below the panes are 3 check-boxes: one to show if the account is Tax
           Related, one to mark the account as a Placeholder, and one to 
           mark an account Hidden.
The Tax Related check-box means that an account has been
           flagged to be included in the Tax Schedule Report. This flag is only displayed on the Edit
           Account dialog and is set in the Income Tax Information dialog
           (Edit → Tax Report Options).
           See the Tax Schedule Report and TXF Export section in Reports Chapter (la sezione chiamata «Resoconti generali»).
The Placeholder check-box sets an account to read-only status and 
             prevents the addition of transaction data to the account.
Nota
Setting an account to Placeholder will also hide that account in the pop-up 
             account list in a register. Sub-accounts to the placeholder account will still display 
             in the pop-up, however.

The Hidden check box hides an account (and any sub-accounts) in
           the account tree. To reset this option, you will
           first need to open the View → Filter By...
           dialog for the account tree and check the Show hidden accounts option.
           Doing so will allow you to select the account and reopen this dialog.
Nota
Hidden accounts still appear in the pop-up account list in a register. 
             To remove an account from this pop-up account list as well, check the 
             Placeholder check box.

Below these checkboxes is a pane that contains a list of Account Types. Select a type from the
          descriptions in la sezione chiamata «Tipi di conti in GnuCash».
Il riquadro successivo contiene un albero dei conti dal quale scegliere il Conto padre. Per creare un nuovo albero dei conti, selezionare Nuovo conto di livello principale. 
Nota
Le scelte disponibili nel riquadro del Tipo di conto dipendono dalla selezione effettuata nel riquadro del Conto padre. Per esempio se il Conto padre  è Capitali verrà mostrato solamente il Tipo di conto Capitale. Questo permette di mantenere una struttura dei conti coerente.

Procedura per abilitare l’aggiornamento dei prezzi online



	GnuCash si affida a uno strumento esterno per recuperare le quotazioni via internet. Questo strumento è un modulo di Perl denominato Finance::Quote e deve essere installato sul proprio computer indipendentemente da GnuCash. Il primo passo per abilitare l’aggiornamento delle quotazioni tramite internet consiste nell’assicurarsi che Finance::Quote sia installato correttamente.
Per sapere se il modulo di Perl Finance::Quote è già installato nel sistema, digitare «perldoc Finance::Quote» in una finestra del terminale e verificare se c’è qualche documentazione disponibile. Se c’è la documentazione allora il modulo è installato, altrimenti no.
L’installazione di Finance::Quote differisce a seconda del sistema operativo in uso. Per i vari sistemi supportati, è possibile seguire le seguenti linee guida:
	Linux: la maggior parte delle distribuzioni (Fedora, openSuse, Mandriva, Ubuntu, ecc... ) forniscono un pacchetto nei propri repository per il modulo di perl Finance::Quote. Quindi nella maggior parte dei casi è sufficiente utilizzare il proprio gestore di pacchetti preferito (yum, apt, rpm, synaptics, yast, ecc...)  per installare il modulo. Il nome del pacchetto può variare da distribuzione a distribuzione. In genere ha un nome del tipo «perl-Finance-Quote».

	Windows: Finance::Quote on Windows requires perl
              to be installed already. If you haven’t done so, you should first install ActivePerl, or more recently,
              Strawberry Perl.
Il file installabile di GnuCash disponibile sulla pagina principale, contiene un piccolo programma che assiste nell’installazione di Finance::Quote. È possibile raggiungerlo dal menu «Start» nel gruppo GnuCash ed è chiamato «Installa la funzione di ricerca delle quotazioni online».

	Mac OS X: se GnuCash è stato installato dal pacchetto di installazione disponibile sulla pagina principale di GnuCash, Finance::Quote è già installato.

	Se nessuno dei precedenti casi è adatto alla propria situazione, è possibile seguire le seguenti istruzioni più generali:
	Chiude ogni sessione di GnuCash aperta.

	Trovare la cartella dove è installato GnuCash cercando la stringa «gnc-fq-update» (senza le virgolette).

	Spostarsi in questa cartella, aprire una finestra del terminale ed eseguire come root il comando «gnc-fq-update» (senza le virgolette). Si aprirà una sessione di aggiornamento di Perl CPAN che installerà nel sistema, attraverso internet, il modulo Finance::Quote. Il programma gnc-fq-update è interattivo, comunque, con la maggior parte dei sistemi, si potrà rispondere «no» alla prima domanda: «Eseguire la configurazione manuale? [sì]» e l’aggiornamento continuerà automaticamente da questo punto.






Quando l’installazione è terminata, eseguire il programma di test «gnc-fq-dump», nella stessa cartella, distribuito con GnuCash per verificare se Finance::Quote è installato e funziona correttamente.
Nota
If you feel uncomfortable about performing any of these steps, please either email the GnuCash-user
               mailing list (<gnucash-user@gnucash.org>) for help or come to the GnuCash IRC channel on
               irc.gnome.org. More information is available on the GnuCash Wiki FAQ for example
               http://wiki.gnucash.org/wiki/FAQ#Q:_How_do_I_fix_a_.22system_error.22_or_.22unknown_error.22_when_getting_stock_quotes.3F
               You can also leave out this step and manually update your stock prices.


	Creare il conto per il fondo comune o per le azioni impostando il campo titolo/valuta, come descritto nel seguito.
Suggerimento
Quando si creano questi tipi di conti, si consiglia di creare anche dei conti delle entrate per registrare i dividendi, i guadagni in capitale (nel lungo e nel breve periodo) e i conti per le uscite per registrare le commissioni e le perdite ( se si considerano le perdite come uscite).


	Si creino il fondo comune o le azioni sia utilizzando l’editor titoli per le azioni o i fondi esistenti, o la finestra del nuovo titolo perle nuove azioni o fondi.
Selezionare l’opzione Ricevi quotazioni online, il tipo di fonte per le quote e il Fuso orario.
Per la ricezione delle quotazioni via internet, è necessario avere abilitato le opzioni per la ricezione delle quote online e il fuso orario.
	Ricevi quotazioni online - questa opzione permette di abilitare lo specifico titolo o azioni alla ricezione delle quotazioni da una fonte online.

	Tipo di fonte per le quote: selezionare, fra le tre opzioni disponibili, il tipo di fonte da cui ricevere le quotazioni. Le fonti Multi-riga quali «Europe» possono essere usate per superare i problemi di connessione con un unica fonte. Scegliendo invece Singola, verranno ricercate informazioni solo dalla fonte specificata.
Dopo aver selezionato il tipo di fonte per le quotazioni, selezionare un elemento della relativa lista a a comparsa. Attualmente fra le fonti disponibili e supportate, si ricordano: Yahoo, Yahoo Europe, Fidelity Investments, T. Rowe Price, the Vanguard Group, the Australian Stock Exchange (ASX) e TIAA-CREF.
Nota
Si noti che Yahoo fornirà le quotazioni per diversi fondi comuni compresi Fidelity, T.Rowe Price e Vanguard, e che i prezzi indicati da Yahoo dovrebbero essere identici a quelli che è possibile reperire nei siti di origine.

If you are outside the US and use one of the different Yahoo sources or
               multiple sources containing Yahoo, you should append the market code for the security
               such as PA for Paris, BE for Berlin, etc. Example: 12150.PA (a Peugeot security
               in the Paris market).  Tabella A.4, «Yahoo Codes for Exchanges and Markets» below lists suffixes for various
               markets around the world.
Pseudo-simboli per i fondi TIAA-CREF sono elencati nella tabella Tabella A.5, «Pseudo simboli da utilizzare per le quotazioni TIAA-CREF».

	Fuso orario - selezionare il fuso orario per la quota che si desidera ricevere. Per esempio, Yahoo fornisce le quotazioni con il fuso orario della costa orientale degli Stati Uniti, quindi occorre scegliere America/New York se si utilizza questa fonte per le quotazioni.




	Selezionare una commodity nell’editor dei prezzi.

	Selezionare Ricevi quotazioni nella finestra di modifica prezzo.

	Controllare l’ultimo prezzo per il titolo selezionato.



If you wish to update price quotes from the command line, you can do so by
           the following command:
gnucash --add-price-quotes <nome-de-file-di-gnucash>
          
Il comando gnucash --add-price-quotes <gnucash-file-name> può essere utilizzato per ottenere il prezzo corrente delle proprie azioni. Il file specificato «<gnucash-file-name>» dipenderà dal nome e dalla posizione del proprio file dei dati. Questo può essere individuato dal nome visualizzato nella cornice in alto nella finestra di GnuCash prima del «-». Il nome del file può anche essere trovato nel menu File nell’elenco dei file recentemente aperti; il primo elemento, numerato 1, è il nome del file attualmente aperto.
This can be automated in Mac OSX by creating a crontab entry. For example, to update your file every Friday
          evening (18:00) after markets close (modify the time accordingly for your time zone), you could add
          the following to your personal crontab:
0 18 * * 5 /path/to/gnucash --add-price-quotes /path/to/gnucash-filename > /dev/null 2>&1'
For Linux, which needs dbus, usually started by the desktop
            manager, to communicate with dconf or gconf:
0 18 * * 5 env `dbus-launch` sh -c 'trap "kill $DBUS_SESSION_BUS_PID" EXIT; /path/to/gnucash
            --add-price-quotes /path/to/gnucash-filename > /dev/null 2>&1'
Si ricordi che i «prezzi» dei fondi comuni rappresentano dei «valori di capitale netto (NAV)» e richiedono diverse ore dopo la chiusura dei mercati per essere disponibili. Se i NAV vengono scaricati prima del giorno in cui vengono determinati, si riceveranno i valori del giorno precedente.


Scheda del bilancio di apertura



The Opening Balance tab is visible only when creating a new account, and is disabled for Stock and Mutual Fund accounts. In the latter case, opening balances must be created by hand. Please see Section 8.5.1 in the Tutorial and Concepts Guide for instructions if you need to create an opening balance in a Stock or Mutual Fund account. It is
           used to record the beginning balance for an account. This allows it to be used for
           two different scenarios. If using GnuCash for the first time to record transactions,
           it can be used as a beginning balance. If the accounts in use are closed at the end
           of a period and new accounts are created, it is used to close and carry balances
           forward.
In questa scheda sono presenti tre riquadri. Quello superiore contiene le Informazioni sul saldo.
	Saldo: immettere il saldo con cui inizializzare il conto.

	Data: la data con cui il bilancio di apertura deve essere registrato.



Il riquadro successivo è quello del Tipo di trasferimento.
	Utilizza il conto del capitale per i bilanci di apertura: in questo modo si trasferisce il bilancio di apertura per il conto da un conto standard del capitale chiamato bilanci di apertura.

	Selezionare il conto di trasferimento: questa opzione abilita il riquadro inferiore in modo che un conto differente possa essere utilizzato per trasferire il bilancio di apertura.



L’ultimo riquadro è quello del Conto di trasferimento. Selezionare il conto da utilizzare per il bilancio d’apertura scegliendo fra quelli della lista nel riquadro.


Modificare un conto



La finestra di modifica del conto consta di una sola scheda per le informazioni generali. Questa finestra presenta le stesse informazioni che sono già state descritte in la sezione chiamata «Creare un nuovo conto». Per accedere alla finestra di Modifica conto andare in  Modifica → Modifica conto (scorciatoia di menu Ctrl+E) o premere il pulsante Modifica della barra degli strumenti nella finestra della struttura dei conti.

Rinumerare i sottoconti



Utilizzare Rinumera sottoconti per riassegnare i codici dei conti per tutti i figli del conto padre corrente. Per esempio, se si ha la seguente struttura dei conti:
Tabella 5.2. Numeri iniziali dei conti.
	Codice
	Nome

	10
	Colori

	10-1
	Rosso

	10-2
	Arancione

	10-3
	Giallo

	10-4
	Blu

	10-5
	Viola





Si voglia ora aggiungere il conto «Verde», ma si voglia anche inserirlo tra i conti «Giallo» e «Blu». Invece di dover rinumerare tutti i conti manualmente a partire dal «Blu», si può usare il comando Rinumera sottoconti per il conto «Colori». Nella finestra che comparirà il valore della voce prefisso dovrebbe essere già impostata a «10», il codice del conto «Colori». Se si imposta un valore dell’intervallo pari a «5» e si preme Rinumera, si otterrà la seguente struttura:
Tabella 5.3. Numeri dei conti rinumerati
	Codice
	Nome

	10
	Colori

	10-05
	Rosso

	10-10
	Arancione

	10-15
	Giallo

	10-20
	Blu

	10-25
	Viola





Ora è disponibile lo spazio necessario nella numerazione dei conti per aggiungere il conto Verde con un codice adatto per inserirlo dove si desidera.
Tabella 5.4. Numeri finali dei conti.
	Codice
	Nome

	10
	Colori

	10-05
	Rosso

	10-10
	Arancione

	10-15
	Giallo

	10-18
	Verde

	10-20
	Blu

	10-25
	Viola






Cancellare un conto




Cancellare un conto significa rimuovere dal file tutte le informazioni sulle transazioni e le informazioni del conto stesso. L’operazione di cancellazione non può essere annullata. Verrà richiesto di confermare la rimozione del conto. Se il conto contiene ancora delle informazioni sulle transazioni, si verrà avvertiti che il conto contiene ancora delle transazioni..
Un effetto conseguente alla rimozione di un conto che contiene delle transazioni, è che ci si ritroverà con dei conti non bilanciati. Questo fatto verrà indicato nel conto con un segno di spunta vicino agli importi di debito e credito. È possibile riparare automaticamente questi conti non bilanciati utilizzando il menu Operazioni → Controlla e ripara. Automaticamente verranno assegnati gli importi non bilanciati a un nuovo conto denominato Sbilancio.

Riconciliare un conto a un estratto conto



In GnuCash la riconciliazioni dei conti con gli estratti conti bancari o di qualsiasi altra istituzione finanziaria, è un modo di controllare l’accuratezza delle proprie transazioni (e di quelle della banca) e il saldo dei propri conti. È anche un’operazione utile per rintracciare gli assegni non riscossi e altre transazioni insolute.
The reconciling process in GnuCash involves two dialogs: the
      la sezione chiamata «Reconciling Information» dialog followed by the la sezione chiamata «Riconcilia» window. They provide access
      to various GnuCash functions to make it easy to enter and update
      account information during the reconciliation.
Suggerimento
The Reconcile window is accessed from the account tree window or the account register window by
        going to Actions → Reconcile...
        or using the menu shortcut Alt+A, R.

The Summary Bar at the bottom of the Account Register Window indicates the amounts
         of Present (Balance), Future (Balance), Cleared
         (Transactions), Reconciled (Transactions) and
         Projected Minimum. On-line account information can be used to
         mark which transactions the bank has processed by changing the R (reconciliation status)
         column in the register from n (new) to c (cleared). The bank statement is then used
         with the Reconcile window to reconcile the account which changes the R field to
         y (reconciled).
Reconciling Information



The Reconcile Information dialog is used to indicate the closing Statement Date
        and the Starting Balance (fixed from last reconciliation) and Ending Balance
        from the statement. The Include Sub-accounts check-box is used if one or more subaccounts are used to track
        the account you are reconciling. The Enter Interest Payment button is used to add a transfer to the
        accounts for an interest payment. If selected a dialog will be displayed to add the
        la sezione chiamata «Interest Payment» to the account.
Nota
The Enter Interest Payment button is shown only if you are reconciling an account of
          Bank type.

When you have entered all relevant data, press Ok to proceed to the
        la sezione chiamata «Riconcilia» dialog or Cancel to discard the reconciliation process.
Interest Payment



There are three panes in the Interest Payment dialog. At the bottom is a
            button called No Auto Interest Payments for this Account which will cancel the
            dialog. The top pane contains the Payment Information.
	Importo: inserire l’importo degli interessi.

	Data: selezionare la data del pagamento degli interessi.

	Nr.: inserire un numero per la transazione (opzionale).

	Descrizione: inserire una descrizione per la transazione.

	Promemoria: inserire una nota riguardante la transazione (opzionale).



The Reconcile Account pane highlights in the tree the account that the
            interest payment will be transferred to or from.
The Payment From pane contains a list of accounts where you can select the source
            account.
Nota
If the payment is for a credit or loan account then usually the payment would be from an
              Expense account. If the payment is for a checking or savings account then
              usually this would be from an Income account.

Suggerimento
The Show Income/Expense check-box shows or hides the
              Income and Expense accounts.

Select OK to enter the interest transaction (or Cancel
            the payment) and return to the initial reconciliation screen.


Riconcilia



Nota
For a detailed description of menu items and buttons on the reconcile window, see
            la sezione chiamata «Finestra di riconciliazione».

The Reconcile dialog is where the actual process of matching your statement
          to GnuCash data takes place on a per transaction basis.
The Reconcile dialog is composed by a toolbar and three
          panes; Funds In on the left, Funds out on the right and a balance pane.
Nota
If you enabled the option Use formal accounting labels in the
            Accounts section of the GnuCash preferences,
            you will see Debits and Credits panes instead of
            Funds In and Funds Out panes.

The Funds In and Funds Out pane shows all unreconciled
          deposits to the account. Both panes are composed by five columns.
Suggerimento
To order the listed transactions with a preferred criteria, click on the relevant column header.
            To reverse the selected order click a second time on the column header.

	Data
	The date of the unreconciled transaction.

	Num
	The number of the unreconciled transaction.

	Descrizione
	The Description of the unreconciled
                transaction.

	Importo
	The Amount of the unreconciled transaction.

	R
	Shows a green tick if the transaction will be
                reconciled when done.



To mark a transaction as reconciled just click on it and a green checkmark will appear
          on the relevant R column.
Nota
Under each pane a Total for
            reconciled transactions is shown.

The balance pane shows a summary of the balances used in
          reconciliation.
	Data dell’estratto conto
	The date on the statement set on the la sezione chiamata «Reconciling Information».

	Starting Balance
	The balance at the end of the last reconciliation.

	Ending Balance
	The balance entered from the statement.

	Reconciled Balance
	The balance of selected transactions.

	Difference
	The difference between the Reconciled and
                Ending balances.



The set of unreconciled transactions in the Funds In and Funds Out panes can
          be changed by using the menus and Toolbar to access the account and transaction
          information. You can create a New transaction, Edit a selected transaction,
          add a Balance transaction (of the same amount as listed under Difference in the balance pane),
          and delete the selected transaction.
Suggerimento
To modify a listed transaction, double click on it.

By pressing the Open icon the register of the account to reconcile will be opened.
If you wish to postpone the reconciliation until later use the
          Reconcile → Postpone
          menu item (menu shortcut Ctrl+P) or pressing the
          Postpone icon. If you wish to cancel the reconciliation use the
          Reconcile → Cancel menu item or press the
          Cancel icon.
All previous command are also available in the Reconcile dialog menu.
Select each unreconciled transaction matching a transaction on the statement so a
          green tick appears in the R column. The Balance pane changes to reflect each
          selected transaction until the Ending Balance equals
          the Reconciled Balance and the Difference is zero.
          Once this is done select the Finish button or
          Reconcile → Finish
          (menu shortcut Ctrl+F) to finish the reconcile process.


Capitolo 6. Operazioni comuni per le transazioni



A transaction represents the movement of money from one account to another account. Whenever you spend or
  receive money, or transfer money between accounts, that is a transaction. In GnuCash transactions always involve
  at least two accounts.
GnuCash utilizza i conti come metodo per raggruppare ed organizzare la registrazione delle transazioni. Questa sezione descrive i metodi che GnuCash fornisce per aiutare ad inserire velocemente nel registro le transazioni.

GnuCash permette di inserire le transazioni in diversi modi.
	Immettere le transazioni direttamente dalla finestra del registro rappresenta il metodo più immediato.

	Using the Transfer Funds window .

	Importing transactions either from a QIF/OFX file or via
      "OFX on-line banking".



Cambiare la visualizzazione del registro



GnuCash fornisce diverse opzioni per cambiare il modo in cui viene visualizzato il registro permettendo di mostrare con più chiarezza le transazioni. Lo stile predefinito è quello a "libro mastro basilare": con questa modalità viene mostrata una singola linea per ogni transazione e si tratta del metodo più sintetico per la visualizzazione dei dettagli più rilevanti.
Lo stile di visualizzazione predefinito può essere cambiato dal menu Visualizza: qui sono possibili tre scelte. Quando al finestra del registro viene chiusa, lo stile tornerà a essere quello del libro mastro basilare. Per rendere il cambiamento permanente occorre cambiare lo stile nella scheda Predefinite del registro delle Preferenze di GnuCash.
	Libro mastro basilare: lo stile predefinito costituito da una riga per transazione. Le suddivisioni sono mostrate come sommario. Il pulsante Suddivisione e lavoce del menu Operazioni → Suddividi transazione sono abilitati.

	Mastro ad espansione automatica: questo stile espande automaticamente la transazione selezionata se contiene delle suddivisioni.

	Giornale della transazione: questo stile espande tutte le transazioni in modo da poterle visualizzare completamente.

	Doppia linea: questa opzione agisce sugli stili appena descritta visualizzando una riga aggiuntiva per le note della transazione.



Le altre due opzioni per cambiare la visualizzazione del registro sono: Visualizza → Filtra per... per restringere il numero di elementi visualizzati, e Visualizza → Ordina per.... la sezione chiamata «Registro del conto - Menu Visualizza».


Transfer Funds Dialog Box



The Transfer Funds Dialog Box, accessed
    via Actions → Transfer... or its
    shortcut or by pressing the Transfer icon
    from the account register tab, serves two purposes in
    GnuCash: 
	A way to
    create a simple (i.e. two-split) transaction between arbitrary
    accounts.

	Collect exchange rate or amount
    information in a multi-currency transaction (see la sezione chiamata «Multiple Currency/Commodity Transactions»).




    
Nota
The Basic Information and
    Transfer Accounts panes will be disabled in
    the Transfer Funds dialog when it is being
    used only to collect exchange rate or amount
    information.

Basic Information



 The Basic Information section collects the entries for
    constructing a transaction: Date, description, amount, etc.
	Amount: The amount of the transaction in the Transfer Fromaccount's commodity.

	Date: The posting date for the
      transaction, i.e. the date that you want to record it in your
      book.

	Num: A reference number for the
      transaction, often a check number.

	Description: The description of
      the transaction, often the payer or payee.

	Memo: Additional information you
      might want to note about the transaction. Anything entered here
      will be added to the Memo fields of
      both splits.




Transfer Accounts



The Transfer From and
    Transfer To tree views are used to select the
    accounts which will participate in the transaction. They normally
    show only Asset and Liability accounts. If you need to use an
    Income or Expense account in one of them, check the Show
    Income/Expense checkbox below the appropriate
    view.
	Choose the Transfer From account.

	Choose the Transfer To account.




Currency Transfer



 The Currency Transfer pane is used to
    collect the needed information to enter the amount of the
    Transfer To split. You may enter either a
    price or an amount and GnuCash will
    compute the other. If you have Online Price Retrieval installed
    (see la sezione chiamata «Procedura per abilitare l’aggiornamento dei prezzi online») you can use the
    Fetch Rate button to retrieve a current
    quote.
The Currency Transfer pane is enabled
    only if the selected accounts use different commodities or the
    Transfer Funds dialog was launched to collect
    price or amount information from editing a transaction in the
    register. 
The Currency Transfer pane is organized
    as a radio group with two selections, Exchange
    Rate and To Amount. Each consists
    of a radio button and a numeric entry.
 If a relevant price is available in the price database (see
    la sezione chiamata «Aggiungere manualmente il prezzo di un’azione») the Exchange
    Rate will have that as a default entry.
	Select the Exchange Rate radio
      button if you want to enter a price or use the Fetch
      Rate button.

	Select the
      To Amount radio button if you want to enter
      the amount of the To Account
      split.

	Enter the price/exchange rate or the amount in the
      numeric entry corresponding to radio button you
      selected. GnuCash will calculate the
      other amount for you when you exit the field. If it's enabled
      you can use the Fetch Rate button to
      retrieve a current quote.



Nota
If you have created a price in the Price
      Editor (see la sezione chiamata «Aggiungere manualmente il prezzo di un’azione») for the current date quote
      retrieval will not update that price. You must first delete the
      manually-created prce in the Price Editor
      before clicking the Fetch Rate
      button.

Nota
The Fetch
      Rate button will immediately create or replace a
      price in the Price Editor unless there is
      an existing manually-created price for
      today.


Finishing Up



Select OK to commit the transaction
    (or confirm the price/amount) or Cancel to
    dismiss the dialog without entering the
    transaction.
Nota
When committing a transaction or
    confirming an exchange rate the price on the transaction date in
    the Price Editor may be updated. See la sezione chiamata «Editor prezzi» for details.



Inserire una transazione dal registro



All’apertura della finestra del registro per un conto, viene visualizzata la lista delle transazioni per quel conto. Questa finestra presenta lo stesso nome del conto sulla scheda. I menu contengono varie funzioni che permettono di modificare la visualizzazione delle transazioni. Anche la barra degli strumenti contiene delle funzioni comunemente utilizzate per manipolare le transazioni; esse sono descritte nella sezione la sezione chiamata «Account Register & General Journal Window» di questo documento.
Inserimento diretto dalla finestra del registro



The register window will look slightly different depending on the style options you have chosen.
      The following describes entering simple transactions in the basic ledger style. The cursor is placed
      in the date field by default when the register window is opened.
Nota
When working on transactions in GnuCash, be aware that the
        Enter key and the Tab key behave
        differently, and perform different actions.
The Enter key moves to the first field of the next split,
        regardless of which field you are in. If there is no next split, proceeds to the next transaction.
        In any case, Enter finishes the transaction edit, and any
        imbalance is posted to Imbalance-CUR, where CUR is the
        currency of the transaction.
The Tab key moves to the next field in the current split.
        If it's the last field, moves to the next split, creating a new one if there isn't one. If the
        split is blank, the Tab key finishes the transaction and posts any
        imbalance to Imbalance-CUR, as above.

	Selecting the small icon on the right of the date field drops down a date selection calendar.
          Use the arrows to select the correct month and year for the transaction then select the date.
          Selecting the icon once more will close the date selection calendar. It is also possible to
          type in the date or part of the date and let GnuCash fill the rest.

	Premere Tab per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente assegnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

	Premere di nuovo Tab per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di completare automaticamente il nome del beneficiario mentre si starà scrivendo.

	A questo punto possono accadere due fatti alla pressione del tasto Tab: se GnuCash individua una transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando automaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel campo del Trasferimento quando è visualizzata una sola riga per la transazione.

	 Accounts may be selected either by typing them in or
          by pressing the small button on the right of the
          Transfer field, which will display a
          pick list of all non-placeholder accounts. Note that this pick list
          will still display hidden accounts. If you have hidden an account in
          your chart of accounts, you may want to set the account also to be
          a placeholder account so that it doesn't display here.
          
 When typing, GnuCash will
          fill in available accounts as you type. For example, if you
          have Equity and
          Expenses top-level accounts, typing
          E will fill in Equity because it sorts before
          Expenses. Continuing to
          type x will present Expenses the account separator
          (: by default, see la sezione chiamata «Conti»Account Preferences about
          changing it) will accept the currently offered account so
          that you can start typing the name of a child
          account.

	Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto nella sezione la sezione chiamata «Riconciliare un conto a un estratto conto».

	Press the Tab key to move to the first of the amount fields. The names of the next two columns are different
          according to what type of account is opened. For example, Bank accounts show Deposit and
          Withdrawal here, Credit Card accounts show Payment and
          Charge, and Stock accounts show Shares, Price,
          Buy and Sell.

	Inserire un importo per la transazione nel campo corretto. Quando la transazione è «bilanciata» premendo il tasto Invio, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione verrà aggiunta al registro la transazione. Selezionando il pulsante Elimina o andando in Transazione → Elimina transazione verrà cancellata la transazione.

	Transactions with just one transfer account will show the name of that account in the Transfer
          field in completed transactions. (The Transfer field is the fourth (4) from the left in the register
          display.)

	Per spostarsi alla transazione vuota alla fine del registro, premere il pulsante Vuota sulla barra degli strumenti o andare in Operazioni → Transazione vuota.





Transazioni con suddivisioni multiple



La finestra del registro può apparire leggermente diversa in funzione delle opzioni di visualizzazione selezionate. Nel seguito verrà descritto il processo di inserimento di una transazione con suddivisioni multiple quando lo stile del registro è impostato a quello di libro mastro basilare. In GnuCash una suddivisione si ha quando il denaro è trasferito da o verso due o più conti per una stessa transazione. Il cursore viene automaticamente posizionato nel campo della data all’apertura della finestra del registro.
Le righe per i conti multipli non saranno visualizzate nella modalità a libro mastro basilare a meno che non vengano selezionati o il pulsante Suddivisione o l’opzione Operazioni → Suddividi 
	Selezionando la piccola icona a destra del campo della data, verrà visualizzato un calendario da cui è possibile selezionare la data. Usare le frecce per selezionare il mese e l’anno corretto e infine selezionare il giorno. Premendo nuovamente la piccola icona verrà chiuso il calendario. È anche possibile digitare dalla tastiera la data e GnuCash cercherà di completarla mentre si sta scrivendo.

	Premere Tab per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente assegnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

	Premere di nuovo Tab per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di completare automaticamente il nome del beneficiario mentre si scrive.

	A questo punto possono accadere due fatti alla pressione del tasto Tab: se GnuCash individua una transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando automaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel campo del Trasferimento quando è visualizzata una sola riga per la transazione.

	Quando si digita all’interno del campo del Trasferimento, GnuCash tenterà di completare automaticamente il nome del conto. La ricerca avviene alfabeticamente, quindi digitando Us verrà individuata la sezione Uscite della lista dei conti. Quando è stata isolata la sezione, è possibile muoversi tra i conti figli premendo i : (due punti). Se, dopo aver digitato Ex si preme :, allora il cursore si sposterà nel primo sottoconto nella lista dei conti. La pressione di una combinazione di lettere e dei : permette di muoversi rapidamente attraverso la struttura ad albero dei conti. La piccola icona a destra del riquadro del Trasferimento rappresenta un metodo alternativo per selezionare un conto.

	Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto in la sezione chiamata «Riconciliare un conto a un estratto conto»

	Premere ancora Tab per spostarsi nel primo campo dell’importo. I nomi delle due colonne successive sono diversi in funzione del tipo di conto aperto. Per esempio, i conti bancari visualizzano i nomi Deposito e Prelievo, i conti per le carte di credito mostrano Pagamento e Addebito mentre i conti per le azioni visualizzano Quote, Prezzo, Compra e Vendi.

	Inserire l’importo della transazione nel campo corretto. Prima di premere Tab o Invio leggere il passo successivo.

	Per inserire delle ulteriori suddivisioni, premere il pulsante Suddivisione sulla barra degli strumenti o selezionare la voce Operazioni → Suddividi transazione.  Per le transazioni che contengono più di una suddivisione, viene visualizzata la dicitura --Transazione suddivisa-- e sarà necessario utilizzare il pulsante Suddivisione per mostrarne i dettagli.

	La transazione verrà espansa, i titoli delle colonne dell’importo cambieranno e l’intestazione della colonna Trasferimento sarà vuota. La prima riga contiene la descrizione e l’importo della transazione. La seconda riga contiene il nome del conto attualmente aperto nel campo del Conto e l’importo della transazione. La terza riga contiene il nome del conto di trasferimento nel campo del Conto. Se l’importo non risulta bilanciato,GnuCash lo indicha inserendo delle celle grigie nelle colonne dell’importo e riportando l’ammontare non bilanciato nell’ultima riga vuota del registro.

	Quando viene selezionata una delle righe più corte, le intestazioni delle colonne cambiano. La prima e l’ultima (Data e Saldo) non avranno un titolo; Nr. cambierà in Operazione, Descrizione in Promemoria e la colonna vuota del Trasferimento cambierà il titolo in Conto. Le ultime due colonne dell’importo visualizzeranno i titoli descritti al passo sette.

	I campi Operazione e Promemoria sono opzionali in questa fase; il primo può contenere una descrizione del tipo di conto di trasferimento coinvolto mentre il secondo è destinato a una descrizione aggiuntiva della transazione.

	Sposta il cursore nel campo dell’importo mancante sulla terza riga e lo completa. Premendo il tasto Invio, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione il cursore verrà posizionato sulla riga successiva

	La colonna del Conto contiene una lista dei conti di trasferimento. Questa colonna è utilizzata per aggiungere delle suddivisioni. Il metodo descritto al passo cinque, può essere utilizzato per selezionare un ulteriore conto su una riga vuota. Si possono aggiungere quante suddivisioni si desiderano.

	Quando la transazione è bilanciata, le celle grigie spariranno come anche l’importo visualizzato nell’ultima riga vuota.

	Premendo Invio, come descritto più sopra, si salterà alla transazione successiva. Selezionando la transazione successiva verrà chiusa automaticamente la suddivisione oppure si potrà chiuderla manualmente premendo il pulsante Suddivisione oppure selezionando la voce del menu Operazioni → Suddividi transazione.




Multiple Currency/Commodity Transactions



Any transaction that has splits whose accounts are
    denominated in different commodities (currencies are a subset
    of commodities) requires an exchange rate to convert between
    the two. For more information please see Chapter 10 of the
    Tutorial and Concepts Guide.
Registers for accounts of type STOCK or FUND display
    four columns, Shares,
    Price, Buy, and
    Sell (the last two will be
    Credit and Debit
    respectively if you've enabled Use formal accounting
    labels in the Accounts tab of
    Preferences). Enter any two and
    GnuCash will calculate the other for
    you; if you enter 3 and the result doesn't balance
    GnuCash will ask which one to change
    to make the split balance.
Registers of other types have only
    Credit and Debit (the
    names will be different depending on the account type if you
    haven't enabled Use formal accounting labels)
    and so use the Transfer Dialog with most of
    the fields disabled to collect either an Exchange
    Rate or a To Amount (the amount in
    the other currency/comodity). Please see (la sezione chiamata «Currency Transfer») for details of using this
    dialog.
Nota
When committing a transaction or confirming
    an exchange rate the price on the transaction date in the
    Price Editor may be updated. See la sezione chiamata «Editor prezzi» for details.


Modificare una transazione



Per modificare una transazione è sufficiente selezionare la parte della transazione che si desidera modificare. Una volta effettuati i cambiamenti, premere il tasto Invio, oppure selezionare il pulsante Inserisci o andare in Transazione → Inserisci Transazione per spostare il cursore nella riga successiva della transazione.
Per visualizzare maggiori dettagli relativi a una transazione nella modalità a libro mastro basilare, premere il pulsante Suddivisione nella barra degli strumenti o selezionare Operazioni → Suddividi transazione.

Cancellare una transazione



Se è necessario rimuovere una transazione dal registro, selezionarla e premere il pulsante Elimina nella barra degli strumenti oppure andare in Transazioni → Elimina transazione. Verrà visualizzata una finestra di conferma dell’eliminazione, a meno che non siano state cambiate le preferenze. La finestra propone due opzioni 
È possibile rimuovere anche solo alcune parti della transazione premendo il pulsante Suddivisione sulla barra degli strumenti o selezionando Operazioni → Suddividi transazione. La parte della transazione da cancellare può essere poi selezionata per l’eliminazione.

Rimuovere le suddivisioni da una transazione



La rimozione delle suddivisioni da una transazione prevede che vengano eliminate tutte le suddivisioni a esclusione di quella relativa al conto aperto. Questa operazione rappresenta un metodo efficace per riutilizzare una transazione con suddivisioni multiple modificandola a piacimento (si noti che questo può essere fatto senza espandere la transazione, ma così facendo si rendono più visibili gli effetti dell’operazione).
	Se lo stile del registro è impostato a libro mastro basilare, premere il pulsante Suddivisione sulla barra degli strumenti o selezionare Operazioni → Suddividi transazione per espandere la transazione selezionata. Se la modalità di visualizzazione del registro è un’altra, è sufficiente selezionare la transazione.

	Selezionare Transazione → Rimuovi suddivisioni transazione.
Verrà aperta una finestra per confermare la cancellazione, a meno che non siano state cambiate le preferenze. Questa finestra presenta due opzioni: Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione. La risposta verrà impostata in base all’opzione attivata. La scelta effettuata può essere annullata andando in Operazioni → Ripristina avvisi. la sezione chiamata «Ripristina avvisi...».

	Tutti i conti e i relativi dettagli verranno rimossi a eccezione del conto attualmente aperto.

	L’importo non risulterà bilanciato e GnuCash lo indicherà inserendo delle celle grigie nelle colonne dell’importo e riportando l’ammontare non bilanciato nell’ultima riga vuota del registro.

	Modificare la transazione inserendo le nuove informazioni.




Copiare una transazione



La copia delle transazioni è disponile dal menu Transazione. Il menu Transazione presenta i comandi Taglia transazione, Copia transazione e Incolla transazione che pemettono di copiare, tagliare e incollare l’intera transazione in una nuova riga. Con questa procedura di copia verrà utilizzata la data mostrata nella nuova linea vuota.
La voce Transazione → Duplica transazione... o il pulsante della barra degli strumenti Duplica, a differenza del comando Copia, permettono di scegliere una nuova data.
	Selezionare la transazione da duplicare.

	Andare in Transazione → Duplica transazione...

	Una finestra dal nome Duplica la transazione richiederà la data e il numero della transazione stessa.

	Premere OK per aggiungere la transazione al registro.




Setting the reconcile status (R field) of a transaction



In the GnuCash register there is a column named R. This field
    indicates the status of a transaction. Possible values are:
	n
	Default status when a transaction is created

	c
	Cleared. Status may be assigned either manually or by an import process.

	y
	Status assigned solely by the reconciliation process (see la sezione chiamata «Riconciliare un conto a un estratto conto»).
          Places limits optionally requiring confirmation on editing fields in that line of a transaction.

	f
	Frozen. Not implemented at this time

	v
	Voided. Status is assigned or released manually through the transaction menu (la sezione chiamata «Registro del conto - Menu Transazione»)
          to a transaction and applies to every line in the transaction. It hides most of the transaction details but does not delete them.
          When a transaction is voided a reason entry is required that appears to the right of the description.




Saltare al registro di un altro conto



Quando si utilizza la finestra del registro del conto, può rivelarsi utile essere in grado di vedere un altro conto e il conto di trasferimento allo stesso tempo. GnuCash permette di eseguire velocemente questa operazione utilizzando la funzione di «salto»; è infatti disponibile, nella barra degli strumenti, il pulsante Salta raggiungibile anche tramite il menu Operazioni → Salta nella finestra del registro del conto.
Selezionare la transazione nella finestra del registro del conto e premere il pulsante Salta oppure selezionare Operazioni → Salta per aprire la finestra del registro del conto di destinazione. Se la transazione è suddivisa in più di un conto allora sarà necessario visualizzare tutti i conti di suddivisione e selezionare quello in cui si desidera "saltare".

Pianificare le transazioni



Le transazioni pianificate consentono di essere avvisati o di inserire automaticamente le transazioni in una data specificata. Questa proprietà combinata con l’assistente Dall’ultimo avvio... > (la sezione chiamata «Assistente dall’ultimo avvio») permette di rivedere e inserire le transazioni. L’assistente per il Rimborso di mutui e ipoteche (la sezione chiamata «Assistente per mutui e ipoteche») permette di configurare una transazione pianificata per ripagare un prestito con un tasso di interesse composto. L’editor transazioni pianificate (la sezione chiamata «Finestra di modifica della transazione pianificata») permette di creare e modificare le transazioni che stanno per essere inserite automaticamente nel registro.
Il metodo più semplice per configurare una transazione pianificata consiste nell’utilizzare come modello una transazione esistente nella finestra del registro di un conto. Selezionare la transazione da utilizzare come modello e poi selezionare o il pulsante Pianifica sulla barra degli strumenti o andare in Operazioni → Pianifica.... Verrà aperta la finestra dal titolo Crea Transazione pianificata.
	Nome: inserire un nome per la transazione pianificata. Questo verrà utilizzato nel campo della Descrizione per la transazione.

	Frequenza: selezionare l’intervallo di tempo intercorrente tra due pianificazioni. Le date in cui la transazione verrà inserita saranno visualizzate nel mini calendario in basso.

	Data d’inizio:selezionare una data iniziale per la transazione pianificata.

	Senza fine: se la transazione non ha un termine.

	Data di termine: selezionare una data finale per la transazione pianificata.

	Numero di occorrenze: inserire il numero di volte con cui si desidera che la transazione venga inserita nel registro.



Il pulsante Avanzate... apre la finestra dell’Editor transazioni pianificate per modificare la transazione. Questa è descritta nell’apposita sezione: la sezione chiamata «Finestra di modifica della transazione pianificata».
Finestra della transazione pianificata



La finestra per le transazioni pianificate permette di accedere alla lista delle transazioni pianificate e di crearle, modificarle o eliminarle; fornisce anche un calendario. Fermando il cursore per qualche secondo su una data visualizzata dal calendario, verrà mostrata una piccola finestra contenente l’elenco delle transazioni pianificate per quella stessa data; per chiudere la piccola finestra è sufficiente premere su di essa un’altra volta. Le date evidenziate in giallo sul calendario rappresentano i giorni in cui sono pianificate delle transazioni.
Il riquadro superiore della finestra delle transazioni pianificate contiene una lista delle transazioni pianificate attualmente impostate. Questa lista elenca il nome della transazione, se questa è attiva ai fini della pianificazione, la frequenza (mese o giorno) con cui la transazione deve essere inserita, l’ultima data in cui è stata inserita e la prossima data in cui verrà inserita.
Sul lato destro del riquadro è presenta una freccia rivolta verso il basso che, quando premuta,che permette di selezionare le caratteristiche visualizzate. Togliendo la spunta a una voce, questa verrà rimossa dal riquadro.
La barra degli strumenti di questa finestra contiene tre pulsanti per creare, cancellare o modificare una transazione pianificata. Premendo i pulsanti Nuovo o Modifica, verrà aperto l’Editor transazioni pianificate. Premendo invece Elimina verrà cancellata la transazione pianificata selezionata. Le stesse opzioni sono raggiungibili anche attraverso il menu Pianifica → Nuovo/Modifica/Cancella, nella scheda della Transazioni pianificate.
Al di sotto della lista delle transazioni pianificate, è posizionato il calendario delle "prossime scadenze"; qui è visualizzato il calendario fino all’anno seguente e sono evidenziate le date in cui sono previste delle transazioni pianificate. Cliccando su di una data nel calendario, verrà aperta una finestra con la lista delle transazioni pianificate per quella stessa data. Spostando il puntatore al di sopra di un’altra data, cambierà di conseguenza anche la lista delle transazioni. Cliccando di nuovo sul calendario verrà chiusa la finestra contenente la lista delle transazioni.
La finestra per le transazioni pianificate è accessibile sia dalla scheda del conto che da quella del registro attraverso la voce del menu Operazioni → Transazioni pianificate → Editor transazioni pianificate.


Finestra di modifica della transazione pianificata



La finestra dell’Editor transazioni pianificate è divisa in aree: Nome, Opzioni, Frequenza, Calendario e Modello di transazione.
Il campo del Nome permette di inserire il nome per la transazione pianificata. Questo verrà visualizzato nel campo Descrizione della transazione.
L’area delle Opzioni fornisce la possibilità di scegliere se  la transazione deve essere creata automaticamente e quanti giorni prima crearla o notificarne la ricorrenza.
L’area delle Scadenze fornisce delle opzioni per impostare i limiti di tempo e il numero di transazioni da inserire.
L’area della Frequenza permette di impostare le ricorrenze e le date in cui la transazione deve essere inserita.
Il calendario fornisce una rapida visualizzazione delle transazioni già pianificate.
La scheda del Modello di transazione permette di impostare la transazione così come deve essere inserita nel registro alla data spcificata.
Queste opzioni sono descritte con maggior dettaglio in la sezione chiamata «Pianificare le transazioni»
	Dalla scheda delle Transazioni pianificate selezionando una transazione dall’elenco e premendo il pulsante Modifica o Nuovo verrà aperto l’Editor Transazioni pianificate.




Stampare gli assegni



In GnuCash gli assegni sono stampati dal registro del conto. GnuCash fornisce la possibilità di stampare assegni con lo standard Quicken (anche nel formato US Letter) o di creare un formato personalizzato. Anche la posizione dell’assegno e il formato della data sono personalizzabili.
Per stampare un unico assegno in GnuCash, selezionare la transazione di cui stampare l’assegno e andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà per la stampa dell’assegno.
Per stampare più assegni in GnuCash eseguire una ricerca per trovare le transazioni che si intende stampare. Dalla finestra dei risultati della ricerca andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà di stampa degli assegni per stampare tutti gli assegni presenti nella finestra di ricerca.
La finestra per la stampa dell’assegno presenta due schede. La prima è denominata Opzioni e permette di impostare le opzioni più comuni per la stampa dell’assegno; la seconda, denominata Formato personalizzato permette di configurare la posizione dei vari campi sull’assegno. È utile a questo scopo stampare un assegno di prova su un foglio di carta e utilizzarlo per effettuare le correzioni necessarie.
La selezione preimpostata nella finestra delle Opzioni è l’assegno Quicken/Quickbooks (tm) US-Letter.
	Formato dell’assegno: provare prima con il formato Quicken e utilizzare il formato personalizzato se la posizione non è corretta.

	Posizione dell’assegno: permette di selezionare l’assegno da stampare: Top (in alto), Middle (in mezzo) o Bottom (in basso). L’opzione Personalizzato è da selezionare se la posizione degli assegni nella pagina non è corretta.

	Formato data: il valore predefinito visualizzato in questo campo è impostato nelle preferenze di GnuCash. Dalla lista a comparsa è possibile selezionare il formato della data desiderato. Il formato può essere cambiato utilizzando le righe denominate Mesi: e Anni:. Scegliendo Personalizzato sarà possibile impostare il formato della data nel campo Formato: (%m significa mese, %d significa giorno, %Y significa anno). Un esempio del formato selezionato è mostrato appena più sotto nella finestra.

	Indirizzo: l’indirizzo del beneficiario, se il formato dell’assegno contiene uno spazio dedicato e se si intende stampare un unico assegno.



La scheda del Formato personalizzato è divisa in due sezioni. La metà superiore (al di sopra della linea di divisione) contiene due colonne per l’inserimento delle coordinate X e Y della posizione del campo sull’assegno. Le posizioni nel formato di assegno personalizzato sono a partire da x = 0 sul lato sinistro dell’assegno, crescenti verso destra, e y = 0 dal lato superiore dell’assegno, crescenti verso il basso. (Se si utilizza una versione di GTK precedente alla 2.10, allora y = 0 è al bordo inferiore e positiva verso l’alto).
	Beneficiario:

	Data:

	Importo (in parole):

	Importo (in numeri):

	Indirizzo:

	Note:

	Promemoria:

	Importo suddivisioni

	Promemoria suddivisioni

	Conto suddivisioni



La parte della scheda del Formato personalizzato al di sotto della linea di divisione contiene i campi per il posizionamento dell’assegno all’interno della pagina. La Traslazione è la distanza dall’angolo superiore sinistro mentre la Rotazione rappresenta la rotazione in senso orario dell’assegno. 
Il campo Unità nella metà inferiore della finestra indica le unità da utilizzare per i campi in entrambe le metà della finestra.
Una volta che è stato premuto il tasto OK nella finestra di stampa dell’assegno, verrà visualizzata la finestra per la stampa di un documento di GnuCash. Premere di nuovo OK per stampare l’assegno.

Operazioni online...



Nota
Questa sezione è "in costruzione - ogni contributo è benvenuto!!".

Ricevi saldo





Ricevi transazioni ...





Inoltra transazione





Addebito diretto






Giornale generale



The General Journal is an advanced register used to enter transactions without needing to open
    individual accounts. The General Journal shows the transaction entries for all accounts on one register.
Entering transactions in the General Journal is more complicated than entering them in the individual
    account registers. The advantage is the General Journal provides a more comprehensive view of the
    transactions you have entered in all your accounts.
The General Journal defaults to showing only the previous month of transactions. This is changeable
    by using the "Filter By..." on the View menu.

Capitolo 7. Business Features



The accounting needs of a business are quite different from that of
    a person. Businesses have customers that owe money, vendors which are owed
    money, employee payroll, more complex tax laws, etc. GnuCash offers
    business oriented features to facilitate these needs.
Accounts Receivable (A/R) are used by businesses to record sales for
    which they are not immediately paid. Accounts Payable (A/P) record bills
    that they have received, but might not pay until later. These types of
    accounts are used primarily when you have a lot of bills and receipts
    flowing in and out, and do not want to lose track of them just because you
    do not pay or get paid right away. For most home users, A/R and A/P are
    too complicated to be worth the effort.
Accounts Receivable (or A/R) refers to products or services provided
    by your company for which payment has not yet been received. This is
    represented on the balance sheet as an asset, because the expectation is
    that you will receive payment soon.
Accounts Payable (or A/P) refers to products or services bought by your
    company for which payment has not yet been sent. This is represented on the balance sheet
    as a liability because you will have to pay for them.
Initial Setup



To set up GnuCash to handle accounts receivable and accounts payable
      for a company the following preliminary steps must be done.
    
Account Setup



There are many different ways to set up a business account
      hierarchy. You can start with the Business Accounts setup which is
      available from the New Account Hierarchy assistant, or you could build one
      manually. To access the prebuilt Business Accounts, start GnuCash and
      click on File → New File and
      proceed until you see the list of available accounts, select Business
      Accounts.
Nota
The prebuilt Business Account hierarchy will not meet your needs
        exactly. You will need to make adjustments for the hierarchy to function
        well with your particular situation. It should be close enough that it
        is recommended you begin with it.


Tax Tables



Tax Tables can used to determine the tax for customer invoices (or vendor bills).
      
 A tax table can be assigned to an invoice line or bill line.
 The default invoice line tax table can be assigned to each customer and the default bill
        line tax table can be assigned to each vendor.
      
The default tax table for new customers or new vendors can  be specified in the Book Options 
        window which can be accessed by
        File → Properties → Business tab.
      
Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu
        Business → Sales Tax Table.
        The following fields should be entered:
      
	Name This is the tax table name.

	Type Either Percent %
 or Value $
.

	Value
This is the percentage or value depending on Type.

	Account This is the account to which tax will be posted.
            For tax collected from customers, this should probably be a Liability account as it must be payed to the government.
            For tax paid to vendors, if tax laws allow tax paid to vendors to offset tax collected from customers, this should probably
            also be a Liability account (even though it will usually have a debit balance)
            so that the net tax owed to the government can be easily observed.
          
If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will be rolled up
            and can be seen in the  GnuCash Accounts tab.
          
If unsure about tax law requirements, get professional advise. 




Company Registration



After you have built the account structure and defined your tax tables, register the GnuCash
        file as belonging to your company by filling in the data requested in
        the la sezione chiamata «Business Book Options Tab» accessible from the
        File → Properties menu item.
      

Counters



Define the format and last used numbers of codes such as customer,
          invoice, vendor, bill, employee, expense voucher, job number and
          order.
          See la sezione chiamata «Counters Book Options Tab».
        

Business Preferences



Set options on the Business tab of the GnuCash preferences, which is
        accessed via Edit → Preferences
        (GnuCash → Preferences on Mac OS X).
        See la sezione chiamata «Impresa».
      

Billing Terms



Billing Terms can be used to determine the payment due date  and be a guide for determining discount for early payment of invoices (or vendor bills).
      
Nota
As of GnuCash 2.6.7, Billing terms are only partially supported. Date due is calculated but discount amount is not.

          Discount for early invoice payment is not implemented. There are 2 ways this may be done, although neither is recommended, and
          professional advise should be used to confirm that regulations are being complied with:
          
	After creating and posting a payment which pays the invoice in full, manually edit the payment transaction (usually strongly discouraged)
                and split the payment to reduce it by the amount of the discount and a create a compensating split in an income (discount) account.
              

	Alternatively, after creating and posting a payment for the discounted amount, create a credit note for the discount using a specific negative
                sales income (discount) account for the transfer account.
              




        

You can specify the billing terms on each invoice/bill.
        Invoice billing terms will default from the customer billing terms.
        Bill billing terms will default from the vendor billing terms.
      
Billing Terms are maintained using the Billing Terms Editor which is accessed via menu
        Business → Billing Terms Editor.
        The following fields should be entered:
      
	Name The internal name of the billing term. For some examples of billing term names and descriptions see
             http://wiki.gnucash.org/wiki/Terms
          

	Description The description of the billing term, printed on invoices

	There are 2 types of billing terms, with different information to be entered
	Type Days
	Due Days The invoice or bill is due to be paid within this number of days after the post date

	Discount Days The number of days after the post date during which a discount will
                    be applied for early payment
                  

	Discount % The percentage discount applied for early payment




	Type Proximo
	Due Day The day of the month bills are due

	Discount Day The last day of the month for the early payment discount

	Discount % The discount percentage applied if paid early

	Cutoff Day The cutoff day for applying bills to the next month. After the
                    cutoff, bills are applied to the following month. Negative values
                    count backwards from the end of the month.
                  












Crediti correnti



GnuCash has an integrated accounts receivable system.

      To use GnuCash’s integrated
      accounts receivable system, you must first set up
      Accounts Receivable accounts of type
      A/Receivable under
      Assets to accrue income you're owed. It is
      within this account that the integrated A/R system will place
      transactions, debiting it when you post bills and crediting it
      when you receive payments.
    


        Basic A/R Account Hierarchy:



        -Assets

          -Accounts Receivable

          -Checking

        -Income

          -Sales

        -Liabilities

          -Tax

            -Tax on Purchases

            -Tax on Sales



      

Nota
You need to add additional asset, expense, and income accounts to
          this hierarchy for it to be useful. The important aspects of this
          hierarchy are the use of an income account and the Accounts Receivable
          asset account, with account type set to A/Receivable.
        

          If you deal with customers in more than one currency you will
          need a separate Accounts Receivable
          account for each currency.
        

The transactions generated by the A/R system are recorded within the Accounts
    Receivable account. You generally do not work directly with this account.
    You generally work with the four integrated GnuCash A/R application
    components available through the Business → Customer sub-menu. These four components are:
	la sezione chiamata «Customers»
	People or companies to whom
        you sell products or services on credit.

	la sezione chiamata «Fatture»
	The physical invoice you
        send to a customer to request payment. This invoice contains an
        itemized list of things you sold.

	la sezione chiamata «Customer Jobs»
	Is where you register
        Customer Jobs. Jobs are a mechanism by which you can group multiple
        invoices to a particular customer.

	la sezione chiamata «Process Payment»
	Used to register
        payments you received from a customer.



The following sections introduce the individual components in more
    detail.

Customers



Customers are people or companies to whom you sell goods or
    services. They must be registered within the A/R system.
Nuovo



To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as
      Company Name, Address, Phone, Fax, etc. Below is a list of the other
      options:
	Identification - Customer Number - can be
          any number by which you would like to refer to this customer. You
          may leave it blank and a number will be chosen automatically.
          See la sezione chiamata «Counters Book Options Tab» for more info.

	Identification - Active - differentiates
          active customers from inactive ones. This is useful when you have
          many past customers, and you want to see only those marked
          active.

	Billing Address - Name - is the contact
          name of the person to receive the invoices.

	Notes - records any additional comments
          about the customer.

	Billing Information - Currency -
          specifies the billing currency for this customer. It will
          default to the default currency set in
          Preferences
Nota
All invoices will be denominated in this
          currency and GnuCash will require an
          Accounts Receivable account in this currency.


	Billing Information - Terms - specifies
          the default billing terms for this customer. Billing terms must be
          preregistered using Business → Billing Terms Editor.

	Billing Information - Discount - gives
          the customer a default percentage based discount at the time of
          invoice creation. Enter a value from 0 to 100. You can override the
          default discount when you create an invoice.

	Billing Information - Credit Limit -
          stores the maximum credit you are willing to extend to the customer.
          This field is for your reference purposes only. GnuCash does not use
          the value.

	Billing Information - Tax Included - this
          specifies whether nor not tax is included in invoice amounts by
          default. You can choose Yes,
          No, or Use Global.
          
	Yes means that the tax is already
                included in amounts on invoices.

	No means tax is not
                included.

	Use Global means to use the setting
                made in the global preferences accessible through
                Edit → Preferences
                (Gnucash → Preferences on Mac OS X).




	Billing Information - Tax Table -
          specifies a default tax table to apply to invoice line items. Tax
          tables must be registered from the Business → Tax Table Editor menu item.

	Shipping Address - records the customer’s
          shipping address if it is different from the billing address. The
          shipping address is for your reference. GnuCash does not use the
          value.




Find and Edit



To search for an existing customer, use the Business → Customer → Find Customer window. You select a customer to
      View/Edit from the results of the search. This
      window is also used to look up customers when creating invoices and
      processing payments.
If many customers match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
If the customer you are searching for does not match the supplied
      search criteria, change the search criteria, click the New
      Search radio button and then the Find
      button. The relevant step is the New Search
      selection. If the customer is not in the result of the original search,
      and you only search within this set, the customer cannot be found,
      regardless of new search criteria.
Nota
To return a list of all registered active customers, set the
        search criterion to matches regex, and place a
        single dot "." in the text field area. Make sure Search only
        active data is checked, then click
        Find. The regular expression "." means to match
        anything.



Fatture



An invoice is the paperwork you send to a customer to request
    payment for products or services rendered. GnuCash can generate and track
    invoices.
A credit note is the paperwork you send to a customer to correct
    products or services rendered that were incorrectly invoiced. GnuCash can generate and track
    credit notes via the same menu entries as invoices.
Nota
This section applies to both invoices and
      credit notes. In order to avoid repeating everything twice and to keep
      the text easier to read it will refer only to invoices. You can apply
      it equally to credit notes. Only where the behaviour of credit notes
      differs from invoices this will be explicitly mentioned.  Credit notes were introduced starting with
      GnuCash stable release 2.6.0.

Nuovo



To send an invoice to a customer you must first create a new
      invoice. To create an invoice use Business → Customer → New Invoice. The
      New Invoice window must be filled in appropriately:
	Invoice Information - Type - the
          type of customer document to create - either an invoice or a credit note.

	Invoice Information - Invoice ID - the
          identification number of this invoice. This is your internal number
          for this invoice. If you leave it blank, an invoice number will be
          generated automatically. See la sezione chiamata «Counters Book Options Tab»
          for more info

	Invoice Information - Date Opened - the
          date this invoice was created.

	Billing Information - Customer - the
          customer who is to receive this invoice. If you remember the company name
          you entered in the New Customer window for this customer,
          start to type it in this field and GnuCash will try auto complete
          it for you. Else, press the Select... button to access the Find
          Customer window described in la sezione chiamata «Find and Edit». Highlight the customer
          you are looking for with a click in the search results, then press the
          Select button.

	Billing Information - Job (optional) -
          associates the new invoice with a customer job (see la sezione chiamata «Customer Jobs»).
          If you remember the job name
          you entered in the New Job window for this job,
          start to type it in this field and GnuCash will try auto complete
          it for you. Else, press the Select... button to access the Find
          Job window. This window is the same to the one described in
          la sezione chiamata «Find and Edit». Highlight the job
          you are looking for with a click in the search results, then press the
          Select button.

	Billing Information - Billing ID - this
          is the customer’s PO Number or other «customer reference number».
          You should use it to identify your invoices to this customer (and
          job, if you have one).

	Billing Information - Terms - the payback
          terms agreement for this invoice. A list of registered terms is
          available within the pop up menu. If you specified a default value
          for the selected customer, this field is initialized with the
          default.



When you click the OK button, the
      Edit Invoice window opens.

Modifica



From the Edit Invoice window you can enter an itemized list of
      goods and services you sold on this invoice in a manner similar to how the account
      register works. For credit notes you enter an itemized list of goods and
      services you refunded instead.
There are 15 columns in the Invoice Entries
      area:
	Date - The date this item was
          sold.

	Invoiced? - X means
          the item is attached to this invoice, an empty box means the item is
          not attached to this invoice. The item is attached for you when you
          proceed to the next line item.

	Description (optional) - is what the item
          or service is called.

	Action (optional) - is a user defined
          field. You can place Cost Center information here, or use one of the
          3 predefined actions, Hours, Material, or Project.

	Income Account - selects which income
          account is credited with this income.

	Quantity - tracks how many of the items
          you sold.

	Unit Price - is the unit price of the
          item.

	Discount Type - is the type of
          discount:
	$ means Discount
              is a monetary value

	% means Discount
              is a percentage.



You can click the field to toggle between the discount
          types.

	Discount How - the discount can be
          computed as follows:
	> means the discount applies after
              tax.

	< means the discount applies
              before tax.

	= means both discount and tax are
              applied to the pretax value.



You can click the field to change the setting.

	Discount (optional) - is the total
          discount, in monetary units or percentage, depending on
          Discount Type. You can leave it blank for no
          discount. Any default discount you specified for the customer will
          be automatically entered for each new item.

	Taxable? - is this item taxable?
          X means yes, a blank field means no. You can
          click the field to toggle the setting.

	Tax Included? - has the tax already been
          included in the unit price? X means yes, a
          blank field means no. For example, if there is 1 item of $100 with a
          tax of 5% then:
	If Tax Included is empty, then subtotal = $100 and tax =
              $5.

	If Tax included is set (X), then
              subtotal = $95.23 and tax = $4.77.  The computation is:
              Subtotal = Total / (1+taxrate) and Tax = Total - Subtotal
              = Total - (Total / (1+taxrate)).
              




	Tax Table (optional) - this is a pop up
          menu of all the available tax tables. If you make the item taxable,
          then this table is used to compute the amount of tax. The tax table
          determines tax percentages and the accounts to which tax is
          charged.

	Subtotal (uneditable) - is the computed
          subtotal for this item (less tax).

	Tax (uneditable) - is the computed tax
          for this item.



When you have finished entering all the items, you can
      Post and print the invoice.

Post



When you finish editing an invoice and are ready to print, you
      must Post the invoice. The invoice does not have to
      be posted immediately. In fact, you should only post an invoice when you
      are ready to print it. Posting an invoice places the transactions in an
      accounts receivable account.
The Post Invoice window appears and asks you
      to enter the following information:
	Post Date - specifies the date for the
          transactions entered into the accounts receivable account.
          By default this is the invoice’s Date
          Opened (see la sezione chiamata «Nuovo» for
          information about that date).

	Due Date - is the date on which payment
          for the invoice is expected.
	If you specified payment terms when you created the
              invoice, the date is calculated according to selected terms, and
              the entry field is insensitive.

	If you did not specify payment terms, enter the expected
              payment due date here.




	Description - is an arbitrary
          description. When invoice transactions are placed in the accounts
          receivable account, this description is entered in the memo field of
          those transactions.

	Post To Account - selects the accounts
          receivable account in which invoice transactions are posted. You can
          select the account from a list of existing A/Receivable
          accounts.

	Accumulate Splits - determines if invoice
          items which transfer to the same account are combined into a single
          split for that account or entered individually. For the sample
          invoice which sold Nails and a Hammer, the setting affects post
          results as follows:
	Checked (splits are accumulated) - a single transfer of
              $575.00 from the Income:Sales account is recorded.

	Not checked - the transaction created in the A/Receivable
              account, shows two transfers from Income:Sales account $100.00
              and $475.00. The memo fields in the splits indicate the sale of
              Nails and the Hammer (the item descriptions entered on the
              invoice) respectively.







Find



To find an existing invoice, use the Business → Customer → Find Invoice
      menu item. From the results of the search, you can select an invoice
      to edit or view.
Nota
Before you can edit a posted invoice, you will need to
        Unpost it.

One of the design goals in GnuCash’s Account Receivable system was
      to allow different processes to get to the same state, so you can reach
      an invoice from different directions based on the way you think about
      the problem:
	You can search for the customer first, then list their
          invoices.

	You can search for invoices by number or by company
          name.

	You can list invoices associated with a customer job.




Stampa



After you post an invoice, you should print it and send it to your
      customer. To print an invoice use File → Print Invoice menu item.
Suggerimento
You can modify the appearance of the invoice, IE: add a company
        logo, etc. To do so, see the la sezione chiamata «Changing the Invoice Appearance».

Invoices can also be printed from the main window by selecting
      Reports → Business Reports → Printable Invoice from the main menu. The
      resulting report window states that no valid invoice is selected. To
      select the invoice to print:
	Use the Options Toolbar button or select
          Edit → Report Options from
          the main menu.

	Select the General tab of the report
          options dialog.

	Click the Select button next to the
          Invoice Number field.

	Search for the invoice as usual.



You can also print invoices from within the Process Payment
      dialog. See the la sezione chiamata «Process Payment» for instructions on
      how to do so.

Assign Starting Invoice Number



By default, GnuCash starts with invoice number 1 and increments from there. You can
      manually type an invoice number into the text box each time you create
      an invoice, but this gets tiring and sooner or later leads to duplicate
      numbers.
You can change the starting invoice number if it is important you.
      Use File → Properties, access
      the Counters tab, change the Invoice number value to be
      one less than your desired starting invoice number and click the OK button or the
      Apply button.


Customer Jobs



Customer Jobs are used to group multiple invoices and credit notes to the same
    customer. Use of the Customer Jobs feature is optional. The feature is
    useful when you have multiple jobs for the same customer, and would like
    to view all the invoices and credit notes related to a single job.
To use customer jobs, you must create them using the Business → Customer → New Job menu item. You will see the New
    Job window. The editable fields are:
	Job Info - Job Number (optional) - enter
        the number for this job. If left blank, a number will be chosen for
        you. See la sezione chiamata «Counters Book Options Tab» for more info.

	Job Info - Job Name - the name you want to
        assign to the new job.

	Owner Info - Customer - the customer for
        whom the job is created. If you remember the company name
        you entered in the New Customer window for this customer,
        start to type it in this field and GnuCash will try auto complete
        it for you. Else, press the Select... button to access the Find
        Customer window described in la sezione chiamata «Find and Edit». Highlight the customer
        you are looking for with a click in the search results, then press the
        Select button.

	Owner Info - Billing ID - the customer’s
        reference to this job (e.g. their PO Number). This is the "Billing
        Identification" that they require to correlated your invoices with
        their order. The Billing ID you enter is used to set the billing id
        for new invoices associated with this job.

	Job Active - toggles this job being active
        or not. This is useful when you have many inactive jobs, since it is
        easier to search only among jobs that are marked active.



To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired job in the
    search results, and click the View/Edit Job
    button.
To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
    Job menu item. Select the desired job in the
    search results and click the View Invoices button. A
    window listing invoices and credit notes associated with this job appears. Select an
    invoice or credit note and click the View Invoice button to open an
    invoice editor in the main application window.

Process Payment



Eventually, you will receive payment from your customers for
    outstanding invoices. To register these payments, use the Process Payment
    application found in Business → Customer → Process
    Payment.
Suggerimento
There is an alternative way of assigning a payment to (one or more)
        invoices where the payment transaction already exists, say in the case
        where transactions have been imported from a bank. There is no way to
        assign a payment to an invoice during the import process, so this must
        be done after transactions have been imported.
      
This can best be done starting from the asset account register
        holding the imported payment transaction (like your bank account). In
        that account, select the payment, right-click (control-click for Mac OS
        X) and choose Assign as payment.... The payment
        window will pop-up, partly filled in with the information from the
        transaction. Fill in the missing information like the proper customer
        and invoice to complete the payment.
      
One caveat: the logic behind Assign as payment...
         won't properly detect credit note reimbursements and will
          wrongfully interpret such a transaction as a vendor bill.
      

The Process Payment application consists of:
	Payment Information - Customer - the
        customer who paid you. If you remember the company name
        you entered in the New Customer window for this customer,
        start to type it in this field and GnuCash will try auto complete
        it for you. Else, press the Select... button to access the Find
        Customer window described in la sezione chiamata «Find and Edit». Highlight the customer
        you are looking for with a click in the search results, then press the
        Select button.

	Payment Information - Invoice - the invoice
        for which payment was received. If you remember the invoice ID,
        start to type it in this field and GnuCash will try auto complete
        it for you. Else, press the Select... button to access the Find
        Invoice window described in la sezione chiamata «Find». Highlight the invoice
        you are looking for with a click in the search results, then press the
        Select button.

	Payment Information - Date - the date you
        you received payment.

	Payment Information - Amount - the amount
        of money received.

	Payment Information - Num - the check
        number.

	Payment Information - Memo - any comments
        about this payment.

	Post To - the A/Receivable account to which
        to post this transaction.

	Transfer Account - the account where the
        money will be deposited (a checking account for example).



Over Payments or Pre-Payments



If a customer overpays an invoice or pays for goods or services before
      they have been invoiced, Process Payment for the total amount received.
      GnuCash will then keep track of the over-payment
      (or pre-payment) in the A/R account and you can use the residual when
      paying the next invoice.
    

Partial Payments



Partial payments are possible too. Select the invoice to pay.
      GnuCash will automatically suggest that invoice's
      remaining balance as payment amount. Simply adjust that amount to what you
      want to pay.
    

Writing Off a Bad Debt



Nota
Please check with your accountant to ensure the following is
      acceptable in your region.

The usual way to do this is to process a payment for the invoice to a
      BadDebt account. Such an account would be an expense
      account. However, in GnuCash, you can't process a
      payment for an invoice directly to an expense account, so it takes two
      steps:
    
	Pay the invoice to an asset or liability account, such as
        your checking account.

	Change the asset or liability account, in the 
        non Accounts Receivable split of the payment transaction, to
        the BadDebt expense account.



Specifically
	Remove all transactions from the A/R account related to
        the invoice, except for the invoice's transaction itself. This includes
        any payment transactions, and transactions between your BadDebt and A/R
        account.
In case the payment has associated lot link transactions
          (1), remove those as well.
        
If all is well, your Process Payment window
          for this customer should list the invoice the customer won't pay, and
          no prepayments.
        

	Pay your invoice to an arbitrary asset or liability
        account. It can be your checking account. We will fix that in the next
        step.

	Open the account register for your A/R account. For this
        invoice there should now be one payment transaction. If you are using
        GnuCash 2.6.0 - 2.6.4 there will also be one
        lot link transaction (1).
        

	 Select the payment transaction and change the transfer
        account to your BadDebt account. Make sure to leave
        the transaction (eg by clicking on another transaction) to save the
        changes.



If all is well, your Process Payment window
      should still be clean: no pre-payments, and the bad debt invoice gone.
    
Nota
(1): GnuCash
      versions 2.6.0 to 2.6.4 created lot link transactions which show in the
      A/R account register. This came with its own set of subtle issues. It is
      recommended to upgrade to the latest (or at least 2.6.6) version, which
      fixes a lot of small problems. Version 2.6.5 had a flaw in the logic
      cleaning up the lot links. Once upgraded, please run 
      Actions → Check & Repair on your A/R and A/P accounts to clean up most of the lot
      link legacy. Don't forget to make a backup first just in case.
Lots are used internally for relating payments to invoices. Lots
        themselves are invisible in the account registers.
        To see them you need to open the lot viewer, which can be found in
        Actions → View lots
         while in any A/R or A/P account register.
        Select a lot to see the Splits in lot.
      
Lot links are transactions
        which you can see in your A/R and A/P accounts. They are unusual in the
        sense that all their splits are in one account (A/R or A/P). Each split
        in a lot link transaction is linked (hence the
        name) to an invoice or payment transaction by means of a lot.
      

See http://wiki.gnucash.org/wiki/Business_Features_Issues for more information.
    


Changing the Invoice Appearance



The default Invoice style, as shown in la sezione chiamata «Stampa», is fairly barren. The default invoice
    style leaves the top part of the form blank, so you can print on company
    letterhead paper. There are some things you can do to change invoice
    appearance.
Use File → Properties to
    enter your Company informations in the Business tab of the Book Options window.
    Some of the entered informations are printed on the right side of invoices.
To add a customized background, heading banner or logo to invoices,
    modify the invoice style sheets. To do this, go to Edit → Style Sheets and select the New
    button in the Select HTML Style Sheet window that will appear.
Give a Name to the new style sheet (e.g. Custom Invoice) and select the
    Fancy Template. When you click the
    OK button, the HTML Style Sheet Properties window is
    displayed. This window presents you five sections listed in the left pane: Colors, Fonts,
    General, Images, and Tables. The Colors
    section allows you to change the colors of various items of the invoice. The Fonts section lets you
    set fonts type and dimensions. The General section allows you to set the Preparer and
    Prepared for information, and to Enable Links. The Images section allows you
    to import graphics into the style sheet. The Tables section allows you to
    adjust the spacing around the tables which make up the invoice.
To include a company logo, banner heading and background image, use
    your favorite graphics application such as The Gimp or OpenOffice Draw to
    save the images in either GIF or PNG format. Then import them into the
    style sheet using the Images section described above.
Nota
The images are placed in the invoice as follows. The
      Background Tile is tiled to become the background
      image, the Heading Banner goes to above the invoice
      text, and the Logo is placed in the upper left corner
      of the invoice to the left of the Heading Banner. You will probably have
      to try a few different sized images until you get the invoices to print
      nicely. Some sizing suggestions are that the Logo should be 1 square cm
      (~0.5 inch), and the Heading Banner should be 15 cm (~6 inches) wide and 1
      cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you
    select the style sheet to use from the Options menu.

Debiti correnti




      GnuCash has an integrated accounts
      payable system. As with Accounts Receivable
      you must have an Accounts Payable account
      set up under Liabilities for each currency
      in which you will issue invoices. The Accounts
      Payable accounts accrue the amounts you owe to
      others, so bills credit these accounts and payments and credit
      memos debit these accounts.  Generally you do not directly work
      with this account but use the four integrated
      GnuCash A/P application components.
      The A/P components are available from the
      Business → Vendor
      sub-menu.

    
These A/P components are:
	Vendors are people or companies from which you buy
          products or services on credit.

	Bills represent the physical bills vendors send to
          request payment from you. A bill contains an itemized list of things you purchased.

	Jobs (optional) is where you register Vendor Jobs.
          Jobs are mechanism by which you can group multiple bills from a particular vendor.

	Process Payments is where you register payments to a
          vendor to whom you owe money.



The following sections introduce the individual Accounts Payable application components.

Vendors



A vendor is a company or person from whom you purchase goods or services.
    Vendors must be registered within the A/P system.
Nuovo



To register a new vendor, select the Business → Vendor → New Vendor menu item. Fill in general information about the vendor,
    such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options: 
	Identification - Vendor Number - can be any number by which you would
        like to refer to this vendor. You may leave it blank and a number will be chosen automatically.
        See la sezione chiamata «Counters Book Options Tab» for more info

	Identification - Active - differentiates active vendors from inactive
        ones. This is useful when you have many past vendors, and you want to see only those marked active.

	Payment Address - Name - is the contact name of the person to
        receive payments you make.

	Notes - records any additional comments about the vendor.
        Use it to track names of contact people within the vendor’s company, for example.

	Payment Information - Currency -
          specifies the payment currency for this vendor. It will
          default to the default currency set in
          Preferences
Nota
All Bills and Credit Notes will be denominated in this
          currency and GnuCash will require an
          Accounts Payable account in this currency.


	Payment Information - Terms - specifies the default payment terms
        for this vendor. Payment terms must be preregistered using
        Business → Billing Terms.

	Payment Information - Tax Included - specifies if tax is included
        in bills from this vendor. You can choose Yes, No,
        or Use Global.
	Yes means that tax is already
              included in amounts on bills.

	No means tax is not included.

	Use Global means to use the setting
              made in the global preferences accessible through
              Edit → Preferences
              (Gnucash → Preferences
              on Mac OS X).




	Payment Information - Tax Table - specifies a default tax
          table to apply to bills from this vendor.  Tax tables must be registered using the
          Business → Tax Table
          menu item.




Find and Edit



To search for an existing vendor, use the Business → Vendor → Find Vendor window.
      You select a vendor to View/Edit from the results of the search.
      This window is also used to look up a vendor when entering bills and processing payments.
If many vendors match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
If the vendor you are searching for does not match the supplied
      search criteria, change the search criteria, click the New
      Search radio button and then the Find
      button. The relevant step is the New Search
      selection. If the vendor is not in the result of the original search,
      and you only search within this set, the vendor cannot be found,
      regardless of new search criteria.
Suggerimento
To return a list of all registered active vendors, set the search criterion to
        matches regex, and place a single dot «.» in the text field area.
        Make sure Search only active data is checked, then click Find.
        The regular expression «.» means to match anything.



Ricevute



A bill is a request for payment you receive from a vendor.  GnuCash can track bills.
A credit note is the document you receive from a vendor to correct
    products or services rendered that you were incorrectly charged for on a bill. GnuCash can generate and track
    credit notes via the same menu entries as bills.
Nota
This section applies to both bills and
      credit notes. In order to avoid repeating everything twice and to keep
      the text easier to read it will refer only to bills. You can apply
      it equally to credit notes. Only where the behaviour of credit notes
      differs from bills this will be explicitly mentioned.

Nuovo



When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill.  To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window appropriately.
	Invoice Information - Type - the
          type of vendor document to create - either a bill or a credit note.

	Invoice Info - Invoice ID (optional) - the identification number of the invoice as emitted by the vendor (IE: the vendor’s internal number for this invoice).

	Invoice Info - Date Opened - the date the Invoice was emitted by the vendor.

	Billing Info - Vendor - the issuing vendor. If you remember the company name
  you entered in the New Vendor window for this vendor,
  start to type it in this field and GnuCash will try auto complete
  it for you. Else, press the Select... button to access the Find
  Vendor window described in la sezione chiamata «Find and Edit». Highlight the vendor you are looking for with a click
  in the search results, then press the Select button.

	Billing Info - Job (optional) - associates a vendor job (see la sezione chiamata «Vendor Jobs») with this bill.
  If you remember the job name
  you entered in the New Job window for this job,
  start to type it in this field and GnuCash will try auto complete
  it for you. Else, press the Select... button to access the Find
  Job window. This window is very similar to the one described in
  la sezione chiamata «Find and Edit». Highlight the job you are looking for with a click
  in the search results, then press the Select button.

	Billing Info - Billing ID (optional) - the vendor’s ID for the bill (e.g.: their invoice #).

	Billing Info - Terms - the pay back terms agreement for this bill. A list of registered terms is available within the pop up menu.  If you specified a a default value for the selected vendor, this field is initialized with the default.

	Chargeback Project - Customer (optional) - the customer to associate with this bill.  This is used to charge your customer later.

	Chargeback Project - Job (optional) - the customer job to associate with this bill.



When you click the OK the Edit Bill opens.

Modifica



From the Edit Bill window you can enter an itemized list of
      goods and services you purchased, in a manner similar to how the account
      register works. For credit notes you enter an itemized list of goods and
      services the vendor refunded instead.
There are 12 columns in the Invoice Entries area:
	Date - The date this item was sold.

	Invoiced? - X  means the item is attached to this invoice, an empty box means the item is not attached to this invoice.  If the box is empty you can attach the item to the invoice by first selecting the item row and then clicking in this box.

	Description (optional) - is what the item or service is called.

	Action (optional) - is a user defined field.  You can place Cost Center information here, or use one of the 3 predefined actions, Hours, Material, or Project.

	Expense Account - selects the expense account to change for this item.

	Quantity - tracks how many of the items you bought.

	Unit Price - is the unit price of the item.

	Taxable? - is this item taxable?  X means yes, a blank field means no. You can click the field to toggle the setting.

	Tax Included? - has the tax already been included in the unit price?  X means yes, a blank field means no.

	Tax Table (optional) - this is a pop up menu of all the available tax tables.  If the item is taxable and tax has not been included in the unit price, then this tax table is used to compute the amount of tax.

	Subtotal (uneditable) - computed subtotal for this item (less tax)

	Billable - is this item billable to the chargeback customer/job?



When you have finished entering all the items, Post the bill. 

Post



When you finish editing a bill, you should Post the bill.  You do not have to post the bill, you can close it and return to it later. You have to post the bill eventually.  Posting a bill places its transactions into an accounts payable account.  The Post Bill window appears and asks you to enter information:
	Post Date - specifies the date for the transactions entered into the accounts payable account.

	Due Date - is the date on which payment for the bill is expected.
	If you specified payment terms when you created the bill,
              the date is calculated according to selected terms, and
              the entry field is insensitive.

	If you did not specify payment terms, enter the expected
              payment due date here.




	Description - is an arbitrary
       description. When bill transactions are placed in the accounts
       payable account, this description is entered in the memo field of
       those transactions.

	Post To Account - selects the accounts
        payable account in which bill transactions are posted. You can
        select the account from a list of existing A/Payable
        accounts.

	Accumulate Splits - determines if bill
          items which transfer to the same account are combined into a single
          split for that account or entered individually. For the sample
          bill for Letterhead and Envelopes, the setting affects post
          results as follows:
	Checked (splits are accumulated) - a single transfer of
              $100.00 to the Expenses:Office Supplies account is recorded.

	Not checked - the transaction created in the A/Payable
              account, shows two transfers to Expenses:Office Supplies account
              $75.00 and $25.00.  The memo fields in the splits indicate the
              purchase of Letterhead and Envelopes (the item descriptions
              entered on the bill) respectively.







Find



To find an existing bill, use the Business → Vendor → Find Bill menu item.  From the results of the search, you can select a bill to edit, or view.
Nota
Before you can edit a posted bill, you will need to Unpost it.

Nota
There are other ways to access an existing bill.  These are similar to accessing invoices for your customers.  See la sezione chiamata «Find» for more information.



Vendor Jobs



Vendor Jobs are used to group multiple bills and credit notes from a single vendor.  Use of the vendor jobs feature is optional.  The feature is useful when you have multiple jobs for the same vendor, and would like to view all the bills and credit notes for a single job.
To use vendor jobs, you must create them using the Business → Vendor → New Job menu item.  You will see the New Job window.  The editable fields are:
	Job Info - Job Number (optional) - enter
        the number for this job. If left blank, a number will be chosen for
        you.

	Job Info - Job Name - the name you want to
        assign to the new job.

	Owner Info - Vendor - the vendor for
        whom the job is created.

	Owner Info - Billing ID - the vendor’s
        reference to this job (e.g. their PO Number).

	Job Active - toggles this job being active
        or not. This is useful when you have many inactive jobs, since it is
        easier to search only among jobs that are marked active.



To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job in the
    search results, and click the View/Edit Job
    button.
To select from the bills and credit notes associated with a given job, use Business → Vendor → Find Job menu item. Select the desired job in the
    search results and click the View Invoices button. A
    window listing bills and credit notes associated with this job appears. Select a
    bill or credit note and click the View Invoice button to open a
    bill editor in the main application window.

Process Payment



Eventually, you need to pay your bills.  To do so, use the Process Payment application found in Business → Vendor → Process Payment.
Suggerimento
There is an alternative way of assigning a payment to (one or more)
      bills where the payment transaction already exists, say in the case
      where transactions are imported from a bank.
    
This can best be done starting from the asset account register
      holding the imported payment transaction (like your bank account). In
      that account, select the payment, right-click (control-click for Mac OS
      X) and choose Assign as payment.... The payment
      window will pop-up, partly filled in with the information from the
      transaction. Fill in the missing information like the proper vendor
      and bill to complete the payment.
    
One caveat: the logic behind Assign as payment...
       won't properly detect credit note reimbursements and will
        wrongfully interpret such a transaction as a customer invoice.
    

The Process Payment application consists of:
	Payment Information - Vendor - the vendor you wish to pay. If you remember the company name
  you entered in the New Vendor window for this vendor,
  start to type it in this field and GnuCash will try auto complete
  it for you. Else, press the Select... button to access the Find
  Vendor window described in la sezione chiamata «Find and Edit». Highlight the vendor you are looking for with a click
  in the search results, then press the Select button.

	Payment Information - Bill - the bill you wish to pay. If you remember the bill ID,
  start to type it in this field and GnuCash will try auto complete
  it for you. Else, press the Select... button to access the Find
  Bill window described in la sezione chiamata «Find». Highlight the bill you are looking for with a click
  in the search results, then press the Select button in the search window.

	Payment Information - Date - the date you wish to make the payment, normally the current date.

	Payment Information - Amount - the amount of money to transfer in this payment.

	Payment Information - Num - the check number.

	Payment Information - Memo - any comments about this payment.

	Post To - the A/Payable account to post this transaction.

	Transfer Account - the account from which money for the payments
   comes from, such as a checking account.



Over Payments or Pre-Payments



If you wish to overpay an invoice or pay for goods or services before
      they have been invoiced, Process Payment for the total amount payed.
      GnuCash will then keep track of the over-payment
      (or pre-payment) in the A/P account and you can use the residual in the
      future.
    

Partial Payments



You may wish to partially pay a bill. Select the bill to pay.
      GnuCash will automatically suggest that bill's
      remaining balance as payment amount. Simply adjust that amount to what you
      want to pay.
    


Employees



GnuCash can help your company by tracking employees. You can register a
    la sezione chiamata «New Employee», la sezione chiamata «Find and Edit» existing employees, create
    la sezione chiamata «New Expense Voucher/Credit Note» and la sezione chiamata «Find and Edit Expense Voucher/Credit Note».
Expense voucher are used to reimburse employees for authorized expenses (f.e. travels, parking, food etc...).
    Employees credit notes are the opposite of expense vouchers.
New Employee



To register a new employee, select the Business → Employee → New Employee menu item. The New Employee
    window will open with two tabs:
	Employee tab

	Access Control tab



Employee tab
	Identification - Employee Number - can be any number by which you would
        like to refer to this vendor. You may leave it blank and a number will be chosen automatically.
        See la sezione chiamata «Counters Book Options Tab» for more info.

	Identification - Username (Mandatory) - a unique username to identify the employee.

	Identification - Active (Optional) - differentiates active employees from inactive
        ones. This is useful when you have many past employees, and you want to see only those marked
        Active.

	Payment Address - Name (Mandatory) - the full name of the employee.

	Payment Address - Address (Mandatory) - the address of the employee.

	Payment Address - Phone, Fax, Email (Optional)- others optionals contact information for the employee.

	Interface - Language (Optional) - 

	Payment Information - Terms (Optional) - specifies the default payment terms
        for this employee. Payment terms must be preregistered using
        Business → Billing Terms.

	Billing - Default Hours per Day (Optional) - 

	Billing - Default Rate (Optional) - 

	Billing  - Currency -
          specifies the billing currency for this employee. It will
          default to the default currency set in
          Preferences
Nota
All expense vouchers and credit notes for this
          employee will be denominated in this currency and
          GnuCash will require an Accounts
          Payable account in this currency.


	Billing - Credit Account (Optional) - 



Access Control tab
	Access Control List




Find and Edit



To search for an existing employee, use the Business → Employee → Find Employee... menu.
      You select an employee to View/Edit from the results of the search.
      This window is also used to look up an employee when entering voucher and processing payments.
If many employees match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
Nota
If the employee you are searching for does not match the supplied
        search criteria, change the search criteria, click the New
        Search radio button and then the Find
        button. The relevant step is the New Search
        selection. If the employee is not in the result of the original search,
        and you only search within this set, the employee cannot be found,
        regardless of new search criteria.

Suggerimento
To return a list of all registered active employees, set the search criterion to
        matches regex, and place a single dot «.» in the text field area.
        Make sure Search only active data is checked, then click Find.
        The regular expression «.» means to match anything.


New Expense Voucher/Credit Note



To register a new expense voucher/ Credit Note, select the Business → Employee → New Expense Voucher... menu item. The New Expense Voucher
    window will open. You can enter the following data:
	Voucher information - Type (Optional) - select if you are entering
        a Voucher or a credit note.

	Voucher information - Voucher ID (Optional) - can be any number by which you would
        like to refer to this voucher. You may leave it blank and a number will be chosen automatically.
        See la sezione chiamata «Counters Book Options Tab» for more info.

	Voucher information - Date opened - the date of the voucher. Click on
        the button on the right of the date to open a calendar.

	Billing information - Employee (Mandatory) - the employee to which
        voucher refers.
Suggerimento
The field supports auto-completion so if you start typing GnuCash
          will try to complete the text automatically using existing employees name. You can also press the button
          Select... to open the Find Employee
          window.


	Billing information - Billing ID (Optional) - the identification number
        of the document (f.e. the bill number for a dinner).

	Billing information - Terms (Optional) - the pay back terms agreement
        for this bill. A list of registered terms is available within the pop up menu.

	Default chargeback project - Customer (Optional) - the Customer
        to wich voucher refers.
Suggerimento
The field supports auto-completion so if you start typing GnuCash
          will try to complete the text automatically using existing Customer name. You can also press the button
          Select... to open the Find Customer
          window.


	Default chargeback project - Job (Optional) - the Customer Job
        to wich voucher refers.
Nota
 you can type in this field only if there is one or more job registered in
          GnuCash belonging to the selected Customer.

Suggerimento
The field supports auto-completion so if you start typing GnuCash
          will try to complete the text automatically using existing Customer name. You can also press the button
          Select... to open the Find Customer
          window.


	Notes - records any additional comments about the voucher/credit note. 




Find and Edit Expense Voucher/Credit Note



To search for an existing Expense Voucher, use the Business → Employee → Find Expense Voucher...
      menu item.
      You select an Expense Voucher to View/Edit from the results of the search.
      This window is also used to look up an expense voucher when entering voucher and processing
      payments.
If many expense vouchers match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
Nota
If the expense voucher you are searching for does not match the supplied
        search criteria, change the search criteria, click the New
        Search radio button and then the Find
        button. The relevant step is the New Search
        selection. If the expense voucher is not in the result of the original search,
        and you only search within this set, the voucher cannot be found,
        regardless of new search criteria.

Suggerimento
To return a list of all expense vouchers, set the search criterion to
        matches regex, and place a single dot «.» in the text field area.
        Make sure Search only active data is checked, then click Find.
        The regular expression «.» means to match anything.



Capitolo 8. Strumenti e assistenti



GnuCash fornisce diversi strumenti specializzati che permettono l’accesso a funzionalità avanzate. Questi strumenti sono selezionabili dal menu Strumenti. Alcuni di essi potrebbero non essere visualizzati se non sono stati configurati alcuni dei supporti quali l’Online Banking, o gli strumenti appropriati per la finestra corrente.
Find



The GnuCash Find assistant can be used to find
    transactions or to perform business related research on your data file.
Find Transaction



Find Transaction is used to search for transactions in GnuCash
        and display the results in a register window. To open the Find Transaction dialog in
        Split Search mode, you can type the keyboard shortcut Ctrl+f.
Exactly which transactions are searched depends on
        where you invoke the tool from. If you start from the main
        accounts hierarchy page, all transactions will be searched.
        If you start from an individual account register, only
        transactions in that account will be searched. And if you
        filter the transactions in a register using
        View  → 
        Filter By... , then only
        transactions in that account and shown by the filter will be
        searched.
Nota
The first row of the Find Transaction dialog
          indicates that you are performing a Split Search.

There are two panes in the Find Transaction dialog. The top pane contains
        the Search Criteria buttons and the bottom pane contains the Type of
        Search selection.
There are two buttons in the top of the Search Criteria pane.
        The left button allows you to Add another criteria row to search for
        multiple criteria. The existing criteria row needs to be completed
        before adding a new row. The right button is used to Search for items
        where all criteria are met or Search for items where any criteria are
        met. The all criteria are met search requires all of the criteria rows
        to have at least one match. The any criteria are met search requires
        only one of the criteria rows to be matched.
The criteria row  in the Search Criteria pane is used to combine different
        criteria buttons (see table Tabella 8.1, «Search criteria buttons - Split Search» for a comprehensive list of combinations)
In the Type of Search pane there are five selections. The first option is always enabled, the following
        three are available when you invoke the Find... option from a register window or after performing the
        first Find if the Find... command was invoked from any other window.
        Last option is available only for Business search.
	New Search
	Perform a new transaction search

	Refine current search
	Search within the results of the previous search

	Add results to current search
	Search based on the first set of criteria or the new criteria

	Delete results from current search
	Discard any results that match the previous search results

	Search only active data
	Search only if data are marked as active. This selector
            is greyed out for the Split Search as it is meaningful only for
            business related search



Nota
When selecting search criteria keep in mind that criteria are applied to
         individual splits or fields in transactions, and that the entire transaction is
         included in the results. There is no visual indication in the results to
         indicate which split or field met the search criteria.

When search criteria are selected, you can press the Find button. You will be
        presented with the search results in a new register tab. A report of the
        search results may created and printed using 
        Reports → Account Report.
        The Account Report has limited formatting options but, like all
        GnuCash reports, being in html format, can be
        copied and pasted into a spreadsheet for further formatting.
        Alternatively, the Account Report can be exported to an html file, and
        the html file may be opened in a spreadsheet.
        
Nota
Press the Close button to close the Find Transaction dialog.

Tabella 8.1. Search criteria buttons - Split Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Description[a]
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Memo[a]
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Number[a]
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Operazioni
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Note
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Data di emissione
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Valore
	ha il credito o il debito
	minore di
	Campo per l’immissione dell’importo
	Elimina riga
	
	
	

	minore o uguale a

	uguale a

	diverso da

	maggiore di

	maggiore o uguale a

	ha il credito
	minore di

	minore o uguale a

	uguale a

	diverso da

	maggiore di

	maggiore o uguale a

	ha il debito
	minore di

	minore o uguale a

	uguale a

	diverso da

	maggiore di

	maggiore o uguale a

	Quote
	is less than
	Campo per l’immissione dell’importo
	Elimina riga
	
	
	
	

	is less than or equal to

	equals

	does not equal to

	is greater than

	is greater than or equal to

	Quotazione
	is less than
	Campo per l’immissione dell’importo
	Elimina riga
	
	
	
	

	is less than or equal to

	equals

	is not equal to

	is greater than

	is greater than or equal to

	Reconcile[c]
	è
	Non liquidata
	Liquidata
	Riconciliata
	Bloccata
	Invalidata
	Elimina riga

	non è

	Bilancio
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Account[d]
	soddisfa ogni conto
	scegliere conti
	Elimina riga
	
	
	
	

	matches no accounts

	All Accounts[e]
	matches all accounts
	scegliere conti
	Elimina riga
	
	
	
	

	[a] The Description, Memo, Number
                are common to all lines in a transaction.

[b] regex
                means regular expression text search as used in various computer programs such
                as Perl

[c] The
                Reconcile option applies the selected criteria to each line
		of a transaction individually. Each transaction line may have only one of the indicated values,
		but there is often a mix of values within a complete transaction, so companion lines may
		not meet the selected criteria. See separate note defining status values. For a detailed
                description of transaction statuses see la sezione chiamata «Setting the reconcile status (R field) of a transaction»
                

[d] The
                Account option performs a search where the accounts selected
                in the Choose Accounts dialog will both be searched individually for
	        results. This means that a match in any of the selected accounts will
        	either be displayed (matches any account) or discarded (matches no
        	account).

[e] The All Accounts
                option performs a search where accounts selected in the Choose Accounts
                dialog will only return results that match in both accounts.






Explanations of the
        Criteria



The Reconcile criterion
          deserves some more explanation. Think of the selected
          reconciliation status buttons
          (Not Cleared,
          Cleared, and so on) as a single group,
          joined with a logical “or”. In other words, the
          selection “is
          ” or “is
          not” applies to the “or” of the
          selected status buttons. The buttons which are left unselected
          are simply ignored. (It’s not the same as saying
          the reconciliation status must not be one
          of these.)
For example: if you select Reconcile
          is Cleared
          Reconciled, that means you’re
          saying “I want all transactions which contain cleared
          splits OR reconciled splits” (imagine an invisible
          “OR” between all the selected status buttons).
          It’s the same as selecting
          Reconcile is
          Cleared, then adding another search
          criterion with the Add button, then on
          the new line selecting Reconcile
          is Reconciled,
          and finally selecting Search for items
          where any criteria are met.
          In either case, GnuCash will show
          you exactly the same set of transactions.


Find Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher



The business find assistant is used to search for business related items (Customer,
        Invoice, Job, Vendor, Bill, Employee, Expense Voucher). To open the business search dialog
        select the desired item to Find from the
        Business → Customer/Vendor/Employee  submenus.
Suggerimento
The titlebar and the first row of the assistant dialog reports the item type you are searching for: Customer,
          Invoice, Job, Vendor, Bill, Employee, Expense Voucher.

There are two panes in the Find dialog. The top pane contains
        the Search Criteria buttons and the bottom pane contains the Type of
        Search selection.
Search Criteria section



There are two buttons in the top of the Search Criteria pane.
        The left button allows you to Add another criteria row to search for
        multiple criteria.
Nota
The existing criteria row needs to be completed
          before adding a new row.

The right button is used to Search for items
        where all criteria are met or Search for items where any criteria are
        met. The all criteria are met search requires all of the criteria rows
        to have at least one match. The any criteria are met search requires
        only one of the criteria rows to be matched.
The criteria row  in the Search Criteria pane is used to combine different
        criteria buttons (see tables Tabella 8.2, «Search criteria buttons - Customer Search»,
        Tabella 8.3, «Search criteria buttons - Invoice Search», Tabella 8.4, «Search criteria buttons - Job Search», Tabella 8.5, «Search criteria buttons - Vendor Search»,
        Tabella 8.6, «Search criteria buttons - Bill Search», Tabella 8.7, «Search criteria buttons - Employee Search» Tabella 8.8, «Search criteria buttons - Expense Voucher Search»
        for a comprehensive list of combinations)

Type of Search section



In the Type of Search pane there are five selections. The first and alst options are
        always selectable while the following three are available only when you perform the first search by setting
        some search criteria and pressing the Find button.
	New Search
	Perform a new search

	Refine current search
	Search within the results of the previous search

	Add results to current search
	Search based on the first set of criteria or the new criteria

	Delete results from current search
	Discard any results that match the previous search results

	Search only active data
	Search only if data are marked as active.




The rest of the search dialog



When search criteria are selected, you can press the Find button. You will be
        presented with the list of search results in the same Find dialog.
Suggerimento
Aside the results, GnuCash gives you some buttons to manage
          the highlighted result.

Suggerimento
In the bottom right of the Find dialog there is a button that allows to create a
          New business item.

Nota
Press the Close button to close the Find assistant dialog.


List of search criteria buttons



Tabella 8.2. Search criteria buttons - Customer Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Company Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Customer ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Billing Contact
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Shipping Contact
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]





Tabella 8.3. Search criteria buttons - Invoice Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Invoice ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Company Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Date Opened
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Posted?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Data di emissione
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Paid?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Billing ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Invoice Notes
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Invoice Owner
	è
	Cliente
	Espressione inserita nel campo di ricerca
	Select...
	Elimina riga
	
	

	Venditore

	Dipendente

	Job

	non è
	Cliente

	Venditore

	Dipendente

	Job





Tabella 8.4. Search criteria buttons - Job Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Job Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Job Number
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Billing ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Only Active?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Owner's Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]





Tabella 8.5. Search criteria buttons - Vendor Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Company Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Vendor ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Billing Contact
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]





Tabella 8.6. Search criteria buttons - Bill Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Bill ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Company Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Due Date
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Date Opened
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Posted?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Data di emissione
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Paid?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Billing ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Bill Notes
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Bill Owner
	è
	Cliente
	Espressione inserita nel campo di ricerca
	Select...
	Elimina riga
	
	

	Venditore

	Dipendente

	Job

	non è
	Cliente

	Venditore

	Dipendente

	Job





Tabella 8.7. Search criteria buttons - Employee Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Employee Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Employee Username
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Employee ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]





Tabella 8.8. Search criteria buttons - Expense Voucher Search
	Pulsante 1
	Button 2
	Button 3
	Button 4
	Button 5
	Pulsante 6
	Pulsante 7
	Pulsante 8

	Voucher ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Employee Name
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Due Date
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Date Opened
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Posted?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Data di emissione
	è prima del
	Campo per la selezione della data
	Elimina riga
	
	
	
	

	è prima del o il

	è il

	non è il

	è dopo il

	è il o dopo il

	Is Paid?
	è
	impostato a vero
	Elimina riga
	
	
	
	

	non è

	Billing ID
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Voucher Notes
	contiene
	Espressione inserita nel campo di ricerca
	L’espressione inserita è insensibile alle lettere maiuscole/minuscole?
	Elimina riga
	
	
	

	matches regex[b]

	does not match regex[b]

	Voucher Owner
	è
	Cliente
	Espressione inserita nel campo di ricerca
	Select...
	Elimina riga
	
	

	Venditore

	Dipendente

	Job

	non è
	Cliente

	Venditore

	Dipendente

	Job









Assistente dall’ultimo avvio



L’assistente Dall’ultimo avvio viene avviato automaticamente quando si esegue GnuCash; permette di inserire nel registro qualsiasi transazione il cui inserimento automatico sta per avvenire. L’esecuzione all’avvio di GnuCash può essere modificata nella finestra delle preferenze di GnuCash all’interno della scheda Transazioni pianificate. Per eseguire l’assistente manualmente, andare in Operazioni → Transazioni pianificate → Dall’ultimo avvio...
Nella finestra Dall’ultimo avvio... sono presenti tre colonne:
	Transazione
	Il nome assegnato nell’Editor transazioni pianificate che identifica la transazione pianificata.

	Stato
	Il valore del campo  State può essere uno tra i seguenti:
Suggerimento
Fare clic nel campo della colonna dello Stato relativa a una transazione per modificarne lo stato (questa opzione è disponibile solamente se il campo dello stato non è vuoto)

	Ignora
	Se viene visualizzata una transazione pianificata, da creare o come promemoria, l’utente può impostare lo stato a Ignorato per scartare l’inserimento. La transazione pianificata non verrà inserita nel registro e la transazione verrò ricordata solamente nell’occorrenza successiva. Per esempio, se è stato impostato un promemoria per una transazione relativa a un trasferimento di 500€ alla fine del mese verso il proprio conto risparmi, e questo mese si è acquistato un nuovo computer a causa del quale non si avrà la disponibilità di quella cifra, si potrà impostare lo stato della transazione a Ignorato.

	Posticipato
	If a scheduled transaction has been listed
                      with a status To-create but
                      you want to hold it and not have it entered to
                      your register yet, then you can set it to
                      Postponed. When at some
                      later time you change it back to
                      To-create it will be
                      created with the original posted-date. If you
                      want to change that you must edit the
                      transaction after it's created.

	Promemoria
	Si è a n giorni dalla data di scadenza della transazione pianificata. Il numero di giorni n con cui segnalare in anticipo la scadenza di una transazione pianificata, può essere impostato o nella scheda Transazioni pianificate delle Preferenze di GnuCash o nella scheda Generali dell’Editor transazioni pianificate.

	Da creare
	La transazione pianificata verrà creata automaticamente alla pressione del pulsante Ok.

	Vuoto
	Un campo vuoto significa che non è prevista alcuna operazione per la transazione pianificata.






Nella parte inferiore della finestra sono presenti due pulsanti:
	Il pulsante Annulla permette di uscire dalla finestra Dall’ultimo avvio... senza creare le transazioni pianificate.

	Il pulsanteOk chiude la finestra Dall’ultimo avvio e applica le operazioni in sospeso.



Nella parte inferiore destra della finestra Dall’ultimo avvio... è possibile abilitare l’opzione Controlla le transazioni create. Abilitandola, quando sono presenti una o più transazioni Da creare, premendo il tasto Ok verrà aperta una finestra del registro in cui sono visualizzati dettagli della transazione inserita automaticamente da GnuCash

Assistente per mutui e ipoteche



Questa procedura guidata crea una transazione pianificata per il rimborso di un prestito. Quando è utilizzato per creare una transazione pianificata, l’assistente crea una formula variabile in modo che l’interesse composto venga correttamente calcolato. Per avviare l’assistente occorre selezionare Operazioni → Transazioni pianificate → Rimborso di mutui e ipoteche... dal menu principale.’
It does not support zero-interest loans, but one doesn't really need an assistant for that: Just create a scheduled transaction for the principal divided by the number of payments that lasts for the number of payments. For example, if one has borrowed $1200 for a year at no interest and promised to pay it back in monthly installments, the repayment schedule is $100 monthly for twelve months.
L’assistente per il rimborso di mutui e ipoteche presenta all’avvio una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra rimarranno invariati in tutte le finestre dell’assistente.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

	Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Il pulsante Avanti permette di avanzare nella procedura.



La schermata seguente permette di inserire le informazioni essenziali per il prestito. Queste sono fornite normalmente dalla banca al momento della firma dei documenti da parte del debitore. Qui è inoltre possibile impostare il conto che la transazione pianificata utilizzerà per inoltrare il pagamento.
	Conto del mutuo: scegliere un conto per le transazioni di pagamento del mutuo o utilizzare il tasto «Nuovo...» per creare un nuovo conto per le transazioni.

	Importo: l’ammontare del prestito.

	Interest Rate: Enter the loan interest rate in percent per compounding period. The Assistant supports rates between .001% and 100%.

	Tipo: scegliere il tipo di prestito. Se viene impostato il tasso fisso, il riquadro della frequenza è disabilitato.

	Frequenza di variazione del tasso di interesse: scegliere la frequenza con cui il tasso cambia e la data di inizio del cambiamento.

	Data d’inizio: selezionare la data in cui il prestito è stato acceso.

	Length: Enter the length of the loan with the number and
	      period, e.g. 60 months or 5 years.

	Months Remaining: This tells the Assistant how many months
	      remain on the loan. The default value assumes that the loan is paid up through
	      today. For example, if a 5-year loan started on 1 January 2012 and today is 12 July
	      2015, the default months remaining is 18. If you want to create past payment
	      transactions you'll set the months remaining accordingly: In our example, if you
	      wanted to create all of the payments you'd set "months remaining" to 60; if you wanted
	      to start tracking the payments at the beginning of 2015 you'd enter 24. 



La schermata successiva è destinata all’impostazione del conto di garanzia, dell’assicurazione e delle opzioni delle tasse per il prestito; È utile soprattutto per i pagamenti dei mutui. Quando ognuna di queste opzioni è impostata, vengono abilitate delle pagine aggiuntive nell’assistente per impostare queste voci del pagamento. Tutte le pagine verranno descritte in questa sezione anche se alcune potrebbero non venire visualizzate se l’opzione corrispondente non è stata scelta.
	... usare un conto destinato a garanzia per i pagamenti?: questa opzione abilita l’utilizzo di un conto impostato per tracciare i pagamenti a garanzia. Se il mutuo o il prestito utilizzano un conto destinato a garanzia per il pagamento delle tasse, dell’assicurazione ecc... allora si imposti il conto qui.

	... pagare imposte?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento delle tasse.

	... pagare assicurazione?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento dell’assicurazione.

	... pagare "PMI"?: aggiunge una schermata per impostare una transazione pianificata per il pagamento della PMI (Private Mortgage Insurance = assicurazione privata sul mutuo).

	... pagare altre uscite?: aggiunge una schermata addizionale per impostare una transazione pianificata dedicata al pagamento delle altre spese relative al prestito.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il rimborso del mutuo.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: visualizza le variabili utilizzate per il calcolo della rata da pagare.

	Pagamento da: scegliere un conto da cui pagare il prestito.

	Capitale a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso del capitale.

	Interessi a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso degli interessi.

	Repayment Frequency: Select the Frequency and start date for loan
	      repayments. Note that the start date will be the posted date of the first scheduled
	      transaction. This is not taken into account for calculating the remaining duration of
	      the loan, see Months Remaining:. Make sure that you set both to
	      reflect your intentions or you may get surprising results.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle tasse.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle tasse.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle tasse.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle imposte.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell’assicurazione.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento della PMI.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento della PMI.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento della PMI.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell’assicurazione privata sui mutui ipotecari.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento dell’importo dell’assicurazione.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento dell’assicurazione.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento dell’assicurazione.



La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle altre spese.
	Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

	Importo: inserire l’importo da pagare.

	Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle altre spese.

	Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle altre spese.

	Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle altre spese.



L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata per il prestito. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

	Il pulsante Indietro riporterà alla schermata precedente permettendo la modifica delle opzioni immesse in precedenza.

	Il pulsante Termina terminerà l’assistente e creerà la transazione pianificata.



Ora si dovrebbe avere la transazione pianificata per il rimborso del mutuo o del prestito, impostata correttamente.

Registrare un frazionamento azionario



I frazionamenti azionari avvengono quando una Società decide che il prezzo dell’azione è troppo elevato per un singolo investitore che vuole acquistarla. Il frazionamento ha l’effetto di far diminuire il prezzo della singola quota mantenendo invariato il valore delle quote possedute dall’investitore che ha già acquistato le azioni.
Assistente per il frazionamento azionario



GnuCash utilizza questo assistente per registrare i frazionamenti azionari; esso fornisce un modo per inserire i dettagli del frazionamento, qualsiasi cambiamento nel prezzo dell’azione o anche il cash disbursement derivante dal frazionamento azionario.
L’assistente per il frazionamento azionario è accessibile dal menu Operazioni → Frazionamento azionario....
L’assistente visualizza subito una schermata che contiene una breve descrizione del suo funzionamento e del suo utilizzo. I tre pulsanti in basso nella schermata, non cambieranno durante l’utilizzo della procedura guidata.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare l’inserimento delle informazioni del frazionamento azionario. Qualsiasi scelta effettuata nella procedura guidata fino a questo punto, verrà persa.

	Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Il pulsante Avanti permette di avanzare nella procedura.



La schermata successiva permette di selezionare un conto per le azioni. Selezionare un conto dalla lista per registrare un frazionamento o una fusione azionaria.
	Conto: viene elencato il nome del conto di GnuCash per l’azione.

	Simbolo: il simbolo dell’azione associata con questo conto.

	Quote: il numero di quote che sono state acquistate nel conto.



La schermata successiva permette di impostare i dettagli del frazionamento azionario. La parte superiore della finestra contiene dei dettagli utilizzati nella creazione della transazione per il frazionamento azionario.
	Data: selezionare la data del frazionamento azionario.

	Share Distribution: inserire il numero di quote guadagnate dal frazionamento azionario. Per una fusione azionaria si inserisca un numero negativo.

	Descrizione: inserire una descrizione o lasciare quella di default.



La parte inferiore della finestra contiene dei dettagli utili per registrare un prezzo per il frazionamento (opzionale).
	Nuovo prezzo: inserire il prezzo delle azioni nel giorno del frazionamento azionario.

	Valuta: selezionare la valuta delle quote.



La schermata successiva permette di inserire una transazione per l’esborso di liquidi (Cash In Lieu) come conseguenza del frazionamento azionario (opzionale).
	Importo in contanti: inserire l’importo dell’esborso di liquidi.

	Promemoria: inserire un promemoria o lasciare quello di default.

	Conto entrate: scegliere un conto delle entrate per l’esborso.

	Conto attività: scegliere un conto delle attività per l’esborso.



L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.
	Il pulsante Annulla permette di uscire dall’assistente e cancellare il frazionamento azionario. Qualsiasi scelta effettuata nella procedura guidata fino a questo punto, verrà persa.

	Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

	Il pulsante Terminacrea le transazioni necessarie per registrare il frazionamento azionario.



Ora dovrebbe essere stata immessa correttamente il frazionamento o la fusione azionaria.


Procedura guidata per l’HBCI (Online Banking)



Nota
Questa sezione è "in costruzione - ogni contributo è benvenuto!!".

La procedura guidata per l’HBCI permette di creare e modificare i dati necessari per accedere alle transazioni registarte dall’online banking. Attualmente, le istruzioni più complete per questo procedimento sono nella wiki di GnuCash all’indirizzo Setting up OFXDirectConnect in GnuCash 2. Se la voce Impostazione dell’Online Banking non appare nel proprio menu Strumenti, verificare di essere nella finestra della struttura dei conti o nella scheda del registro.

Editor prezzi



Nota
GnuCash uses the term commodity to mean anything that it
     counts: Currencies, securities (i.e intangible assets like stock
     or mutual fund shares and bonds), or tangible assets like trucks
     and computers. When valuing one commodity in terms of another it
     uses the term Exchange Rate
     between two currencies and Price between a non-currency commodity
     and a currency commodity. For the rest of this section we'll use
     "price" to mean both price and exchange rate and "commodity" to
     mean any sort of commodity except where currency behavior is
     different.

The Price Editor is used to list and edit the price of one
     commodity in another commodity. New prices can be added, existing
     prices can be edited, and prices can be retrieved from a variety
     of sources on the World-Wide Web when the commodity is properly
     configured.
Each commodity pair can have one price per day. An existing
     price will be overwritten by a newer one if the newer one has the
     same or a more preferred source. The order of source preference
     (1 is most prefered) is:
     
	user:price-editor: Prices created manually in the
       Price Editor

	Finance::Quote: Online quotes

	user:price: Prices entered explicitly in the
       Exchange Rateentry of the
       Transfer Funds dialog box or in the
       Price column of a register for an account
       of types STOCK or MUTUAL

	user:xfer-dialog: Prices calculated from an entry in
       the To Amount entry of the
       Transfer Funds dialog box.

	user:split-register: Prices calculated from the
       Shares and Debit or
       Credit columns of a register for an
       account of types STOCK or MUTUAL

	user:stock-split: Prices entered in the
       Stock Split Assistant 




     
Nota
Prices created manually in the Price
     Editor are preferred over prices retrieved via
     Finance::Quote so Finance::Quote will fail to update such
     manually-created prices.


     
 The Price Editor displays existing prices as follows:
        
	Security: The
            Security/commodity being priced. The display is sorted by
            the Namespace that the individual
            securities are listed on.  The list is expanded by
            clicking on the caret on the left of
            the name.

	Valuta: la valuta con cui il prezzo è registrato.

	Data: la data in cui il prezzo è stato registrato.

	Source: The source
            of the commodities price quote, listed above.

	Tipo: esistono diversi tipi di prezzi per le azioni.
	Offerta: indica il prezzo con cui un operatore specializzato è pronto ad acquistare un’azione.

	Domanda:  indica il prezzo con cui gli operatori sono pronti a vendere l’azione.

	Ultimo:  indica il prezzo con cui è avvenuto l’ultimo scambio per l’azione o titolo. Rappresenta il prezzo più comunemente utilizzato dai media.

	Net Asset Value:
             Are typically used for mutual funds. They are
             calculated on the net value of the fund’s assets
             each day around the time of the market close and are in
             effect until the next recalculation.

	Sconosciuto: utilizzare questa voce se il tipo di prezzo non è noto.




	Prezzo: il prezzo attuale della commodity.




     
Aggiungere manualmente il prezzo di un’azione



Per inserire un nuovo prezzo, premere Aggiungi e inserire i dettagli del titolo e del prezzo nel riquadro. Per modificare un prezzo esistente, selezionarlo dalla lista dei prezzi, premere il pulsante Modifica e modificare i dati presenti.
Per cancellare un singolo prezzo, selezionarlo e premere il pulsante Rimuovi. Per rimuovere tutti i prezzi più vecchi di una certa data, premere il pulsante Rimuovi vecchi e inserire i dettagli nella schermata visualizzata.
Verrà visualizzata una finestra con il messaggio "Cancella tutti i prezzi delle azioni in base al seguente criterio:". Inserire quindi la data dell’ultimo prezzo da cancellare.
Al di sotto del campo della data sono presenti due opzioni:
	Cancella i prezzi inseriti manualmente - se selezionata, verranno cancellati i prezzi immessi manualmente e datati precedentemente alla data specificata. Diversamente solo i prezzi aggiunti dal modulo Finance::Quote verranno cancellati.

	Cancella l’ultimo prezzo per un’azione - se selezionata, verranno cancellati i prezzi precedenti alla data specificata. Diversamente, l’ultimo prezzo precedente alla data specificata verrà conservato e tutte le quote più vecchie saranno cancellate.




Configurazione per l’utilizzo del pulsante Ricevi quotazioni



Per avere il supporto alla ricezione delle quotazioni tramite internet per una particolare azione o fondo comune, occorre prima di tutto abilitare l’opzione per la ricezione delle quotazioni e selezionare una fonte nell’Editor titolo. Questo processo è descritto in dettaglio in la sezione chiamata «Configurare titoli e valute per la ricezione online dei prezzi». Una volta abilitato il servizio e installato il modulo Finance::Quote, sarà possibile aggiornare le quotazioni delle proprie azioni e dei propri fondi comuni premendo semplicemente il pulsante Ricevi quotazioni.


Editor titoli



L’editor titoli è utilizzato per creare o modificare le commodity che vengono utilizzate dai conti per i fondi comuni e per le azioni; permette anche di visualizzare i dettagli delle valute nazionali utilizzate da GnuCash.
Per mostrare i dettagli delle valute Nazionali, si attivi l’opzione Mostra valute Nazionali in basso nella schermata.
Per ogni elemento della lista, sono visualizzati i dettagli relativi al titolo o valuta:
	Type: Categories for organizing securities. GnuCash has the following built in:
	CURRENCY or ISO4317: These are used for national currencies and are not editable with the Security Editor.

	FUND: Ordinarily used for open-ended mutual funds, i.e., those that one purchases from and sells to only the issuing company and that are priced daily at their net asset value.

	AMEX, ASX, EUREX, NASDAQ, and NYSE: These represent a few of the exchanges on which stocks, closed-end mutual funds, and exchange-traded funds are traded.

	Template: This is a reserved word. It will not normally appear in the Security Editor unless you type it in, and if you do it will cause problems. Don't use it.



If your investment doesn't fit into one of these categories, for example if you trade stocks on the DAX or LSE, you can easily create your own type simply by typing it into the field. The type of security has no meaning to Gnucash (except Template, don't use that!), it's there only to make it easier for you to find the security from the selection lists.

	Simbolo: il simbolo o l’abbreviazione della commodity. Generalmente si tratta del simbolo ticker (per le azioni) o un’abbreviazione univoca per la commodity. Se la commodity è scambiata in un mercato pubblico, è importante utilizzare lo stesso identificatore utilizzato nel mercato. Per le valute Nazionali il simbolo è il codice della valuta secondo la norma ISO-4217.

	Nome: il nome completo della commodity. Assegnarne uno riconoscibile come, per esempio, Dollari USA o azioni IBM.

	Codice: rappresenta un codice numerico o alfanumerico utilizzato per identificare la commodity. Il codice CUSIP è una stringa numerica che identifica univocamente ogni azione, bond o fondo comune e la maggior parte dei tipi di traded options, futures and commodiy. Questo codice non è obbligatorio.

	Frazione: rappresenta l’unità minima scambiata della commodity, espressa come frazione di una singola unità nominale. Questa unità è utilizzata dai conti in GnuCash come la frazione predefinita per gli scambi della commodity.



Aggiungere o modificare una commodity



Per inserire una nuova commodity (azione o fondo comune), premere Aggiungi e inserire i dettagli della commodity nella finestra per il Nuovo titolo. Per modificare una commodity esistente, selezionarla dalla lista, premere il pulsante Modifica e modificare la finestra di Modifica titolo. Per eliminare una commodity, selezionarla e premere il pulsante Rimuovi.
I campi nelle schermate di nuovo titolo e modifica titolo sono le stesse presentate nell’ la sezione chiamata «Editor titoli». Al di sotto di questi campi sono presenti le opzioni per le quotazioni online.

Configurare titoli e valute per la ricezione online dei prezzi



Per avere il supporto alla ricezione delle quotazioni online per una particolare azione o fondo comune, è necessario prima di tutto abilitare la ricezione delle quotazioni online e selezionare la fonte dall’editor del titolo. Per icevere invece i tassi di cambio delle valute, è necessario che sia solamente abilitata l’opzione per le quotazioni online, che venga selezionato il fuso orario e che sai attivata l’opzione «Ricevi quotazioni» nell’"editor titoli".
Istruzioni dettagliate sono reperibili nella sezione sulla creazione di nuovi conti. la sezione chiamata «Procedura per abilitare l’aggiornamento dei prezzi online»


Calcolatore di prestiti



Il Calcolatore di prestiti è utile per calcolare gli interessi composti. Fornisce la possibilità di inserire quattro parametri dei cinque necessari per calcolare l’interesse composto e di calcolare il parametro incognito.
La calcolatrice è suddivisa in due riquadri: quello di sinistra presenta cinque campi con un pulsante Calcola e un pulsante Pulisci. Il tasto Calcola permette di ottenere il risultato dell’incognita mentre il pulsante Pulisci cancella qualsiasi valore inserito nel campo corrispondente.
	Numero di rate: questo campo è destinato al numero di rate da utilizzare per i calcoli.

	Tasso di interesse: questo campo è destinato al valore percentuale del tasso di interesse.

	Valore attuale: questo campo contiene, di solito, l’importo che è stato chiesto in prestito. È l’importo di base su cui si vogliono calcolare gli interessi.

	Importo della rata: questo campo contiene l’importo del pagamento per il periodo selezionato (ad esempio: mensile, settimanale ecc...). Se serve a ripagare un prestito allora dovrebbe avere un segno negativo.

	Valore futuro: questo campo è per il valore finale al termine del periodo di pagamento. Nel caso si stesse ripagando un prestito per intero allora sarebbe nullo (=0).



Il riquadro di destra contiene i pulsanti per selezionare il tipo di pagamento e l’interesse composto utilizzati per i calcoli nel riquadro di sinistra.
	Interesse composto: questa opzione permette di impostare l’intervallo temporale utilizzato per il calcolo se è stato selezionato l’interesse composto discreto.

	Rata: questo pulsante permette di impostare l’intervallo da utilizzare per il campo del Numero di rate.

	Pagamenti alla fine del periodo: attivare l’opzione se il pagamento della rata alla fine del periodo.

	Pagamenti all’inizio del periodo: attivare l’opzione se il pagamento della rata all’inizio del periodo.

	Interesse composto discreto: questa opzione è utilizzata quando l’interesse è applicato in modo discreto, cioè a intervalli temporali definiti dal pulsante Interesse composto descritto più sopra.

	Interesse composto continuo: questa opzione è utilizzata quando il tasso di interesse è applicato in modo continuo.

	Pagamento totale: questo campo visualizza l’importo totale da pagare per restituire il prestito.



Esempi di utilizzo del Calcolatore di prestiti di GnuCash sono forniti nella «guida ai concetti e manuale». Capitolo sui prestiti nella «guida ai concetti e manuale»

Chiudi libro



The Close Book dialog box is used
     for “closing the books,”--an accounting process that
     resets the balances of the income and expense accounts. In this
     process, income account balances are transferred into an income
     equity account, while expense account balances are transferred
     into an expense equity account. You must specify both these
     accounts, which may be the same. You must also specify the date
     for the closing transfer.
Dialog Box
     Details



The dialog box has the following parts:
	Closing Date: Specify the date
           for the closing transfer. You can type in a date or
           choose one from the drop-down.

	Income Total: Specify the
           account into which the total balance of all income
           accounts will be transferred. Optionally you can create a
           new account to receive the transfer using the 
           New button.

	Expense Total: Specify the
           account into which the total balance of all expense
           accounts will be transferred. Again, you can optionally
           create a new account to receive the transfer using the
           New button.

	Description: Specify the
           description that will be entered in the closing entry.
           




How It Works



GnuCash closes books by
       creating one transaction per currency for income accounts,
       and one transaction per currency for expense accounts. The
       transactions all use the date selected by the user, and each
       transaction may contain any number of splits. Each split
       moves the balance out of one income or expense account. The
       last split in each closing transaction moves the total
       offsetting debit/credit balance into the specified equity
       account.
Each transaction will use the description provided by
       the user in the Description: entry.
The fact that GnuCash just
       uses transactions to close the books makes it very simple to
       undo a book closing: just delete the closing transactions.

What It Doesn’t
     Do



The book closing tool does not delete any accounts or
       transactions; create any new files; or hide any accounts.

Necessity



Note that closing the books in GnuCash
        is unnecessary. You do not need to zero out
       your income and expense accounts at the end of each financial
       period. GnuCash’s built-in
       reports automatically handle concepts like retained earnings
       between two different financial periods.
In fact, closing the books reduces the usefulness of
       the standard reports because the reports don’t
       currently understand closing transactions. So from their
       point of view it simply looks like the net income or expense
       in each account for a given period was simply zero.

Conclusion



If you close your books, be prepared to see inaccuracies
       in the standard reports. On the other hand, you will see
       current-period income and expense figures in the chart of
       accounts.


Lots in Account




      GnuCash uses lots in 2 ways:
    
	To link security buy transactions to sell transactions so
         the real cost of the sold securities can be used to calculate capital
         gain or loss. See la sezione chiamata «Lots for Security Capital Gains».

	To link payments or credit notes to the invoices to which
          they apply in the Business Features. See
          la sezione chiamata «Lots for Business Features».



Lots for Security Capital Gains




        The Lots in Account SSSS window, where SSSS is
        the security account, is used to manually or automatically link
        security transaction splits to lots and create capital gain/loss
        transactions to account for the difference between the costs of buying
        a security and the value received by selling it.
      
To open the Lots in Account window, open the
        security account register, then select
        Actions → View Lots.
      
Figura 8.1. Lots in Account window for Security Capital Gains
        
[image: Example of Lots in Account window for a security account]An image of the Lots in Account
               window for a security account.






Screen Elements



Adjusting the Size of Screen Elements
        
As well as adjusting the size of the whole window, it is
          possible to adjust the proportions of the window elements both
          horizontally and vertically.
        
There are 2 bars for adjusting the window horizontally. One
          between the Title and the Lots in
          This Account panel, and the other between the 
          Splits free panel and the >>
          and << buttons.
        
The window proportions may be adjusted vertically by
          dragging the vertical bar located to the right of Show
          only open lots.
        
These resizing bars can be hard to see, so move the mouse pointer
          until it changes to the resize pointer then click and drag the bar.
          The resize pointers are different depending on your operating system
          and theme. Here are some examples of resize pointers:
        

          [image: <->]

          [image: Screen Elements]
        
It is not possible to individually adjust the size of panel
          columns.
        
Fields
	Title: Shows the title for the highlighted
              (selected) lot in the Lots in This Account 
              panel. When a new lot is created by clicking the New Lot
               button, it has a default title of Lot n
               where n is a number starting at 0 (for each security
              account) and incrementing by 1. Deleting a lot does not reset the
              next number to be used, but the title can be changed as required.
            

	Notes: Notes for the highlighted lot.
              Users are free to enter anything they wish and the notes can be
              changed as required.
            



Panels
The order of the items in all the panels in this window
          can be adjusted by clicking on the column headings.
        
	Lots in This Account panel
This panel shows lots for this security account.
If Show only open lots is checked, only
              lots that have not been completely sold are shown.
            
Columns
	Type: Always
                blank for security lots. This window is also used for business
                lots (which link payments to invoices) when coming from an
                Accounts Payable or Receivable account and in that case,
                Type will be I for
                invoice. Credit Notes are also Type I.

	Opened: Open
                   if there are no splits in the lot, otherwise the
                  date of the earliest split in this lot.

	Closed: 
                Open if the lot is not fully sold, otherwise the
                date of the last sell split.

	Title: Lot Title.

	Balance: Number of unsold
                securities in this lot.

	Gains: Calculated
                gains or losses for this lot.




	Splits free panel
This panel shows buy and sell splits for this security
              account which are not linked to a lot. Capital Gains splits
              (Shares and Price are 0) are not shown.
            
Columns
	Date: Transaction Date Posted.
                

	Num: Transaction Num.

	Description: Transaction
                Description.

	Amount:
                Number of shares bought or sold from the transaction split.
                Positive for buys, negative for sells. If the security
                transaction split has been split into multiple subsplits
                (because a split may only be linked to 1 lot), this amount
                will not be the full transaction amount, but only the amount
                for this split.

	Value: Amount x split price.
                

	Gain/Loss:
                For sell splits, shows calculated gain or loss. This will
                be recalculated during scrubbing.

	Balance:
                Cumulative number of unsold shares for free splits.
                




	Splits in Lot panel
This panel shows splits linked to the highlighted lot in
              the Lots in This Account panel. This
              panel will be empty until a lot is highlighted in the
              Lots in This Account panel. Capital Gains
              splits (Shares and Price are 0) are not shown.
            

              Columns
            
	Date:
                Transaction Date Posted.

	Num:
                Transaction Num.

	Description:
                Transaction Description.

	Amount:
                Split number of shares bought or sold. Positive for buys,
                negative for sells. If the security transaction split has been
                split into multiple subsplits (say by scrubbing because a
                split may only be linked to 1 lot), this amount will not be
                the full transaction amount, but only the amount for this
                split.
              

	Value:
                Amount (No of Shares) x split price.

	Gain/Loss:
                For sell splits, shows calculated gain or loss. This will
                be recalculated during scrubbing.

	Balance:
                The number of unsold shares in this lot after this
                transaction.






Buttons
	
               >>: Links a free split
              (buy or sell) to a lot. This button is not enabled until both
              a lot and a free split are highlighted. The split moves from
              the Splits free panel to the 
              Splits in lot panel.
            
Multiple buy splits and multiple sell splits may be linked
              to the same lot. Refer to following section about the 
              Scrub Account button for details of the capital gains
              transactions created in these situations.
            

	 <<: Unlinks a split
            from a lot. The split moves from the Splits in lot
             panel to the Splits free panel.
            This button is not enabled until a split in the Splits
            in lot panel is highlighted. When the last split is
            unlinked from a lot, the lot is automatically deleted
            if there is no capital gain/loss transaction.

	New Lot: Creates a new
            lot which shows in the Lots in This Account
            panel. The new lot is not linked to any split.

	
              Scrub Account:
            
	Creates a lot for each buy transaction split
                that is not already linked to a lot.
A new lot is created for each unlinked buy transaction
                  split because gains on investments, in some jurisdictions,
                  may be taxed at different rates depending on how long they
                  were held before being sold. As a separate capital gains
                  transaction is created for each lot, this makes it easier to
                  determine tax on the capital gains based on the lot opened
                  and closed dates.
                
If you know that the capital gains from a
                  sale are all to be taxed at the same rate, you can manually
                  link multiple buys to a lot so scrubbing will only create
                  1 capital gains transaction.
                

                  It is also possible to manually link multiple sell
                  transaction splits to a lot. In this case scrubbing creates
                  a capital gains transaction per sell transaction split
                  based on the average cost of securities held at the time of
                  each sale, assuming acquisitions are allocated to sales
                  using the security account costing method (currently only
                  FIFO). As this makes it complicated to manually verify the
                  costs are correct, it may be wise to limit this to specific
                  situations, say for example if there are multiple sales on
                  the same day.
                

	Links buy and sell transaction splits to lots using FIFO
                  method.
                

	Calculates gain/loss and creates a separate capital
                  gain/loss transaction for each lot that does not already
                  have one.
                
Nota
If gain/loss splits have been manually entered as
                      part of a sell transaction, scrubbing does not recognize
                      them, so if manually adding gain/loss, always separate
                      the gain/loss splits from the transaction that reduces
                      the No of Shares, by putting them
                      in a separate transaction.
                    





	Scrub: Scrub only the
              highlighted lot. This button is only enabled if a lot is
              highlighted. If no buy splits are linked to the highlighted lot,
              nothing is done. The Scrub button will link
              any free sell splits to the lot as required until the sum of the
              sell split amounts equals the sum of the buy split amounts. If
              the sum of the sell split amounts is greater than the sum of the
              buy split amounts, a sell split will itself be split into 2
              splits, with the remaining amount in an unlinked split.
            
Nota
For both the Scrub Account and the
                Scrub buttons:
              
The Gain/Loss for each lot is recalculated and a capital
                gain transaction is created if needed. The transaction has
                1 split for the security account and the other with
                account Orphaned Gains-CCC where CCC is
                the security currency. The Orphaned Gains-CCC
                 account is used because GnuCash
                 doesn't know which capital gain or loss
                account should be used, so the user must change it to the
                required income (or expense) gain or loss account.
              


	Delete: Delete the highlighted
              lot. Any linked splits are automatically freed (unlinked). This
              button is only enabled if a lot is highlighted.
            

	Close: Close the 
              Lots in Account SSSS window.
            



See Tutorial and Concepts Guide, 
          Automatic Calculation of Capital Gain or Loss Using Lots for
          more details.
        


Lots for Business Features



Introduction



For business features, lots are used to link payments or credit
          notes to the invoices to which they apply. This is for both customer
          invoices and vendor bills.
        
There are 2 main uses for the Lots in Account
          window in relation to the business features:
        
	
              To enquire about which payments or credit notes offset particular
              invoices. For each invoice and credit note, GnuCash
               automatically creates 1 (and only 1) lot. By
              selecting the lot for the invoice or credit note in the 
              Lots in This Account panel, all the transaction splits
              for that lot show in the Splits in Lot panel.
            
Suggerimento

                Alternatively, print the invoice and check the 
                Payments option on the Display tab in the report
                options. The Tax Invoice always shows payments so does not have
                the Payments option.
              


	
              To correct mistakes that are hard to correct otherwise (either due
              to bugs in past versions of gnucash or due to unintended use of
              said features). Some of these use cases are found on
              
                this wiki page
              . In the context of the normal operation of business
              features , the Lots in Account window is
              not used to create, delete, link or unlink
              lots. Lots are usually generated and manipulated internally only
              by the business features programs.
            



To open the Lots in Account AAAA window,
          where AAAA is the Accounts Receivable (AR) or
          Accounts Payable (AP) account, open the
          AR or AP account register,
          then select
          Actions → View Lots.
        
Figura 8.2. Lots in Account window for business features
[image: Example of Lots in Account window for an Accounts Receivable account]An image of the Lots in Account
                 window for an Accounts Receivable account.







Screen Elements



The screen elements of the Lots in Account
          window for an AR or AP account are the same as for a security account,
          although the actions and data are different. As this window is only
          used for creating, deleting, linking or unlinking lots in 
          exceptional circumstances, the differences are not
          described. See la sezione chiamata «Screen Elements» for a description
          of the screen elements and what the buttons do when used with the lots
          of a security account.
        



Capitolo 9. Resoconti e diagrammi



Nota
This section is a «work in process». Some of the material has not been reviewed for V2.0.
      While it may not be strictly accurate, it is at least a "guide".

Introduction



Resoconti e diagrammi permettono a GnuCash di presentare una vista generale dei dati finanziari in vari modi. Questi strumenti vanno da un semplice sommario dei totali del conto ad una visualizzazione avanzata di un portafoglio. Questa sezione presenterà una spiegazione dei principali resoconti di GnuCash e su come personalizzarli
To run a report or chart, click on the Reports
      menu, then either select
     a report (it will open with standard options), or click on 
     Saved Report Configuration to select a report you have
     previously configured and saved.
   
Once the report has opened, click on the Options
      toolbar button to
     configure the report as needed, for example to set the report date or
     select accounts.
   
Suggerimento
If you intend to save a report configuration, you
     should choose a named report date option such as Today
     rather than enter a specific date so it is not necessary to
     enter a specific date again in future reports.

Suggerimento
If you often run a report with a date as at the start or end of an
       accounting period, set the accounting period start and end dates in
       Edit → Preferences → Accounting Period then select
       appropriate report date options.
       See la sezione chiamata «Periodo contabile».
     

Suggerimento
If you cannot find a specific report to suit your requirements, you
       may be able to use the Find Transaction assistant
       (Edit → Find) to select a set of transactions, and then report them
       using Reports → Account Report
       . Further formatting or analysis may be done
       by copying and pasting the report into a spreadsheet.
     

After you have configured a report, you can save the configuration for
     future use by clicking either the Save Report Configuration
      or Save Report Configuration As...
     button.
   
Saving a Report Configuration



To save a report configuration for future use, while the required
       report tab is selected, go to the report options, select the
       General tab and change the Report Name
        to a meaningful unique name. Do not confuse this with the
       Report Title which prints at the top of a report.
     
Click the Save Report Configuration or
       Save Report Configuration As... button. This will
       store your customized report options in a file in your home directory.
       E.g. Linux: ~/.gnucash/saved-reports-[versioninfo]
     
The first time you save a report with a name that has not already
       been saved, you can use either the Save Report Configuration
        or the Save Report Configuration As...
        button. You can modify the report name before saving it.
     
After a report configuration for a specific name has been saved, the
       Save Report Configuration button will immediately
       update the saved report configuration without giving the opportunity to
       save the configuration with a new name. Use the Save Report
       Configuration As... button to save the current report
       configuration with a new name.
     
After your customized report has been saved, it is available for use
       by the Reports → Saved Report
       Configurations menu and it will also be listed
       when starting Reports → Sample
       & Custom → Custom Multicolumn Report
       .
     

Working with Saved Report Configurations



Selecting Reports → Saved
       Report Configurations will open a dialog
       window with a list of the Saved Report Configurations
        you have previously created. In this
       context Saved Report Configurations means the set of
       customized settings for standard reports.
     
The Saved Report Configurations window lists
       each of your previously saved report configurations, and 3 small buttons
       at the end of each. These buttons perform the following actions
     
	Load (and run) report configuration. Double clicking a
         report configuration also performs this action.

	Edit report configuration name. This enables a report
         configuration to be renamed.

	Delete report configuration.






Configuring Reports and Charts



GnuCash reports have many configuration
          options. First, run the original report itself. Then,
        access the report options with the Options
        button on the toolbar.
Nota
Check changed Graphic Engine Options

Report Options Buttons



After modifying report options, either
	Click the OK button to apply the changes,
           regenerate the report and
           close the options window.
or

	Click the Apply button to apply the
           changes, regenerate the report and leave the options window open for
           possible further changes. In this case, both the Apply
            and OK buttons will be disabled,
           indicating changes have been applied, until further changes are made.
         
or

	Click the Cancel button to close the
           options window without applying any unapplied changes.




Common Report Options



Many reports share similar options. Some common ones include:
	Nome resoconto: imposta il titolo del resoconto; è anche utilizzato per stampare il resoconto allo scopo di visualizzarlo in seguito.

	Opzioni della data: normalmente i resoconti si riferiscono a una specifica data o intervallo di date. Queste possono essere impostate in due modi: direttamente (utilizzando il selettore di data) o selezionando una data relativa dal menu. Le date relative permettono di specificare dei valori quali Inizio di quest’anno o Oggi.
Suggerimento
If you often run a report with a date as at the start or end
             of an accounting period, set the accounting period start and end
             dates in Edit → 
             Preferences → Accounting Period
              then select appropriate report date
             options. See la sezione chiamata «Periodo contabile».


	Intervallo temporale: questa opzione è utilizzata negli istogrammi per impostare l’intervallo con cui ogni barra viene rappresentata. Valori tipici sono: quotidianamente, settimanalmente, mensilmente e annualmente.

	Conti: selezionare il conto appropriato per il resoconto. Si noti che per alcuni resoconti è possibile selezionare solo certi tipi di conti. Per esempio, un grafico a torta delle uscite è visualizzabile solo se viene selezionato un conto delle uscite.

	Mostra il nome completo del conto: questa opzione permette di scegliere se visualizzare il nome del conto nella forma breve (per esempio Elettricità) oppure completa (per esempio Servizi:Elettricità).

	Includi sottoconti: i resoconti di sommario generalmente hanno un’opzione per includere anche i sottoconti che, se selezionata, fa in modo che sai compresi nel resoconto anche i sottoconti del conto padre selezionato..

	Profondità: questa opzione permette di selezionare il numero di livelli con cui il resoconto deve visualizzare i sottoconti. Se questi superano il livello selezionato, verrà calcolato un valore complessivo per tutti i sottoconti e incluso nel totale. Per fare in modo che ogni conto o sottoconto venga visualizzato singolarmente, selezionare tutti.

	Style Sheet: Select a Style Sheet. Style sheets control how reports are
             displayed. At the moment, there are four style sheets: Default, Easy,
             Footer and Technicolor.
             You can customize each of these from the Edit → Style
             Sheets... menu item.
             This is described in the la sezione chiamata «Modificare i fogli di stile» section.

	Plot Dimensions: There are width and height options for most charts, which
             specify the displayed dimensions (in pixels).

	Valuta del resoconto: seleziona la valuta da utilizzare per il resoconto. Generalmente le valute verranno convertite in questa valuta per la visualizzazione.
The default Report Currency is defined in Edit → Preferences Reports tab. See la sezione chiamata «Resoconti».
            

	Fonte del prezzo: selezionare come i prezzi delle azioni e delle valute vengono calcolati in questo resoconto. È possibile scegliere tra la media pesata dei prezzi su tutte le transazioni, i prezzi al valore corrente o i prezzi al momento della compilazione del resoconto.

	Totali: per i diagrammi verrà visualizzata una legenda con i totali.

	Fette massime: controlla il numero massimo di fette visualizzate in un diagramma a torta. Gli altri conti verranno raggruppati in una fetta identificata con Altro.

	Numero massimo di barre: controlla il numero massimo di barre da visualizzare in un istogramma.

	Visualizzazione colonne: permette di scegliere le colonne da visualizzare dal registro.





Reports Listed By Class



GnuCash has classified the main types of
     reports into major classes. These
      are all available under the Reports menu.
Resoconti generali



The General Reports include the Account Summary Report, the Future
        Scheduled Transactions Summary, the Tax Schedule Report and 
        TXF Export, and the Transaction Report and also the reports in the Sample & Custom menu.
Sommario del conto



 

Future Scheduled Transactions Summary



 

Tax Schedule Report and TXF Export



The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The report is intended to be used by a tax payer to manually prepare his or her own tax return, or alternatively, to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections made to transactions, report settings, currency conversion rates or the account structure as needed. This process should be repeated as often as needed until all the amounts on the report are correct before a final version is used and saved along with the tax returns.
 For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions for the time period selected (also in the report options) are included. The report sorts transactions by date within account providing subtotals by account within tax code within Form or Schedule line number. Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules. Optionally uses special date processing to include federal estimated tax payments after year end.
All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest the report date as specified in the report options; if none is available, transaction amounts are converted to zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.
Nota
For this to work, the user has to segregate taxable and non taxable
           income to different accounts, as well as deductible and non deductible expenses.
           The Income Tax Information dialog is used for this. To access the Income Tax
           Information dialog go to Edit → Tax Report Options. The user
           also must set the TXF category of each tax related account. The Income Tax
           Information dialog is described in the la sezione chiamata «Impostare le opzioni per i resoconti delle tasse» section.


Resoconto delle transazioni



This report lists transactions in selected accounts during a specified financial period. Two fields may be optionally
          used for sorting and totalling.
        
Opzioni del resoconto



Figura 9.1. Transaction Report, Report Options
[image: Transaction Report, Report Options screen]This is an image of the Transaction Report, Report Options, Display tab.






	Accounts tab
	Accounts: Select one or more accounts to be reported.
There are 4 buttons to aid account selection
	Select All	Select all accounts
	Clear All	Clear the selection and unselect all accounts
	Select Children	Select all descendants of selected account
	Select Default	Select the default account selection



	Show Hidden Accounts: Show accounts that have been marked hidden.

	Filter By: Optionally select accounts to be either included or
                   excluded depending on Filter type

	Show Hidden Accounts: Show accounts that have been
                   marked hidden in the Filter By list of accounts

	Filter Type: One of
	None	Do not do any filtering
	Include Transactions to/from Filter Accounts	Include Transactions to/from Filter Accounts only
	Exclude Transactions to/from Filter Accounts	Exclude Transactions to/from all Filter Accounts



	Void Transactions: One of
	Non-void only	Show only non-voided transactions
	Void only	Show only voided transactions
	Both	Show both and include voided transactions in totals



	Reset defaults button: Reset all values to their defaults




	Display tab
	Data

	Reconciled Date

	Num

	Descrizione

	Promemoria

	Notes: Display the notes if the memo is unavailable

	Account Name

	Use Full Account Name

	Account Code

	Other Account Name: For multi-split transactions, this parameter should be unticked. See below for more details.

	Use Full Other Account Name

	Other Account Code

	Shares: Display number of shares

	Price: Display share prices

	Amount: One of
	None	Do not display Amount
	Single	Single column display
	Double	Two column display



	Running Balance

	Totals

	Sign Reverses: One of
	None	Do not display signs reversed
	Credit Accounts	Reverse amount display for Liability, Payable, Equity, Credit Card and Income accounts
	Income and Expense	Reverse amount display for Income and Expense accounts



	Reset defaults button	Reset all values to their defaults




	General tab
	Report name: Enter a descriptive name for this report

	Stylesheet: Select Default, Easy, Footer or Technicolor

	Start Date: Enter or select a specific Start Date
or 	select one of the following named start date options which will be used to	determine the start date each time the report is run
                   
	Today	The current date
	Start of this month	First day of the current month
	Start of previous month	First day of the previous month
	Start of current quarter	First day of the current quarterly accounting period
	Start of previous quarter	First day of the previous quarterly accounting period
	Start of this year	First day of the current calendar year
	Start of previous year	First day of the previous calendar year
	Start of accounting period	First day of the accounting period as defined in the global preferences



	End Date: Enter or select a specific End Date,
or	select one of the following named end date options which will be used to determine the end date each time the report is run
                   
	Today	The current date
	End of this month	Last day of the current month
	End of previous month	Last day of the previous month
	End of current quarter	Last day of the current quarterly accounting period
	End of previous quarter	Last day of the previous quarterly accounting period
	End of this year	Last day of the current calendar year
	End of previous year	Last day of the previous calendar year
	End of accounting period	Last day of the accounting period as defined in the global preferences



	Style: One of
	Single	Display 1 line
	Multi-Line	Display N lines


Nota
In stable version 2.8.0, the Style option will be renamed to Detail Level
                     and moved to the Display tab.


	Common Currency: Convert all transactions into a common currency

	Report's currency: Select the currency to display values

	Table for Exporting: Formats the table for cut & paste exporting with extra cells

	Reset defaults button: Reset all values to their defaults




	Sorting tab
	Primary Key: Primary Sort Key. One of
	None	Do not sort
	Account Name	Sort and subtotal by account name
	Account Code	Sort and subtotal by account code
	Data	Ordina per data
	Exact Time	Sort by exact time
	Reconciled Date	Sort by the reconciled date
	Register Order	Sort as within the register
	Other Account Name	Sort by account transferred from/to's name
	Other Account Code	Sort by account transferred from/to's code
	Importo	Sort by amount
	Descrizione	Sort by description
	Numero	Sort by check/transaction number
	Promemoria	Sort by memo



	Show Full Account Name: Show the full account name for subtotals and subtitles

	Show Account Code: Show the account code for subtotals and subtitles

	Primary Subtotal: Subtotal according to the primary key

	Primary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date, exact time or register order.
                   One of None, weekly, monthly, quarterly or yearly

	Primary Sort Order: One of
	Ascending	Smallest to largest, earliest to latest
	Descending	Largest to smallest, latest to earliest



	Secondary Key: Secondary Sort Key. Same options as Primary Key

	Secondary Subtotal: Subtotal according to the secondary key

	Secondary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date, exact time or register order.
                   One of None, weekly, monthly, quarterly or yearly

	Secondary Sort Order: One of
	Ascending	Smallest to largest, earliest to latest
	Descending	Largest to smallest, latest to earliest



	Reset defaults button: Reset all values to their defaults







Displaying Split Account Details



This is controled by the Style option on the General tab.
Nota
In stable version 2.8.0 this option will be renamed to Detail Level on the Display tab.

In Single line mode, there's only one line per transaction. So you can have
            the account name on one side of the equation and
          
a. the other account name if there's only one other split in the transaction
or
b. "Split" if there are multiple other splits in the transaction. You can't
            display multiple "other" account names in one line. There's just no room for it.
          
In the case of Multi-Line mode, this report uses a completely different concept.
            For each transaction, every split (both the split in this account and the
            split(s) in the other account(s) !) is printed on a separate line. And every
            split really means every split:  both the split which belongs in the account
            being reported and the split(s) in the other account(s) that balance the
            transaction. So even the most basic transaction, with only two splits (this
            account and other account) will print two lines in multiline mode.
          
For a simple transaction like this
	Descrizione	Conto	Debit	Credit
	Cheques Received	 	 	 
	"multiple payers"	IncomeAccount	 	£30.00
	 	BankAccount	£30.00	 


then on a Transaction Report for the bank account the details appear pretty much as above.
For clarity of the accounts, you might enter transactions with multiple splits referring to the same
            account. For example, the above transaction might well be entered like this
          
	Descrizione	Conto	Debit	Credit
	Cheques Received	 	 	 
	"FirstPayer"	IncomeAccount	 	£10.00
	"SecondPayer"	IncomeAccount	 	£20.00
	 	BankAccount	£30.00	 


When this transaction is printed on the bank account's Transaction Report in Single line mode, then
            under other account it simply prints the word split instead of the account name.
          
To display the additional split detail, you need to set Single/Multi-Line to
            Multi-Line and then tick Display -> Account Name.
            Do NOT tick Display -> Other Account Name.
          
You can choose whether or not to turn off the full account name using Display ->
            Use Full Account Name.
Use Full Other Account Name has no effect in Multi-Line mode.



Attività e passività



I resoconti di attività e passività includono il rapporto sul saldo, i resoconti sugli investimenti e il resoconto sul patrimonio netto.
	Portafoglio avanzato:
Columns
	Account: Stock Account

	Symbol: Ticker Symbol/Abbreviation as defined in the Security Editor. A report option can suppress this column.

	Listing: Type as defined in the Security Editor. A report option can suppress this column.

	Shares: Number of shares (quantity). A report option sets how many decimal places to show.
	    A report option can suppress this column.

	Price: Unit market price as at report date. A report option can suppress this column.

	Basis: Cost of all shares acquired by any means, including brokerage fees if the option to include them is checked. Report option Basis calculation method can be set to Average, LIFO or FIFO.

	Value: Number of shares * Unit market price as at report date

	Money In: Sum of the cost of stock purchased, excluding stock acquired as part of a Dividend Reinvestment Plan. I.e. External money used to purchase shares.

	Money Out: Money from selling shares or a spin off transaction.

	Realized Gain: Money received for selling shares minus basis for shares sold, minus brokerage fees for the sale if the option to include them in basis is checked.

	Unrealized Gain: Value less Basis for unsold shares

	Total Gain: Realized Gain + Unrealized Gain

	Rate of Gain: Total Gain / Money In * 100 (from GnuCash 2.6.1 onwards)

	Income: Total of all income transactions associated with a stock account.
Nota
To include income from dividends which are not reinvested (if there is no split to the stock account in the income transaction, the report has no way of associating the income with a particular stock) :
                
Ensure there is a dummy transaction split to the stock         account with quantity 0, price 1 and value 0 in the dividend transaction. Enter the dummy stock split with no values in the dividend account and it will create the transaction with price 1 even though you cannot see the Price column in that register.
		
In GnuCash 2.6.6, this report was modified to simplify the recording of dividend and interest payments. With this
                change it may not be necessary to include the dummy stock split in the transaction. The report will find income (and expense) transactions that are in the parent account of the stock account being reported on. This is done by looking in the parent account for transactions that have exactly two splits (not counting trading account splits) where the other split is to an income or expense account with the same name as the stock's account.
                
For example given an account structure like
                


                Assets (type ASSET)

                  Broker (type ASSET)

                    Widget Stock (type STOCK)

                Income (type INCOME)

                  Dividends (type INCOME)

                    Widget Stock (type INCOME)

                

A transaction that debits the "Assets:Broker" account and credits the "Income:Dividends:Widget Stock" account will count as income even though it doesn't have a split with account "Assets:Broker:Widget Stock".
                
This only works if the parent account ("Assets:Broker" in this case) is a Bank or Asset account and the Income/Expense account has the same name as the stock account. It won't double count transactions that have a dummy split since they won't have exactly two split transactions.
                
It will not work if the income or expense account split is to a subaccount of the account with the same name as the stock account i.e. "Income:Dividends:Widget Stock:Franked"
                


	Brokerage Fees: Brokerage Fees

	Total Return: Total Gain + Income

	Rate of Return: Total Return / Money In * 100



Common report options are described in la sezione chiamata «Configuring Reports and Charts»
Report Specific Options
	Accounts Tab
	Include accounts with no shares: Unchecked (default) or checked.




	Display Tab
	Show ticker symbols: Checked default) or unchecked. If unchecked, Symbol column will be omitted.

	Show listings: Checked (default) or unchecked. If unchecked, Listing column (source of shares price quotes) will be omitted.

	Show number of shares: Checked (default) or unchecked. If unchecked, Shares column will be omitted.

	Share decimal places: The number of decimal places to show in the number of shares. Default is 2.

	Show prices: Checked (default) or unchecked. If unchecked, Price column will be omitted.




	Scheda Generali
	Price Source: Nearest in time (default) or Most Recent.

	Basis calculation method: Average (default), FIFO or LIFO.

	Set preference for price list data: Checked (default): Use price list data. If there is no relevant price list data, transaction prices will be used and there will be a warning. Unchecked: Get prices from stock transactions.

	How to report brokerage fees: Include in basis (default), Include in gain or Ignore.







	Istogramma delle attività:
The Asset Barchart report displays bars that present the value of all assets in a
        GnuCash file over time.  By default, the report shows all accounts
        in Accounts Receivable, Current Assets,
        Fixed Assets, Investments and Special Accounts
        (if they exist) and it displays monthly bars for the current financial period.
        This report provides a graphic view of the assets in the file over time.
Suggerimento
Like all the generic reports, the user can assign a title and save the report with
          it's selected options for re-use later.

The display is in the form of either a stacked barchart or simple barchart with an
        option to display a table of the values.
This report calculates and displays a default of 8 bars or up to 24 separate asset
        accounts value at the end of the day on several dates through a specified time period.
        The report automatically selects the most significant accounts to display with all other
        selected accounts summed as Other.
The report exploits the outline structure of the chart of accounts to allow the user
        to select top level accounts and sub-accounts down to a user-selectable depth.  Selected
        sub-accounts below the selected depth are automatically summed up into
        the next level when it is also selected.  The default number of sub-account levels is 2,
        giving a summary view.  Increasing the number of sub-levels increases the detail available
        to display. It is possible to un-select a higher level account and leave sub-accounts
        selected to force greater detail to appear in the report.
By default the report includes all asset accounts and sub-accounts,
        as well as Imbalance and Orphan Special accounts
        in whatever currencies or commodities may be present. The report's base currency is the
        default currency of the GnuCash file but if the file has data
        for multiple currencies, then it can be changed to another currency.
Since each account may be individually selected, the report can be designed to focus
        on a small subset of data such as current assets or investments.
The overall interval of the report defaults to start at the start of the current
        accounting period and to end at the end of the current accounting period. Numerous
        other starting choices and ending choices are available.
The first bar shows the selected values at the end of the day on the first date chosen.
        There are a number of choices for step size from day to
        year with the default being month. Note that if any
        step date would fall on the 29th, 30th or 31st in a month that does not have such a date
        the next interval will be 31 days later. For that step only the date will slip
        up to 3 days into the following month. This is true for releases at least through 2.4.13.
        Bug 639049 is open in Bugzilla to modify this behavior.
Currently, there is no option to start the report on the last day of any period.
        There is also no option to show beginning balances or end of
        previous step balances. This makes it difficult to correlate this report to
        business quarterly reports, for example.
The Net Worth linechart report, Liability barchart report and Net Worth barchart
        report are similar except for the graphic type and default account groups selected.
Other features are customizable in a manner similar to other standard reports.

	Grafico a torta delle attività:

	Saldo medio:

	Rapporto sul saldo: questo resoconto riassume le attività, le passività e il capitale. Quando vengono mantenute correttamente, le attività dovrebbero essere pari alla somma tra passività e capitali; se così non è, allora è presente uno sbilancio all’interno dei conti.

	Balance Sheet using eguile-gnc:

	Giornale generale:

	Libro mastro generale:

	Portafoglio degli investimenti: questo resoconto riassume il valore delle azioni nel paniere corrente.

	Istogramma:

	Grafico a torta delle passività:

	Istogramma del patrimonio netto: il patrimonio netto è rappresentato dalla differenza tra il valore delle attività e quello delle passività.

	Grafico del patrimonio netto: andamento nel tempo del  patrimonio netto (differenza tra il valore delle attività e quello delle passività).

	Grafico a dispersione del prezzo:




Resoconti per gli affari



I resoconti per gli affari includono i rapporti su clienti e venditori, le fatture stampabili e i resoconti Aging reports.
Resoconto venditori



 

Customer Summary



 

Fattura semplice



 

Resoconto dipendenti



 

Fattura elaborata



 

Resoconto di lavoro



 

Payable Aging



This report provides a listing of vendors and their aged
           outstanding balances. Vendors may be included if they have posted
           business transactions (e.g. invoices) for the selected accounts payable
           account. It shows their current balance, and how much they have
           due from invoices over time periods 0-30 days, 31-60 days,
           61-90 days, and over 90 days. The report also contains links to each
           vendor and to their current vendor report.
         
Optionally, vendor address details may be also shown.
Suggerimento
To export vendor address details, say in order to do a mail
           merge, select the optional vendor address details in the report options
           display tab, apply the options to regenerate the report, then copy and
           paste the report into a spreadsheet. Alternatively, the report can be
           exported to a .html file, then read into a spreadsheet.

Opzioni del resoconto



Nota
See Common Report Options in the
             Configuring Reports and Charts section of this
             help manual for more details of the common options.
             

	General tab
	 Report name:
                   Enter a descriptive name for this report - see common report
                   options.

	Stylesheet:
                   Select a style sheet for this report - see common report
                   options.

	To: Select a date
                   to report on or a named date. Transactions up to and
                   including the selected date will be used to calculate the
                   outstanding aged balances. See common report options.

	Report's currency:
                   Select the currency to display the values in - see common
                   report options.

	Price Source:
                   Select the source of price information used for currency
                   conversion if needed. One of
	Average Cost	The
                           volume-weighted average cost of purchases
	Weighted Average (default)	
                           The weighted average of all currency transactions
                           in the past
	Most recent	The most recent
                           recorded price
	Nearest in time	The price
                           recorded nearest in time to the report date



	Show Multi-currency Totals:
                   If not selected, all totals are shown in the report
                   currency.

	Sort By: Sort
                   companies by one of
	Name (default)	Company name
                           
	Total Owed	Total amount owed
                           to company
	Bracket Total Owed	Amount
                           owed in oldest bracket. If same, use next oldest
                           



	Sort Order: One of
                   
	Increasing (default)	 
	Decreasing	 



	Show zero balance items:
                   Show companies even if they have a zero outstanding
                   balance.

	Due or Post Date:
                   Leading date. Which date to use to determine aging. One of
                   
	Due Date (default)	 
	Post Date	 



	Payable Account:
                   The accounts payable account used to select vendors to be
                   reported. Vendors are included if they have a posted
                   business transaction (usually an invoice) on or before the
                   report date and also meet the Show zero balance
                   items criteria.




	Display tab
	Address Name:
                   Display vendor address name. This, and other fields, may be
                   useful if copying this report to a spreadsheet for use in a
                   mail merge.

	Address 1: Display
                   address line 1.

	Address 2: Display
                   address line 2.

	Address 3: Display
                   address line 3.

	Address 4: Display
                   address line 4.

	Phone: Display
                   address phone number.

	Fax: Display
                   address fax number.

	Email: Display
                   email address.

	Active: Display
                   vendor active status.








Fattura stampabile



 

Receivable Aging



This report provides a listing of customers and their aged
           outstanding balances. Customers may be included if they have posted
           business transactions (e.g. invoices) for the selected accounts receivable
           account. It shows their current balance, and how much they have
           outstanding from invoices over time periods 0-30 days, 31-60 days,
           61-90 days, and over 90 days. The report also contains links to each
           customer and to their current customer report.
         
Optionally, customer address details may be also shown.
Suggerimento
To export customer address details, say in order to do a mail
           merge, select the optional customer address details in the report options
           display tab, apply the options to regenerate the report, then copy and
           paste the report into a spreadsheet. Alternatively, the report can be
           exported to a .html file, then read into a spreadsheet.

Opzioni del resoconto



Nota
See Common Report Options in the
             Configuring Reports and Charts section of this
             help manual for more details of the common options.
             

	General tab
	 Report name:
                   Enter a descriptive name for this report - see common report
                   options.

	Stylesheet:
                   Select a style sheet for this report - see common report
                   options.

	To: Select a date
                   to report on or a named date. Transactions up to and
                   including the selected date will be used to calculate the
                   outstanding aged balances. See common report options.

	Report's currency:
                   Select the currency to display the values in - see common
                   report options.

	Price Source:
                   Select the source of price information used for currency
                   conversion if needed. One of
	Average Cost	The
                           volume-weighted average cost of purchases
	Weighted Average (default)	
                           The weighted average of all currency transactions
                           in the past
	Most recent	The most recent
                           recorded price
	Nearest in time	The price
                           recorded nearest in time to the report date



	Show Multi-currency Totals:
                   If not selected, all totals are shown in the report
                   currency.

	Sort By: Sort
                   companies by one of
	Name (default)	Company name
                           
	Total Owed	Total amount owed
                           by company
	Bracket Total Owed	Amount
                           owed in oldest bracket. If same, use next oldest
                           



	Sort Order: One of
                   
	Increasing (default)	 
	Decreasing	 



	Show zero balance items:
                   Show companies even if they have a zero outstanding
                   balance.

	Due or Post Date:
                   Leading date. Which date to use to determine aging. One of
                   
	Due Date (default)	 
	Post Date	 



	Receivables Account:
                   The accounts receivable account used to select customers to be
                   reported. Customers are included if they have a posted
                   business transaction (usually an invoice) on or before the
                   report date and also meet the Show zero balance
                   items criteria.




	Display tab
	Address Source:
                   Which customer address fields to display. One of
	Billing (default)	Address fields from
                           billing address.
	Shipping	Address fields from
                           shipping address.



	Address Name:
                   Display customer address name. This, and other fields, may be
                   useful if copying this report to a spreadsheet for use in a
                   mail merge.

	Address 1: Display
                   address line 1.

	Address 2: Display
                   address line 2.

	Address 3: Display
                   address line 3.

	Address 4: Display
                   address line 4.

	Phone: Display
                   address phone number.

	Fax: Display
                   address fax number.

	Email: Display
                   email address.

	Active: Display
                   vendor active status.








Tax Invoice



 

Resoconto clienti



 


Entrate e Uscite



I resoconti per entrate e uscite includono il flusso di liquidi e i rapporti sulle entrate.
	Flusso di liquidi:

	Stato patrimoniale:

	Istogramma delle uscite:

	Grafico a torta delle uscite:

	Uscite per giorno della settimana:

	Grafico delle entrate e delle uscite:

	Istogramma delle entrate:

	Income Piechart:

	Income Statement: This report summarizes sources of income and expenditure.
         (This report was called Profit & Loss in gnucash-1.8.)

	Entrate per giorno della settimana:

	Profit & Loss: This is the same report as the Income Statement but with a different title.

	Bilancio di previsione: questo resoconto riassume le fonti di reddito e di spesa.




Esempi e personalizzazioni



Resoconto di benvenuto di esempio



 

Resoconto multicolonna personalizzato



This report is used to place multiple reports
           into a single report window to examine a set of financial information at a glance.
        

Sample Report with Examples



 


Bilancio



Budget Balance Sheet



 

Budget Barchart



 

Budget Flow



 

Budget Income Statement



 

Budget Profit & Loss



 

Budget Report



This report is used to compare budgeted and real amounts for selected accounts. It allows you to review how well you follow the budget.
The report is generated as a table in which each row represents an account and each set of columns shows the budgeted amount, the real amount, and the difference between them for each report period.
Each entry in the real amount column is the sum of all the splits in the row's account over the column's period. For example, if the report is set up for monthly periods, the column is for May, and the row is for Expences:Groceries, then the value will be the sum of all Expenses:Groceries splits for that May.
The report supports selecting a range of periods instead all of them. Periods that are out of range can be included in report as the consolidated columns around the selected range. This allows you to focus on particular periods, for example the current one, and is especially useful for budgets with many periods. For example, if you have a 12 period budget you can make a 3 column report with the format "(all periods before columns set) (current period columns set) (all periods after columns set)" that is easily fits on the screen and allows you to match values with account names.
Budget report options

	  
Nota
Here we describe only options that are specific for the Budget Report. You can find information about standard parameters in la sezione chiamata «Configuring Reports and Charts».


	  
	Show budget - include the budgeted values for the period

	Show actual - include the real values for the period

	Show difference - include the difference between budgeted and real values for the period. Enabling this option does not force including budgeted and actual values in report

	Show Column with totals - Adds a final column set containing budgeted, real value, and difference columns summing those values across all periods of the report.

	Rollup budget amounts to parent - not used in report, can be deleted or should be fixed

	Include accounts with zero total balances and budget values - enables display of accounts with no budget or splits in any period.

	Budget - Select the budget to use for report generation

	Report for range of budget periods - Enables reporting on a subset of the budget by selecting a beginning and an ending period.

	Range start - a combobox with a list of variants how to select start period:
	    
	First - select first budget period

	Previous - select previous period.

	Current - select current period.

	Next  - select next period.

	Last - select last budget period

	Manual - enables spinbox where you can select exact period



Nota
The current, previous, and next options select the period based on the date on which the report is run, with current being the period in which the date falls, previous being the one before that, and next the period after. If the current date falls outside the date range covered by the budget, the first or last period will be used as appropriate.


	Exact start period - options for select exact start period, enabled only if range start option is set to Manual

	Range end - a combobox with a list of variants how to select end period. Values are the same as in Range start options

	Exact end period - the same as Exact start period but for the end of range

	Include collapsed periods before selected - if on, then includes in report all budget periods, that are before selected period range, as a single consolidated column set

	Include collapsed periods after selected - if on, then includes in report all budget periods, that are after selected period range, as a single consolidated column set.




	



Printing or Exporting Reports and Charts



Nota
Da verificare!!! Come personalizzare la stampa con Gnome?

GnuCash è in grado di stampare i resoconti e di esportarli nel formato HTML. La finestra di stampa di un documento di GnuCash è accessibile dal pulsante Stampa sulla barra degli strumenti o tramite il menu selezionando la voce File → Stampa. Per esportare un resoconto come pagina internet (HTML), selezionare il pulsante Esporta sulla barra degli strumenti e inserire il nome da assegnare al file.
Most reports, being presented in HTML, can also be copied and pasted into a spreadsheet.
La finestra di stampa di un documento di GnuCash permette di selezionare la stampante alla quale inviare il lavoro di stampa o il file su cui stampare il documento. La finestra fornisce anche un pulsante di Anteprima per controllare il documento prima di inviarlo in stampa. Premendo Stampa il lavoro verrà inviato alla stampante selezionata mentre premendo Annulla la finestra verrà chiusa senza effettuare alcuna stampa.
Stampando dalla finestra del registro, verrà stampato il resoconto dei conti, che è anche chiamato resoconto del registro. In esso sono elencate le transazioni nel conto con un totale. Gli altri resoconti vengono invece stampati come sono visualizzati nella schermata del resoconto.

Creating Reports and Charts



Nota
Questa sezione potrebbe dover essere aggiornata!!!

Se i resoconti forniti da GnuCash non soddisfano le proprie esigenze, è possibile crearne di nuovi. Per farlo è necessario conoscere Scheme (un linguaggio di programmazione simile a LISP) ed è anche consigliato avere accesso al codice sorgente di GnuCash.
L’interfaccia dei resoconti è documentata nel seguente file del codice sorgente src/report/report-system/doc/report-html.txt. Il file src/report/utility-reports/hello-world.scm nella distribuzione sorgente di GnuCash fornisce un buon esempio di come sviluppare un resoconto.
Accessing the GnuCash API



It is also necessary to access data from the engine to get
         information for your report. This is
         since version 2.1.x performed by a set of
         Scheme wrapper functions that are documented in the file
         src/engine/swig-engine.c.
         Up to version 2.0.5 it was
         src/g-wrap/gnc.html. Examine some of the other
         reports in src/scm/report for an indication of how they are used.
Some users started a table in the GnuCash wiki
         
         Custom Reports#The GnuCash API.
       
Because the above file only contains the syntax of the function
		 you can use the Doxygen source documentation either local after running


./configure --enable-doxygen --enable-html-docs
make doc

 on your sources or online
		 http://code.gnucash.org/docs/MAINT/ or
		 http://code.gnucash.org/docs/MASTER/
		 to get more information about the functions.
	   

Report Rendering



Attualmente, i resoconti sono prodotti richiamando una API di generazione HTML, che fornisce una dialettica di HTML e la disegna con un widget HTML. Questa procedura presenta delle limitazioni, in particolare qiuando si tenta di allineare gli oggetti con precisione, come può rendersi necessario per stampare su fatture pre-stampate.


Capitolo 10. Personalizzare GnuCash



Opzioni di visualizzazione del conto



Il comando Filtra per è utilizzato per impostare o modificare la vista della finestra della struttura ad albero dei conti. La scheda dei Conti permette di selezionare la tipologia dei conti che devono essere mostrati. Queste impostazioni influenzano distintamente ogni finestra aperta della struttura dei conti.
La scheda Altro permette invece di abilitare o disabilitare due opzioni: se visualizzare i conti nascosti e se mostrare i conti che hanno un totale nullo.
La finestra della struttura dei conti, mostra di default solamente la quantità di ogni commodity che si possiede, nella colonna del Totale. Spesso, però, può essere utile visualizzare altri valori; per fare questo si può premere il pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso sul lato destro della barra del titolo nella finestra principale dei conti) e selezionare le voci da visualizzare. Queste scelte influenzano tutte le finestre aperte della struttura dei conti.


Impostare le preferenze



The GnuCash Preferences window allows you to customize your GnuCash
    session by setting several options. From the GnuCash menu
    select Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
    The GnuCash Preferences window will open.
    Using the tabs on the left make your desired changes. The settings in
    this dialog are set per user and not stored with the file. This is
    in contrast to the settings described in la sezione chiamata «Book Options»,
    which are kept with, and are part of, the file (or Book), and as such are
    common to all users. So GnuCash Preferences settings are
    individual to each user who uses a given file and any changes made by one
    user will not affect other users of that file. Also, a given user's
    preferences will be common to all files that that user opens with
    GnuCash.
Suggerimento
Fermando il cursore per qualche secondo sopra le opzioni presenti in questa finestra, verranno mostrate delle descrizioni più approfondite sulla voce selezionata.

Nota
The changes you make will be applied at once.

Per chiudere la finestra delle Preferenze di GnuCash, premere il pulsante Chiudi.
Ogni scheda della finestra delle Preferenze di GnuCash ha una sezione dedicata nel seguito. Per un elenco delle schede, consultare Capitolo 10, Personalizzare GnuCash.
Periodo contabile



Figura 10.1. The Preferences window,
          Accounting Period tab
        
[image: La scheda del Periodo contabile]




	Start Date: This item sets the accounting period’s start date.
	Relative: Use the specified relative starting date for profit/loss
                calculations.  Also use this date for net assets calculations.  Relative defines
                start by today or start of current/previous year, quarter, month.

	Absolute: Use the specified absolute starting date for profit/loss
                calculations.  Also use this date for net assets calculations.




	End Date: This item sets the accounting period’s end date.
	Relative: Use the specified relative ending date for profit/loss
                calculations.  Also use this date for net assets calculations.

	Absolute: Use the specified absolute ending date for profit/loss
                calculations.  Also use this date for net assets calculations.




	Contenuto della barra di riepilogo
	Include grand total: If checked, show in the Summarybar a grand total of all
              accounts converted to the default currency.

	Include non-currency totals: if this
              option is selected, GnuCash will include in the Summarybar a total
              for non-currency items (for instance number of shares).







Conti



Figura 10.2. The Preferences window, 
          Accounts tab
        
[image: La scheda Conti]




	Separator Character: The account
          separator is the character that separates a parent account from its
          sub-account, for example Utilities:Electric. The default is a
          : (Colon), but you can also select
          / (Slash),
          \ (Backslash), - (Dash)
          or . (Period), or any Unicode character
          that isn’t a letter or a number.

	Reverse Balanced accounts: This option
          lets you determine whether account balances will display as positive
          or negative numbers:
	Entrate e uscite assegna un saldo a credito positivo ai conti delle entrate a un saldo a debito negativo ai conti delle uscite. Consultare la sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.

	Conti crediti (predefinita) visualizza un saldo positivo per i conti che normalmente hanno un saldo in credito (entrate, crediti, passività, capitali). Consultare la sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.

	Nessuno mostra tutti i saldi a credito come negativi e tutti i saldi a debito come positivi.




	Labels: Select this option if you want
          column headings in the register to refer to debits and
          credits instead of the default informal headings such
          as withdrawal
          and deposit.

	Default Currency: This item determines
          which currency will be selected by default when creating new
          accounts.
	Locale: Use the system locale currency for
              all newly created accounts.

	Choose: specify the
              currency to use, independent of your system
              settings.




	Account Color: This option
          lets you manage the display of the account color set in the
          Edit Account window:
	Show the Account Colors as background: show the
                accounts color as account name background in the Accounts Page.

	Show the Account Colors on tabs: show the accounts
                color as background in the account register tabs.







Impresa



Figura 10.3. The Preferences window, 
          Business tab
[image: La scheda Impresa]




	Generali
	Enable extra buttons: If checked,
              extra toolbar buttons for common business functions are shown.

	Open in new window: If checked, each
              invoice will be opened in its own top level window. If clear, the
              invoice will be opened in the current window.

	Accumulate splits on post: Whether
              multiple entries in an invoice which transfer to the same account
              should be accumulated into a single split by default.




	Fatture
	Report for printing: Allows to select
              the invoice report to be used for printing.

	Tax Included: Whether tax are
              included by default in entries on invoices. This setting is
              inherited by new customers and vendors.

	Auto pay on posting: If enabled, at post
              time automatically attempt to pay customer documents with outstanding
              pre-payments and counter documents.
Nota
Counter documents are documents with
                opposite sign. For example for an invoice, customer credit notes and negative
                invoices are considered counter documents.
The pre-payments and documents obviously
                have to be against the same customer.





	Ricevute
	Notify when due: Lets you set whether
              you want to be notified at GnuCash startup
              of when a bill is soon to be due.

	Days in advance: How many days before
              the due date to warn about bills coming due.

	Tax Included: Whether tax are
              included by default in entries on bills. This setting is inherited
              by new customers and vendors.

	Auto pay on posting: If enabled, at post
              time automatically attempt to pay vendor documents with outstanding
              pre-payments and counter documents.
Nota
Counter documents are documents with
                opposite sign. For example for a bill, vendor credit notes and negative
                bills are considered counter documents.
The pre-payments and documents obviously
                have to be against the same vendor.








Data e ora



Figura 10.4. The Preferences window, 
          Date/Time tab
[image: La scheda Data e ora]




	Formato della data
	Use 24-hour clock: Lets you specify if you
              want to use 24 or 12 hours time format. That is if 11 o’clock at
              night should be represented as 11PM or 23:00.




	Date Format: This option controls the
          appearance of the date (you could see a preview of the date beside any of the choices).
          The available choices are:
	US: Use the date format common in the United States.

	UK: Use the date format common in the United Kingdom.

	Europe: Use the date format common in continental Europe.

	ISO: Use the date format specified by the ISO-8601 standard.

	Locale: Use the date format specified by the system locale.




	Date completion: This option
          lets you manage the case when a date is entered without a year:
            
	In the current calendar year: (Default) Dates will be completed so that
                they are within the current calendar year.

	In a sliding 12-month window starting a configurable number of months before
                the current month: Dates will be completed so that they are close to the current
                date. You can enter the maximum number of months to go backwards in time when completing dates.




          




Generali



Figura 10.5. The Preferences window, 
          General tab
        
[image: La scheda Generali]




	Generali
	Display "Tip of the Day" dialog: This option displays or hides the
              Tip of the Day screen when GnuCash is started.

	Show splash screen: With this option you
              can enable or disable the visualization of the startup screen while
              GnuCash is starting up.

	Perform account list setup on new file:
              This option turns off the display of the New Account
              Hierarchy Setup assistant when the entry File → New File is selected from the
              GnuCash menu.

	Set book option on new files to use split "action"
              field for "Num" field on registers/reports:
              If selected, the displayed setting on the New Book
              Options dialog for the Use Split Action Field
              for Number setting will be selected and, if saved, the
              book option for the new file will be set so that
              the "Num" field on registers shows/updates the split-action field
              and the transaction-num field is shown on the second line in
              double line mode (and is not visible in single line mode).
              Otherwise, the displayed setting on the dialog will not be
              selected and, if saved, the book option for the new file will be
              set so that the "Num" field on registers shows/updates the
              transaction-num field. See the discussion in la sezione chiamata «Book Options» about how to set book options including
              the option for la sezione chiamata «Use Split Action Field for Number».
              Regardless of the setting of this preference, the
              user can modify the initially displayed setting for this option on
              the New Book Options dialog before saving the
              options.



Nota
If the New Book Options dialog appears
              in situations where a new book is being set up, the settings from
              this preference will determine the default setting for the
              corresponding check box on the dialog. However, the
              OK button on the New Book
              Options dialog must be pressed for the setting to be
              made for the new book; otherwise it will default to not
              selected.


	Numeri
	Display negative amounts in red: If you
                turn off this option, GnuCash will display negative numbers in
                black.

	Automatic Decimal Point: This option
                will automatically insert a decimal point into numbers you type
                in.

	Decimal Places: This field allows you
                to set the number of decimal places to be used.




	File
Nota
Le opzioni seguenti sono rilevanti solamente per i file salvati in formato XML.

	Compress files: This option determines
              whether the GnuCash data file will be compressed or not.

	Show auto-save confirmation question:
              If this option is enabled, GnuCash will show you a confirmation screen
              each time the auto-save process is started.

	Auto-save time interval:
              This field sets the number of minutes between each automatic saving of the file.
              Set to 0 to disable the auto-save feature.

	Enable timout on "Save changes on closing" question:
              If enabled, the Save changes on closing question will only wait a
              limited number of seconds for an answer. If the user didn’t answer within that time,
              the changes will be saved automatically and the question window closed.
              You can sete the number of seconds in the Time to wait for answer field.

	Retain log files: In this section you could set
              your preferences about the log files using the provided radio buttons.
	Never: Disable the creation of log files.

	For: Enter a specific number of days for which keep the files.

	Forever: Disable the auto deletion of log files; retains the log files forever.







	Finestra di ricerca
	New search limit: Defaults to "new
              search" if fewer than this number of items is returned.







Online Banking



Figura 10.6. The Preferences window, 
          Online Banking tab
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	Importazione file QIF
	Show documentation: The first time you
              use the QIF importer you may
              notice that the importer has detailed instructions on how to import
              a file. Once you have become familiar with using the importer, you
              might want to turn off this option. Turning off the option gives you
              less detail in the importer screens.

	Default transaction status (overridden by the status given by the QIF file):
              In this section you could set the default status for imported transactions using the provided
              self-explainingradio buttons:
	Not cleared (Default)

	Liquidata

	Riconciliata







	Importatore generico
	Enable skip transaction action: Enable the SKIP
              action in the transaction matcher. If enabled, a transaction whose best match’s score
              is in the yellow zone (above the Auto-ADD threshold but below the Auto-CLEAR threshold)
              will be skipped by default.

	Enable update match action: Enable the UPDATE AND RECONCILE
              action in the transaction matcher. If enabled, a transaction whose best match’s score is
              above the Auto-CLEAR threshold and has a different date or amount than the matching existing
              transaction will cause the existing transaction to be updated and cleared by default.

	Use Bayesian matching: Use Bayesian
               algorithms to match new transactions with existing accounts.

	Match display threshold: The minimal
              score a potential match must have to be displayed in the match
              list.

	Auto-add threshold: A transaction whose
              best match’s score is in the red zone (above display threshold, but
              below or equal to Auto-add threshold) will be added by
              default.

	Auto-clear threshold: A transaction
              whose best match’s score is in the green zone (above or equal to
              Auto-clear threshold) will be cleared by default.

	Commercial ATM fees threshold:
              In some places commercial ATMs (not
              belonging to a financial institution) are installed in places like convenience
              store.  These ATM add its fee directly to the amount instead of showing up as a
              separate transaction or in your monthly banking fees.  For example, you withdraw
              $100, and you are charged $101.50 plus Interac fees.  If you manually entered
              that $100, the amounts won’t match.  You should set this to whatever is the
              maximum such fee in your area (in units of your local currency), so the
              transaction will be recognized as a match by
              GnuCash.

	Automatically create new commodities: Enables the
              automatic creation of new commodities if any unknown commodity is encountered during
              import. If not enabled, the user will be asked what to do with each unknown commodity.




	Online Banking
Nota
This section is shown only if GnuCash is compiled with
          Aqbanking and HBCI support.

	Close log window when finished: Close the log window
              when the operation is completed.

	Remember PIN: Enable this option if you
              want GnuCash to remember the PIN you
              enter for online banking authentication.

	Verbose debug messages: Enable this option if you
              want GnuCash to show more information about the online
              banking operations.







Stampa



Figura 10.7. The Preferences window, 
          Printing tab
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La scheda Stampa permette di configurare alcune opzioni che governano la stampasu carta degli assegni.
	Print date format: Enable this option
          if you want to print on the check, below the actual date, its format in 8 point type.
          

	Print blocking chars: Enable this option to print
          a series of three asterisks before and after each text field in the check.

	Default font: Click the button on the left to open
          a Pick a Font screen in which you can customize the font
          that will be used to print checks.




Registro



Figura 10.8. The Preferences window, 
          Register tab
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	Operazioni
	'Enter' moves to blank transaction: If
              selected, move the cursor to the blank transaction at the end of the register
              after the user presses the Enter key. Otherwise the cursor will be moved
              down one row.

	Auto-raise lists: If selected, all lists
              will automatically be expanded when input focus is in the list
              field.

	Tab order includes Transfer on Memorised Transaction:
              If selected, when the transaction is auto filled, pressing the
              Tab key in the register the cursor’s jump
              will include the Transfer field.




	Riconciliazione
	Check cleared transactions: If selected,
              automatically check off cleared transactions when
              reconciling.

	Automatic interest transfer: If
              selected, prior to reconciling an account which charges or pays
              interest, prompt the user to enter a transaction for the interest
              charge or payment. Currently only enabled for Bank, Credit, Mutual,
              Asset, Receivable, Payable, and Liability accounts.

	Automatic credit card payment: If
              selected, after reconciling a credit card statement, prompt the user
              to enter a credit card payment.

	Always reconcile to today: If
              selected, always open the reconcile screen with today’s date for
              statement date, regardless of previous reconciliation.




	Grafica
	Use system theme colors: If selected,
              the system color theme will be applied to register windows. Otherwise
              the original GnuCash register color will be used.

	Double mode colors alternate with
              transactions: If selected, configures the register
              window to alternate between the primary and secondary colors with
              each transaction, instead of each row.

	Draw horizontal lines between rows: If
              selected, GnuCash will draw a horizontal line between each
              row.

	Draw vertical lines between columns: If
              selected, GnuCash will draw a vertical line between the cells in
              each row.







Predefinite del registro



Figura 10.9. The Preferences window, 
          Register Defaults tab
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La scheda delle preferenze Predefinite del registro influenza il comportamento delle finestre del registro delle transazioni.
	Stile predefinito
Qui è possibile scegliere tra 3 diversi stili per la finestra del registro: 
	Basic ledger: Show all transactions on one line. (Two in double line
               mode.)

	Auto-split ledger: Automatically expand the current transaction to show
               all splits.  All other transactions are shown on one line. (Two in double line
               mode.)

	Transaction journal: All transactions are expanded to show all splits.
              




	Altre predefinite
	Register opens in a new window: If
              selected, register will be in a separate window instead of in a
              tab.

	Double line mode: If selected, show two
              lines of information for each transaction instead of one.

	Only display leaf account names: If selected, only the name of the leaf
              accounts will be displayed in the Account selection popup.
              The default behavoir is to display the full account name including the path in the account tree.
Avvertimento
Abilitare questa opzione presuppone che vengano utilizzati dei nomi unici per i conti figli.


	Number of transactions: How many
              transactions to show in a register. Set to 0 to show all transactions.







Resoconti



Figura 10.10. The Preferences window, 
          Reports tab
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La scheda delle preferenze Resoconti influisce sul comportamento dei resoconti di GnuCash.
	Default Report Currency: This item
          determines which currency will be used by default when creating
          reports. You can choose:
	Locale: Use the system locale currency for all
             newly created reports.

	Choose: Use the specified currency for all
             newly created reports.




	Posizione
	Report opens in a new window: if you select this option, the
               reports will open up in a new window, instead of in a tab.







Transazioni pianificate



Figura 10.11. The Preferences window, 
          Scheduled Transactions tab
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La scheda delle preferenze Transazioni pianificate governa il comportamento delle transazioni pianificate in GnuCash. Maggiori informazioni relative alle transazioni pianificate sono reperibili in la sezione chiamata «Pianificare le transazioni».
	Assistente dall’ultimo avvio
	Run when data file opened: If selected,
              the Since Last Run screen will appear on GnuCash start-up (or
              rather when GnuCash opens the file).
              




	Predefinite dell’editor transazioni
	Auto-Create new transactions: If
              selected, new scheduled transactions will automatically be entered
              into the register. If the auto-create option is enabled, you could also check
              Notify before transactions are created so that you will be
              able to confirm creating the transactions.

	Create in advance: The default
              number of days in advance to create the registered scheduled
              transactions.

	Remind in advance: The default
              number of days in advance to remind on new scheduled
              transactions.







Finestre



Figura 10.12. The Preferences window, 
          Windows tab
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	Geometria finestra
	Save window size and position: If
              selected, next time GnuCash starts will re-use the windows size
              and position configured in the last run.




	Schede
	Show close button on notebook tabs: Adds
              a small close icon on each tab, to make it easier to close the
              various tabs.

	Bring the most recent tab to the front: If
              selected, the newly created tab will be shown over the other tabs.

	Width: The width of tab label
              expressed in characters.
              
Nota
If the text in the tab is longer than this value
                (the test is approximate) then the tab label will have the middle cut
                and replaced with an ellipsis.
                


              




	Posizione delle schede
Posiziona le schede in Alto (predefinita), in Basso, a Sinistra o a Destra.

	Posizione della barra di riepilogo
Posiziona la barra di riepilogo In alto o In basso (predefinita) nella finestra principale di GnuCash.





Book Options



The File → Properties
       menu item is used to set or modify choices that affect how a specific
       GnuCash file (also referred to as a Book)
       operates. Selecting this menu item brings up the Book Options
        dialog. This dialog also appears in situations where you are
       importing transactions into a new book, with the title New Book
       Options. It is automatically raised in these 'new book'
       situations because these settings can affect how imported data
       are converted to GnuCash transactions and so
       should be considered and set before your first import (specifically, the
       la sezione chiamata «Use Split Action Field for Number» setting).
      
The settings in this dialog are kept with, and are part of, the file
       (or Book). This is in contrast to the settings described in
       la sezione chiamata «Impostare le preferenze», which are set per user and not stored with
       the file. So Book Options settings are shared
       by all users who use a given file and any changes made by one
       user will affect all users of that file.
      
Suggerimento
Pausing the cursor for a couple of seconds over options in these
         tabs will display a tooltip with a more detailed description of the
         choice.
        

The Book Options dialog has five buttons that
        are common to all tabs. The Reset defaults button
        takes all items on the visible tab and sets their value to the default
        setting; it only affects the visible tab. The Help
        button opens up a help window to this section. The Cancel
        button closes the dialog, making no changes to the saved settings for
        Book Options. The Apply
        button is initially insensitive but becomes sensitive when any setting
        is set or changed. Selecting it saves the setting(s) for the book but
        keeps the Book Options dialog open. Typically, the
        changes are reflected in the affected areas of GnuCash
        as soon as the button is pressed, so it can be used to 'see' the effect
        of a given option without having to re-open the dialog. The
        Apply button is not sensitive on the dialog if
        it appears during transaction import (that is, 'new book') situations.
        The OK button behaves like the
        Apply button except that it immediately
        closes the dialog, as well.
      
Accounts Book Options Tab



The Accounts tab of this dialog allows
          the selection of options that affect how accounting registers function.
        
Use Trading Accounts



Check the Use Trading Accounts checkbox to
            have trading accounts used for transactions involving more than one
            currency or commodity.
          

Day Threshold for Read-Only Transactions



Use the Day Threshold for Read-Only
            Transactions spin-box to choose the number of days before
            today, prior to which, transactions will be read-only and cannot be
            edited anymore in the registers. This threshold is marked by a red
            line in the account register windows. If zero, all transactions can
            be edited and none are read-only. This feature is intended to be
            used to guard against accidental changes to non-current transactions.
          

Use Split Action Field for Number



Nota
This option is only available in GnuCash
              version 2.6 or later.

Check the Use Split Action Field for Number
            checkbox to have the split action field of the anchor split used for
            the 'Num' column in registers, reports and import/export functions,
            where applicable, in place of the transaction number; the
            transaction number is then shown as 'T-Num' on reports and on the
            second line of registers. This choice has a corresponding effect on
            business features.
          
The difference between the two is that with the checkbox not
            selected, the same 'Num' is displayed for a given transaction
            regardless of what register it is viewed in and with the checkbox
            selected, a different 'Num' can be entered/displayed for a given
            transaction in each register it is viewed in. In both cases, the
            'next number logic' of the 'Num' cell is based on the account of the
            register the transaction is entered to or viewed from but in one
            case it fills the transaction number, in the other, it fills the
            split action field of the anchor split. In both cases, both fields
            are visible and can be viewed and used as free-form text in
            double-line mode for any value the user wants.
          
Avvertimento
Initial setup of GnuCash: It is
             expected that, after careful consideration of the consequences,
             this option will be set when a new GnuCash
             file is created and not changed thereafter (see next warning). For
             this reason, a preference is provided (see Setting Preferences - General ) that
             can establish an initial default setting for new files, so that if
             you will have more than one file, it is easier to set them all up
             consistently. You may wish to set up a test file and experiment
             with the two settings to understand the differences before
             establishing your first real GnuCash file.
            

Suggerimento
Moving from Quicken: For users that are switching from other
             personal accounting applications, such as Quicken, selecting this
             option may be more consistent with the numbering approach used
             there and can preserve the numbering of historical data brought
             over; this option should be set before performing the initial
             import.
            

Avvertimento
Changing this option for an existing GnuCash
              file: If you change this option for an existing
             file, historical data will not be changed. This means that if you
             set the option one way, enter (or import) transactions, then change
             the option and enter (or import) additional transactions and switch
             back-and-forth, you will end up with a file that will appear to
             have inconsistent treatment of numbers in registers, reports and
             exports. This is because the setting of this option at the time of
             data entry/import determines where the number data is stored and
             the setting at the time of data display/reporting/exporting
             determines which field is displayed as number.
            
There is no reason to avoid changing this option for an
             existing GnuCash file if you understand
             the implications. If you elect to make this change, it should
             probably be done between accounting periods with the understanding
             that number data prior to the date the option is changed will be
             displayed/reported/exported differently from that after the date.
            

Avvertimento
If you change this option, and press Apply
              or OK, open registers and
             labels on query and sorting dialogs will be refreshed to reflect
             the new option immediately. But open reports need to be
             individually reloaded by the user to have the change reflected on
             the report.
            

Avvertimento
This option is only available in GnuCash
              version 2.6 or later. If a GnuCash
              file from an earlier version is opened in version
             2.6 or later, and this feature is not used, this feature will not
             prevent the file from being opened in the earlier version of
             GnuCash. However, if the option is set,
             the file will not be able to be opened by the earlier version, even
             if the option is set back to its original setting. A warning dialog
             will be displayed from the earlier version. Do not set this option
             if you want to open the file with an earlier version.
            



Budgeting Book Options Tab



The Budgeting tab allows you to specify the
         budget to be used for reports when none has otherwise been specified.

Business Book Options Tab



The Business tab allows you to enter values
        that are in turn used by the business features of GnuCash:
	Company Name
	The name of the company.

	Company Contact Person
	The name of the contact person to print on invoices.

	Company Phone, Fax, Email Address
	The references of your business.

	Company Website URL
	The internet address of the company’s website.

	Company ID
	The tax ID of your company.

	Default Customer TaxTable
	The default taxtable applicable to your most common customers.

	Default Vendor TaxTable
	The default taxtable applicable to your most common vendors.

	Fancy Date Format
	The default date format used for fancy printed dates
          (e.g. on invoices).

	Reset Defaults
	Press the button to reset all values to their defaults.



Nota
None of the above values is required to use GnuCash
          but, if given, will be used throughout the program. (f.e. in reports, invoices etc...)


Counters Book Options Tab



The Counters tab allows you to set the
         'previous' value for each number indicated: Bill, Customer, Employee,
         etc. These counters are used by the Capitolo 7, Business Features of
         GnuCash.
The number entered here will be incremented when the various
         business features calculate a value for a corresponding field on a
         dialog. For example, if you leave the Customer Number field blank on
         the New Customer dialog, the customer will be assigned the number in
         the counter field plus 1. The numbers displayed in the tab are
         incremented as these business features are used. (But note that if you
         have the Book Options dialog open, you need to
         close it and re-open it to see the changes; the displayed field values
         are not automatically refreshed.)
The corresponding format fields are
         used to specify printf-style format strings that are used to format the
         printing of the number. For example, to put the literal "C - " in front
         of the customer number, you would put "C - %li" (without the quotes) in
         the customer format string field.
         If the value in the customer number field was 5, the next customer added
         would be assigned the number "C - 6". As another example, if you wanted
         the number to be printed with leading zeros and 5 characters wide, you
         would enter "C - %05li" and the next customer number would be assigned
         the number "C - 00006".
Nota
For historical reasons GnuCash accepts multiple format specifiers
        although they all yield the same end result. You can choose "li", "lli" or I64i".



Modificare i fogli di stile



GnuCash fornisce quattro tipi predefiniti di fogli di stile per le pagine web dei resoconti. Questi fogli di stile possono essere modificati utilizzando l’editor HTML. Per accedervi, selezionare Modifica → Fogli di stile....
Utilizzando l’editor dei fogli di stile è possibile visualizzare e modificare le impostazioni di un foglio di stile.
Nota
Cambiando il foglio di stile, verrà modificato l’aspetto di tutti i resoconti a cui il foglio di stile è associato. È necessario eseguire il comando Aggiorna per visualizzare i cambiamenti, se il o i resoconti sono visualizzati al momento della modifica.

Per aggiungere un nuovo foglio di stile, selezionare il pulsante Nuovo... nel riquadro del foglio di stile; verrà visualizzata la finestra per il Nuovo foglio di stile. Immettere il Nome e selezionare un modello. Per rimuovere un foglio di stile, selezionarlo dalla lista e premere Elimina.
Foglio di stile predefinito



Il foglio di stile Predefinito presenta quattro schede per modificarne l’aspetto nei resoconti che lo utilizzano: Colori, Caratteri, Generali e Tabelle.
Scheda Colori



	Colore alternativo delle celle: il colore da alternare sulle righe della tabella.




Scheda Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Scheda Generali



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Immagine di sfondo: usare il pulsante Sfoglia per selezionare un’immagine da utilizzare come sfondo nei resoconti.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Scheda Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Foglio di stile Semplice



Il foglio di stile Semplice presenta quattro schede per modificare l’aspetto dei resoconti: colori, generali, immagini e tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Fogli di stile Piè di pagina



Il foglio di stile Piè di pagina presenta le stesse cinque schede dello stile Easy per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

	Piè di pagina: il testo da inserire a piè pagina del resocoto.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.





Foglio di stile Technicolor



Il foglio di stile Technicolor fornisce cinque schede per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.
Colori



	Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.

	Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.

	Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.




Stili



	Titolo: selezionare il carattere e la dimensione per i titoli.

	Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

	Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.

	Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.

	Intestazione: selezionare il carattere e la dimensione per l’intestazione.

	Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.

	Cella del totale: selezionare il carattere e la dimensione per le celle del totale.

	Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.

	Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.




Generali



	Redattore: Nome della persona che ha preparato il resoconto.

	Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.

	Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.

	Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.




Immagini



	Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

	Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.

	Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.




Tabelle



	Spaziatura tra le celle: permette di specificare lo spazio tra le celle

	Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.

	Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.






Impostare le opzioni per i resoconti delle tasse



The Income Tax Information dialog is used to set Tax Report Options.
       The settings on accounts in this dialog are used by the TXF Export function
       in reports to select the accounts for export. To access this dialog go to
       Edit → Tax Report Options.
If the Income Tax features are used, it is strongly recommended that
       the Tax Info column be made visible on the accounts tab (click large
       downward-pointing arrow and select Tax Info check box). The Tax Info
       column will display the Form/Schedule and tax category (e.g., Schedule D
       Dividend, cap gain distrib.) assigned to an account, if any. Alternatively,
       it will display the following error messages which can be corrected through
       Edit → Tax Report Options
	Relativo alle tasse ma non ha un codice

	Entità e tipo dell’imposta non specificati

	Tax type "tax_type": invalid code "code" for account type"

	Not tax-related; tax type "tax_type": invalid code "code" for
           account type

	Codice imposta "codice" non valido per il tipo di imposta "tipo_imposta"

	Not tax-related; invalid code "code" for tax type "tax_type"

	No form: code "code", tax type "tax_type"

	Not tax-related; no form: code "code", tax type "tax_type"

	No description: form "form", code "code", tax type "tax_type"

	Not tax-related; no description: form "form", code "code", tax
           type "tax_type"

	Not tax-related; "form"("copy") "desc" (code "code", tax type
           "tax_type")



The Income Tax Identity must be set in order to assign codes to
       individual accounts. Click Edit to set the identity. The Tax Name is
       optional. If entered, it will be printed at the top of the report. A
       Type must be selected in order to activate the tax category
       selections. The choices are:
	Individual, Joint, etc. - Files US Form 1040 Tax Return 

	Partnership - Files US Form 1065 Tax Return

	Corporation - Files US Form 1120 Tax Return

	S Corporation - Files US Form 1120S Tax Return

	None - No Income Tax Options Provided



While the Income Tax Entity Type can be changed after tax categories
       have been assigned to accounts, you should be cautioned that you will need
       to manually change each one if you do so, which could be quite tedious.
       The tax categories are unique for each Income Tax Entity Type, so changing
       the type will make all previously assigned categories invalid. It is assumed
       (and highly recommended) that each GnuCash file is for only one tax entity
       and this is where you specify its type of tax entity. You should not keep,
       for example, personal and partnership accounts mixed in one GnuCash file
       if you plan to use the Income Tax Reporting features.
A given TXF code can be assigned to multiple accounts. The Tax Schedule
       Report will combine accounts by code and generate a detailed TXF record for
       each account and a summary TXF record for the total as calculated by the
       report.
For codes for which the "Payer Name Source" is not grayed, the payer
       on the TXF record will be based on what is specified here, either the
       account name of the account or the account name of the account’s parent
       account. This feature is typically used for interest accounts or stocks or
       mutual funds that pay dividends where the individual payees are shown on
       the tax schedule. For example, if the parent account’s name is the name of
       your broker and the sub-account’s names are the names of individual stocks
       that pay dividends and the name on the 1099-DIV received is that of the
       broker, in order to match that name, you would select ’Parent Account’;
       the total dividends from the broker would be exported and, if you had
       several brokers, there would be an amount exported and a subtotal for each
       broker, along with each brokers name. Alternatively, if you had a parent
       account named Directly Held, for example, and below it sub-accounts for
       one or more stocks, you would receive a 1099-DIV from the issuer of each
       stock separately and, in order to match that name, you would select
       Current Account; the total dividends from each stock would be exported
       and, if you had several stocks, there would be an amount exported and a
       subtotal for each stock, along with each stock’s name as the payer.
Some tax Forms/Schedules need to have multiple copies filed under
       some circumstances (for example, Schedule C if a taxpayer and spouse have
       separate businesses). For tax categories on these Forms/Schedules, the
       Copy Number is not grayed out and can be used to segregate accounts by
       copy number.
	Accounts: This pane contains the list of accounts. Select an
           account to set a TXF category. If no account is selected nothing is
           changed. If multiple accounts are selected, all of the accounts will
           be set to the selected item. 

	Tax Related: Select this check-box to add tax information to an
           account then select the TXF Category below. This setting is displayed
           on the account edit dialogue but cannot be changed from there.

	TXF Categories: Select the desired one. A detailed description
           appears just below (if available, otherwise it says No help
           available), along with the TXF code for the category and information
           about what line number on the form or schedule the amounts are
           included in by tax year (used for detailed sort on report).

	Payer Name Source: Select an option to determine where the text
           description that is exported along with the value of the account is
           derived from, as described above. This is usually the name of a bank,
           stock, or mutual fund that pays dividends or interest. Occasionally,
           it is a description of a deduction.

	Copy Number: A copy number that is exported along with the value
           of the account. This is used to segregate amounts between different
           copies of the same Form/Schedule that may need to be filed (e.g.,
           Schedule C(1), Schedule C(2), etc.). This is also used to sort the
           report.



TXF Export - Known Anomalies and Limitations



TaxCut 1999 
	Code: N488 "^ Sched B \ Div. income, cap gain distrib."

	Code: N286 "^ Sched B \ Dividend income"



These two codes, from the same payer, are not correlated. The user will have to
         adjust for this after import. 
TaxCut 1999, 2000 
	Code: N521 " F1040 \ Federal estimated tax, quarterly"



Does not accept the date field and does not import the individual
         payment amounts, only the total. The date and individual payment amounts,
         only matter if you have to compute the penalty. (this may be a TurboTax
         enhancement) 
	Code: N460 " W-2 \ Salary or wages, self"

	Code: N506 " W-2 \ Salary or wages, spouse" 

	and other related codes.



Use Copy Number to separate information from more than one job. 
TurboTax 1999, 2000 
	Code: N521 " F1040 \ Federal estimated tax, quarterly"



Does not accept the dates outside of the tax year. This is a problem
         for the last payment that is due Jan 15. GnuCash changes the the date of
         the last payment to Dec 31 for the export unless the "Do not use special
         date processing" option is selected in the report options display tab.
         The user will have to adjust for this after import. The date only
         matters if you have to compute the penalty. 
TXF Tax eXport Format 
	Duplicate Codes



Codes can be assigned to multiple accounts and the amounts will be
         summed for all the accounts generating one detail TXF record per account
         and one summary TXF record for the sum. Codes that let you select "Payer
         Name Source" will generate a separate summary TXF account with each
         change in payer. Selecting the "Print TXF export parameters" option will
         cause the report to show to which codes this applies (Payer Name Source
         option Y) and, for the accounts assigned to those codes, the Name Source
         each account is set to and the TXF item number that will be assigned to
         each. A summary TXF record will be generated for each change in assigned
         item line number. These may not be handled the same by TaxCut and
         TurboTax.
	Code: N673 "Short/Long gain or loss"



Short term or long term gain or loss from the sale of a security;
         generates TXF output for only the date sold and sales amount, with the
         date acquired and cost basis information left blank (to be separately
         added in the tax software). The code can be assigned to either a short-,
         long-, or mixed-term gain/loss income account and the security sales
         transaction should be entered as illustrated in Section 8.7, Selling
         Shares, of the GnuCash Tutorial and Concepts Guide. The report uses the
         transaction split of the gain/loss account to find one or more other
         splits in the same transaction with negative share quantities. For each
         of these found, it generates a detailed TXF output record with the
         quantity sold, the name of the security, the date sold, and the sales
         amount. Note that if, for a given transaction, more than one transaction
         split is to a gain/loss income account assigned to code 673, TXF output
         data will be erroneously repeated. That is because the report will
         fetch the same data, and re-output it, for each transaction split set
         to a gain/loss income account within the same transaction. For this
         reason, there should be no more than one gain/loss account entered per
         transaction to use this tax reporting code properly. (Note that
         no amounts are used from GnuCash’s lot-tracking; a future enhancement
         is expected to use this data to provide capital gain reporting).

Detailed TXF Category Descriptions



Table 32. Detailed TXF Category Descriptions



Tabella 10.1. Detailed TXF Category Descriptions
	Tax Form \ TXF Code
Descrizione
	Messaggi TXF di aiuto estesi
	< help \ H001
Name of Current account is exported.
	Categories marked with a «<» or a «^», require a Payer identification to be exported.  «<» indicates that the name of this account is exported as this Payer ID.  Typically, this is a bank, stock, or mutual fund name.
	^ help \ H002
Name of Parent account is exported.
	Categories marked with a «<» or a «^», require a Payer identification to be exported.  «^» indicates that the name of the PARENT of this account is exported as this Payer ID.  Typically, this is a bank, stock, or mutual fund name.
	# help \ H003
Non ancora implementato, NON usare!
	Categories marked with a «#» not fully implemented yet!  Do not use these codes!
	  none \ N000
Tax Report Only - No TXF Export
	This is a dummy category and only shows up on the tax report, but is not exported.
	Help F1040 \ H256
Form 1040 - the main tax form
	Form 1040 is the main form of your tax return.
	  F1040 \ N261
Alimony received
	Amounts received as alimony or separate maintenance.  Note: child support is not considered alimony.
	  F1040 \ N257
Other income, misc.
	Miscellaneous income such as: a hobby or a farm you operate mostly for recreation and pleasure, jury duty pay. Exclude self employment income, gambling winnings, prizes and awards.
	  F1040 \ N258
Sick pay or disability pay
	Amounts you receive from your employer while you are sick or injured are part of your salary or wages. Exclude workers’ compensation, accident or health insurance policy benefits, if you paid the premiums.
	  F1040 \ N260
State and local tax refunds
	Refund of state or local income tax refund (or credit or offset) which you deducted or took a credit for in an earlier year. You should receive a statement, Form 1099-G. Not reportable if you didn’t itemize last year.
	  F1040 \ N262
IRA contribution, self
	Contribution to a qualified IRA.  If you or your spouse are covered by a company retirement plan, this amount could be limited or eliminated.
	  F1040 \ N263
Keogh deduction, self
	Contributions to a Keogh or HR 10 plan of a sole proprietor or a partnership.
	  F1040 \ N264
Alimony paid
	Amounts payed as alimony or separate maintenance.  Note: child support is not considered alimony.
	< F1040 \ N265
Early withdrawal penalty
	Penalty on Early Withdrawal of Savings from CD’s or similar instruments. This is reported on Form 1099-INT or Form 1099-OID.
	  F1040 \ N266
Social Security income, self
	The part of any monthly benefit under title II of the Social Security Act. These will be reported on Form SSA-1099.
	  F1040 \ N269
Taxable fringe benefits
	Fringe benefits you receive in connection with the performance of your services are included in your gross income as compensation. Examples: Accident or Health Plan, Educational Assistance, Group-Term Life Insurance, Transportation (company car).
	  F1040 \ N481
IRA contribution, spouse
	Contribution of a working spouse to a qualified IRA. If you or your spouse are covered by a company retirement plan, the deductible contribution could be limited or eliminated.
	  F1040 \ N482
IRA contrib., non-work spouse
	IRA contribution for a non-working spouse.
	  F1040 \ N483
Social Security inc., spouse
	Spouse’s part of any monthly benefit under title II of the Social Security Act. These will be reported on Form SSA-1099.
	  F1040 \ N516
Keogh deduction, spouse
	Spouse Contributions to a Keogh or HR 10 plan of a sole proprietor or a partnership.
	  F1040 \ N517
SEP-IRA deduction, self
	Contributions made to a simplified employee pension plan (SEP-IRA).
	  F1040 \ N518
SEP-IRA deduction, spouse
	Spouse contributions made to a simplified employee pension plan (SEP-IRA).
	  F1040 \ N519
RR retirement income, self
	The part of tier I railroad retirement benefits, which are treated as a social security benefits. These will be reported on Form RRB-1099.
	  F1040 \ N520
RR retirement inc., spouse
	Spouse’s part of tier I railroad retirement benefits, which are treated as a social security benefits. These will be reported on Form RRB-1099.
	  F1040 \ N521
Federal estimated tax, quarterly
	The quarterly payments you made on your estimated Federal income tax (Form 1040-ES). Include any overpay from your previous year return that you applied to your estimated tax. NOTE: If a full year (Jan 1, YEAR to Dec 31, YEAR) is specified, GnuCash adjusts the date to Mar 1, YEAR to Feb 28, YEAR+1. Thus, the payment due Jan 15 is exported for the correct year.
	  F1040 \ N607
Medical savings contribution, self
	Contributions made to your medical savings account that were not reported on your Form W-2.
	  F1040 \ N608
Medical savings contribution, spouse
	Contributions made to your spouse’s medical savings account that were not reported on their Form W-2.
	  F1040 \ N609
SIMPLE contribution, self
	Contributions made to your SIMPLE retirement plan that were not reported on your Form W-2.
	  F1040 \ N610
SIMPLE contribution, spouse
	Contributions made to your spouse’s SIMPLE retirement plan that were not reported on your spouse’s Form W-2.
	  F1040 \ N611
Fed tax withheld, Social Security, self
	The amount of federal income taxes withheld from your part of any monthly benefit under title II of the Social Security Act.
	  F1040 \ N612
Fed tax withheld, Social Security, spouse
	The amount of federal income taxes withheld from your spouse’s part of any monthly benefit under title II of the Social Security Act.
	  F1040 \ N613
Fed tax withheld, RR retire, self
	The amount of federal income taxes withheld from your part of tier I railroad retirement benefits, which are treated as a social security benefits.
	  F1040 \ N614
Fed tax withheld, RR retire, spouse
	The amount of federal income taxes withheld from your spouse’s part of tier I railroad retirement benefits, which are treated as a social security benefits.
	  F1040 \ N636
Student loan interest
	The amount of interest you paid this year on qualified student loans.
	Help F1099-G \ H634
Form 1099-G - certain Government payments
	Form 1099-G is used to report certain government payments from federal, state, or local governments.
	  F1099-G \ N260
State and local tax refunds
	Refund of state or local income tax refund (or credit or offset) which you deducted or took a credit for in an earlier year. You should receive a statement, Form 1099-G. Not reportable if you didn’t itemize last year.
	  F1099-G \ N479
Unemployment compensation
	Total unemployment compensation paid to you this year. Reported on Form 1099-G.
	  F1099-G \ N605
Unemployment comp repaid
	If you received an overpayment of unemployment compensation this year or last and you repaid any of it this year, subtract the amount you repaid from the total amount you received.
	  F1099-G \ N606
Fed tax withheld, unemployment comp
	The amount of federal income taxes withheld from your unemployment compensation.
	  F1099-G \ N672
Qualified state tuition earnings
	Qualified state tuition program earnings you received this year.
	Help F1099-MISC \ H553
Form 1099-MISC - MISCellaneous income
	Form 1099-MISC is used to report miscellaneous income received and direct sales of consumer goods for resale.
	^ F1099-MISC \ N259
Prizes and awards
	The amount of prizes and awards that are not for services performed. Included is the fair market value of merchandise won on game shows.
	^ F1099-MISC \ N557
Other income
	The amount of prizes and awards that are not for services performed. Included is the fair market value of merchandise won on game shows. Included is all punitive damages, any damages for nonphysical injuries or sickness, and any other taxable damages, Deceased employee’s wages paid to estate or beneficiary.
	^ F1099-MISC \ N555
Rents
	Amounts received for all types of rents, such as real estate rentals for office space, machine rentals, and pasture rentals.
	^ F1099-MISC \ N556
Royalties
	The gross royalty payments received from a publisher or literary agent.
	^ F1099-MISC \ N558
Federal tax withheld
	The amount of federal income tax withheld (backup withholding) from 1099-MISC income.
	^ F1099-MISC \ N559
Fishing boat proceeds
	Your share of all proceeds from the sale of a catch or the fair market value of a distribution in kind that you received as a crew member of a fishing boat.
	^ F1099-MISC \ N560
Medical/health payments
	The amount of payments received as a physician or other supplier or provider of medical or health care services. This includes payments made by medical and health care insurers under health, accident, and sickness insurance programs.
	^ F1099-MISC \ N561
Non employee compensation
	The amount of non-employee compensation received. This includes fees, commissions, prizes and awards for services performed, other forms of compensation for services you performed for a trade or business by which you are not employed.  Also include oil and gas payments for a working interest.
	^ F1099-MISC \ N562
Crop insurance proceeds
	The amount of crop insurance proceeds as the result of crop damage.
	^ F1099-MISC \ N563
State tax withheld
	The amount of state income tax withheld (state backup withholding) from 1099-MISC income.
	Help F1099=MSA \ H629
Form 1099-MSA Medical Savings Account
	Form 1099-MSA is used to report medical savings account distributions.
	  F1099-MSA \ N631
MSA gross distribution
	The amount you received this year from a Medical Savings Account. The amount may have been a direct payment to the medical service provider or distributed to you.
	  F1099-MSA \ N632
MSA earnings on excess contrib
	The earnings on any excess contributions you withdrew from an MSA by the due date of your income tax return. If you withdrew the excess, plus any earnings, by the due date of your income tax return, you must include the earnings in your income in the year you received the distribution even if you used it to pay qualified medical expenses.
	Help F1099-R \ H473
Form 1099-R - Retirement distributions
	Form 1099-R is used to report taxable and non-taxable retirement distributions from retirement, pension, profit-sharing, or annuity plans. Use a separate Form 1099-R for each payer.
	^ F1099-R \ N475
Total pension gross distribution
	The gross amount of a distribution from a qualified pension or annuity plan. Note: IRA distributions are not included here.
	^ F1099-R \ N476
Total pension taxable distribution
	The taxable amount of a distribution from a qualified pension or annuity plan. Note: IRA distributions are not included here.
	^ F1099-R \ N477
Total IRA gross distribution
	The gross amount of a distribution from a qualified Individual Retirement Arrangement (IRA) plan.
	^ F1099-R \ N478
Total IRA taxable distribution
	The taxable amount of a distribution from a qualified Individual Retirement Arrangement (IRA) plan.
	^ F1099-R \ N529
Pension federal tax withheld
	The amount of federal income taxes withheld from your pension distribution.
	^ F1099-R \ N530
Pension state tax withheld
	The amount of state income taxes withheld from your pension distribution.
	^ F1099-R \ N531
Pension local tax withheld
	The amount of local income taxes withheld from your pension distribution.
	^ F1099-R \ N532
IRA federal tax withheld
	The amount of federal income taxes withheld from your IRA distribution.
	^ F1099-R \ N533
IRA state tax withheld
	The amount of state income taxes withheld from your IRA distribution.
	^ F1099-R \ N534
IRA local tax withheld
	The amount of local income taxes withheld from your IRA distribution.
	^ F1099-R \ N623
SIMPLE total gross distribution
	The gross amount of a distribution received from a qualified SIMPLE pension plan.
	^ F1099-R \ N624
SIMPLE total taxable distribution
	The taxable amount of a distribution received from a qualified SIMPLE plan. This amount may be subject to a federal penalty of up to 25%.
	^ F1099-R \ N625
SIMPLE federal tax withheld
	The amount of federal income taxes withheld from a SIMPLE distribution received.
	^ F1099-R \ N626
SIMPLE state tax withheld
	The amount of state income taxes withheld from a SIMPLE distribution received.
	^ F1099-R \ N627
SIMPLE local tax withheld
	The amount of local income taxes withheld from a SIMPLE distribution received.
	Help F2106 \ H380
employee business expenses
	Form 2106 is used to deduct employee business expenses. You must file this form if you were reimbursed by your employer or claim job-related travel, transportation, meal, or entertainment expenses. Use a separate Form 2106 for your spouse’s expenses.
	  F2106 \ N381
Education expenses
	Cost of tuition, books, supplies, laboratory fees, and similar items, and certain transportation costs if the education maintains or improves skills required in your present work or is required by your employer or the law to keep your salary, status, or job, and the requirement serves a business purpose of your employer. Expenses are not deductible if they are needed to meet the minimum educational requirements to qualify you in your work or business or will lead to qualifying you in a new trade or business.
	  F2106 \ N382
Automobile expenses
	Total annual expenses for gasoline, oil, repairs, insurance, tires, license plates, or similar items.
	  F2106 \ N384
Local transportation expenses
	Local transportation expenses are the expenses of getting from one workplace to another when you are not traveling away from home. They include the cost of transportation by air, rail, bus, taxi, and the cost of using your car. Generally, the cost of commuting to and from your regular place of work is not deductible.
	  F2106 \ N385
Other business expenses
	Other job-related expenses, including expenses for business gifts, trade publications, etc.
	  F2106 \ N386
Meal/entertainment expenses
	Allowable meals and entertainment expense, including meals while away from your tax home overnight and other business meals and entertainment.
	  F2106 \ N387
Reimb. business expenses (non-meal/ent.)
	Reimbursement for business expenses from your employer that is NOT included on your Form W-2. Note: meals and entertainment are NOT included here.
	  F2106 \ N388
Reimb. meal/entertainment expenses
	Reimbursement for meal and entertainment expenses from your employer that is NOT included on your Form W-2.
	  F2106 \ N389
Job seeking expenses
	Fees to employment agencies and other costs to look for a new job in your present occupation, even if you do not get a new job.
	  F2106 \ N390
Special clothing expenses
	cost and upkeep of work clothes, if you must wear them as a condition of your employment, and the clothes are not suitable for everyday wear. Include the cost of protective clothing required in your work, such as safety shoes or boots, safety glasses, hard hats, and work gloves.
	  F2106 \ N391
Employee home office expenses
	Your use of the business part of your home must be: exclusive, regular, for your trade or business, AND The business part of your home must be one of the following: your principal place of business, a place where you meet or deal with patients, clients, or customers in the normal course of your trade or business, or a separate structure (not attached to your home) you use in connection with your trade or business. Additionally, Your business use must be for the convenience of your employer, and You do not rent all or part of your home to your employer and use the rented portion to perform services as an employee. See IRS Pub 587.
	  F2106 \ N383
Travel (away from home)
	Travel expenses are those incurred while traveling away from home for your employer. The cost of getting to and from your business destination (air, rail, bus, car, etc.), taxi fares, baggage charges, and cleaning and laundry expenses. Note: meal and entertainment expenses are not included here.
	Help F4137 \ H503
Form 4137 - tips not reported
	Form 4137 is used to compute social security and Medicare tax owed on tips you did not report to your employer.
	  F4137 \ N505
Total cash/tips not reported to employer
	The amount of tips you did not report to your employer.
	Help F2441 \ H400
Form 2441 - child and dependent credit
	Form 2441 is used to claim a credit for child and dependent care expenses.
	< F2441 \ N401
Qualifying child/dependent care expenses
	The total amount you actually paid to the care provider. Also, include amounts your employer paid to a third party on your behalf.
	< F2441 \ N402
Qualifying household expenses
	The cost of services needed to care for the qualifying person as well as to run the home.  They include the services of a babysitter, cleaning person, cook, maid, or housekeeper if the services were partly for the care of the qualifying person.
	Help F3903 \ H403
Form 3903 - moving expenses
	Form 3903 is used to claim moving expenses.
	  F3903 \ N406
Transport/storage of goods
	The amount you paid to pack, crate and move your household goods and personal effects.  You may include the cost to store and insure household goods and personal effects within any period of 30 days in a row after the items were moved from your old home.
	  F3903 \ N407
Travel/lodging, except meals
	The amount you paid to travel from your old home to your new home. This includes transportation and lodging on the way. Although not all members of your household must travel together, you may only include expenses for one trip per person. Do not include meals.
	Help F4684 \ H412
Form 4684 - casualties and thefts
	Form 4684 is used to report gains and losses from casualties and thefts.
	  F4684 \ N416
FMV after casualty
	The fair market value (FMV) is the price at which the property would change hands between a willing buyer and seller, each having knowledge of the relevant facts. The FMV after a theft is zero if the property is not recovered. The FMV is generally determined by competent appraisal.
	  F4684 \ N413
Basis of casualty property
	Cost or other basis usually means original cost plus improvements. Subtract any postponed gain from the sale of a previous main home. Special rules apply to property received as a gift or inheritance. See Pub  551, Basis of Assets, for details.
	  F4684 \ N414
Insurance/reimbursement
	The amount of insurance or other reimbursement you received expect to receive.
	  F4684 \ N415
FMV before casualty
	The fair market value (FMV) is the price at which the property would change hands between a willing buyer and seller, each having knowledge of the relevant facts. FMV is generally determined by competent appraisal.
	Help F4835 \ H569
Form 4835 - farm rental income
	Form 4835 is used to report farm rental income received as a share of crops or livestock produced by your tenant if you did not materially participate in the operation or management of the farm.  Use a different copy of Form 4835 for each farm rented.
	  F4835 \ N572
Total cooperative distributions
	Distributions received from a cooperative. This includes patronage dividends, non patronage distributions, per-unit retain allocations, and redemption of non qualified notices and per unit retain allocations. Reported on Form 1099-PATR.
	  F4835 \ N571
Sale of livestock/produce
	Income you received from livestock, produce, grains, and other crops based on production. Under both the cash and the accrual methods of reporting, you must report livestock or crop share rentals received in the year you convert them into money or its equivalent.
	  F4835 \ N573
Agricultural program payments
	Government payments received for: price support payments, market gain from the repayment of a secured Commodity Credit Corporation (CCC) loan for less than the original loan amount, diversion payments, cost-share payments (sight drafts), payments in the form of materials (such as fertilizer or lime) or services (such as grading or building dams). Reported on Form 1099-G.
	  F4835 \ N574
CCC loans reported/election
	Generally, you do not report CCC loan proceeds as income. However, if you pledge part or all of your production to secure a CCC loan, you may elect to report the loan proceeds as income in the year you receive them, instead of the year you sell the crop.
	  F4835 \ N575
CCC loans forfeited/repaid
	The full amount forfeited or repaid with certificates, even if you reported the loan proceeds as income.  See IRS Pub 225.
	  F4835 \ N576
Crop insurance proceeds received
	You generally include crop insurance proceeds in the year you receive them. Treat as crop insurance proceeds the crop disaster payments you receive from the federal government.
	  F4835 \ N577
Crop insurance proceeds deferred
	If you use the cash method of accounting and receive crop insurance proceeds in the same tax year in which the crops are damaged, you can choose to postpone reporting the proceeds as income until the following tax year. A statement must also be attached to your return.  See IRS Pub 225.
	  F4835 \ N578
Other income
	Illegal Federal irrigation subsidies, bartering income, income from discharge of indebtedness, state gasoline or fuel tax refund, the gain or loss on the sale of commodity futures contracts, etc.
	  F4835 \ N579
Car and truck expenses
	The business portion of car or truck expenses, such as, for gasoline, oil, repairs, insurance, tires, license plates, etc.
	  F4835 \ N580
Chemicals
	Chemicals used in operating your farm, such as insect sprays and dusts.
	  F4835 \ N581
Conservation expenses
	Your expenses for soil or water conservation or for the prevention of erosion of land used in farming. To take this deduction, your expenses must be consistent with a plan approved by the Natural Resources Conservation Service (NRCS) of the Department of Agriculture.
	  F4835 \ N582
Custom hire expenses
	Amounts you paid for custom hire (machine work) (the machine operator furnished the equipment).  Do not include amounts paid for rental or lease of equipment you operated yourself.
	  F4835 \ N583
Employee benefit programs
	Contributions to employee benefit programs, such as accident and health plans, group-term life insurance, and dependent care assistance programs. Do not include contributions  that are a incidental part of a pension or profit-sharing plan.
	  F4835 \ N584
Feed purchased
	The cost of feed for your livestock. Generally, you cannot currently deduct expenses for feed to be consumed by your livestock in a later tax year. See instructions for Schedule F.
	  F4835 \ N585
Fertilizers and lime
	The cost of fertilizer, lime, and other materials applied to farm land to enrich, neutralize, or condition it. You can also deduct the cost of applying these materials. However, see Prepaid Farm Supplies, in Pub 225, for a rule that may limit your deduction for these materials.
	  F4835 \ N586
Freight and trucking
	The costs of freight or trucking of produce or livestock.
	  F4835 \ N587
Gasoline, fuel, and oil
	The costs of gas, fuel, oil, etc. for farm equipment.
	  F4835 \ N588
Insurance (other than health)
	Premiums paid for farm business insurance, such as: fire, storm, crop, theft and liability protection of farm assets.  Do not include premiums for employee accident and health insurance.
	  F4835 \ N589
Interest expense, mortgage
	The interest you paid to banks or other financial institutions for which you received a Form 1098, for a mortgage on real property used in your farming business (other than your main home). If you paid interest on a debt secured by your main home, and any proceeds from that debt were used in your farming operation, refer to IRS Pub 225.
	  F4835 \ N590
Interest expense, other
	The interest you paid for which you did not receive a Form 1098 (perhaps someone else did, and you are liable too), for a mortgage or other loans for your farm business.
	  F4835 \ N591
Labor hired
	The amounts you paid for farm labor. Do not include amounts paid to yourself.  Count the cost of boarding farm labor but not the value of any products they used from the farm. Count only what you paid house-hold help to care for farm laborers.
	  F4835 \ N592
Pension/profit-sharing plans
	Enter your deduction for contributions to employee pension, profit-sharing, or annuity plans. If the plan included you as a self-employed person, see the instructions for Schedule C (Form 1040).
	  F4835 \ N593
Rent/lease vehicles, equip.
	The business portion of your rental cost, for rented or leased vehicles, machinery, or equipment. But if you leased a vehicle for a term of 30 days or more, you may have to reduce your deduction by an inclusion amount. For details, see the instructions for Schedule C (Form 1040).
	  F4835 \ N594
Rent/lease land, animals
	Amounts paid to rent or lease property such as pasture or farm land.
	  F4835 \ N595
Repairs and maintenance
	Amounts you paid for repairs and maintenance of farm buildings, machinery, and equipment. You can also include what you paid for tools of short life or minimal cost, such as shovels and rakes.
	  F4835 \ N596
Seeds and plants purchased
	The amounts paid for seeds and plants purchased for farming.
	  F4835 \ N597
Storage and warehousing
	Amounts paid for storage and warehousing of crops, grains, etc.
	  F4835 \ N598
Supplies purchased
	Livestock supplies and other supplies, including bedding, office supplies, etc.
	  F4835 \ N599
Imposte
	Real estate and personal property taxes on farm business assets; Social security and Medicare taxes you paid to match what you are required to withhold from farm employees’ wages and any Federal unemployment tax paid; Federal highway use tax.
	  F4835 \ N600
Utilities
	Amounts you paid for gas, electricity, water, etc., for business use on the farm. Do not include personal utilities. You cannot deduct the base rate (including taxes) of the first telephone line into your residence, even if you use it for business.
	  F4835 \ N601
Vet, breeding, medicine
	The costs of veterinary services, medicine and breeding fees.
	  F4835 \ N602
Other farm expenses
	Include all ordinary and necessary farm rental expenses not deducted elsewhere on Form 4835, such as advertising, office supplies, etc. Do not include fines or penalties paid to a government for violating any law.
	Help F4952 \ H425
Form 4952 - investment interest
	Form 4952 is used to compute the amount of investment interest expense deductible for the current year and the amount, if any, to carry forward to future years.
	  F4952 \ N426
Investment interest expense
	The investment interest paid or accrued during the tax year, regardless of when you incurred the indebtedness. Investment interest is interest paid or accrued on a loan (or part of a loan) that is allocable to property held for investment.
	Help F6252 \ H427
Form 6252 - income from casual sales
	Form 6252 is used to report income from casual sales of real or personal property when you will receive any payments in a tax year after the year of sale (i.e., installment sale).
	  F6252 \ N428
Selling price
	Enter the total of any money, face amount of the installment obligation, and the FMV of other property that you received or will receive in exchange for the property sold.
	  F6252 \ N429
Debt assumed by buyer
	Enter only mortgages or other debts the buyer assumed from the seller or took the property subject to. Do not include new mortgages the buyer gets from a bank, the seller, or other sources.
	  F6252 \ N431
Depreciation allowed
	Enter all depreciation or amortization you deducted or should have deducted from the date of purchase until the date of sale. Add any section 179 expense deduction.  Several other adjustments are allowed, See Form 6252 instructions.
	  F6252 \ N432
Expenses of sale
	Enter sales commissions, advertising expenses, attorney and legal fees, etc., in selling the property.
	  F6252 \ N434
Payments received this year
	Enter all money and the fair market value (FMV) of any property you received in this tax year. Include as payments any amount withheld to pay off a mortgage or other debt, such as broker and legal fees. Do not include interest whether stated or unstated.
	  F6252 \ N435
Payments received prior years
	Enter all money and the fair market value (FMV) of property you received before this tax year from the sale. Include allocable installment income and any other deemed payments from prior years. Do not include interest whether stated or unstated.
	Help F8815 \ H441
Form 8815 - EE U.S. savings bonds sold for education
	Form 8815 is used to compute the amount of interest you may exclude if you cashed series EE U.S. savings bonds this year that were issued after 1989 to pay for qualified higher education costs.
	  F8815 \ N442
Qualified higher education expenses
	Qualified higher education expenses include tuition and fees required for the enrollment or attendance of the person(s). Do not include expenses for room and board, or courses involving sports, games, or hobbies that are not part of a degree or certificate granting program.
	  F8815 \ N443
Nontaxable education benefits
	Nontaxable educational benefits. These benefits include: Scholarship or fellowship grants excludable from income under section 117; Veterans’ educational assistance benefits; Employer-provided educational assistance benefits that are not included in box 1 of your W-2 form(s); Any other payments (but not gifts, bequests, or inheritances) for educational expenses that are exempt from income tax by any U.S. law. Do not include nontaxable educational benefits paid directly to, or by, the educational institution.
	  F8815 \ N444
EE US savings bonds proceeds
	Enter the total proceeds (principal and interest) from all series EE and I U.S. savings bonds issued after 1989 that you cashed during this tax year.
	  F8815 \ N445
Post-89 EE bond face value
	The face value of all post-1989 series EE bonds cashed this tax year.
	Help F8863 \ H639
Form 8863 - Hope and Lifetime Learning education credits
	Form 8863 is used to compute the Hope and Lifetime Learning education credits. IRS rules are stringent for these credits.  Refer to IRS Publication 970 for more information.
	  F8863 \ N637
Hope credit
	Expenses qualified for the Hope credit are amounts paid this tax year for tuition and fees required for the student’s enrollment or attendance at an eligible educational institution.
	  F8863 \ N638
Lifetime learning credit
	Expenses qualified for the Lifetime Learning credit are amounts paid this tax year for tuition and fees required for the student’s enrollment or attendance at an eligible educational institution.
	Help F8829 \ H536
Form 8829 - business use of your home
	Form 8829 is used only if you file a Schedule C, Profit or Loss from Business, and you meet specific requirements to deduct expenses for the business use of your home.  IRS rules are stringent for this deduction.  Refer to IRS Publication 587.
	  F8829 \ N537
Deductible mortgage interest
	The total amount of mortgage interest that would be deductible whether or not you used your home for business (i.e., amounts allowable as itemized deductions on Schedule A, Form 1040). Form 8829 computes the deductible business portion.
	  F8829 \ N538
Real estate taxes
	The total amount of real estate taxes that would be deductible whether or not you used your home for business (i.e., amounts allowable as itemized deductions on Schedule A, Form 1040). Form 8829 computes the deductible business portion.
	  F8829 \ N539
Assicurazione
	The total amount of insurance paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.
	  F8829 \ N540
Repairs and maintenance
	The total amount of repairs and maintenance paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.
	  F8829 \ N541
Utilities
	The total amount of utilities paid for your home, in which an area or room is used regularly and exclusively for business.  Form 8829 computes the deductible business portion.
	  F8829 \ N542
Other expenses
	If you rent rather than own your home, include rent paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.
	Help F8839 \ H617
Form 8839 - adoption expenses
	Form 8839 is used to report qualified adoption expenses.
	  F8839 \ N618
Adoption fees
	Adoption fees that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.
	  F8839 \ N619
Court costs
	Court costs that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.
	  F8839 \ N620
Attorney fees
	Attorney fees that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.
	  F8839 \ N621
Traveling expenses
	Traveling expenses (including meals and lodging) while away from home, directly related to, and for the principal purpose of, the legal adoption of an eligible child.
	  F8839 \ N622
Other expenses
	Other expenses that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.
	  Home Sale \ N392
Home Sale worksheets (was F2119)
	Home Sale worksheets (replaces Form 2119) are used to report the sale of your personal residence. See IRS Pub 523.
	  Home Sale \ N393
Selling price of old home
	The selling price is the total amount you receive for your home. It includes money, all notes, mortgages, or other debts assumed by the buyer as part of the sale, and the fair market value of any other property or any services you receive. Reported on Form 1099-S.
	  Home Sale \ N394
Expense of sale
	Selling expenses include commissions, advertising fees, legal fees, title insurance, and loan charges paid by the seller, such as loan placement fees or "points."
	  Home Sale \ N396
Fixing-up expenses
	Fixing-up expenses are decorating and repair costs that you paid to sell your old home. For example, the costs of painting the home, planting flowers, and replacing broken windows are fixing-up expenses. Fixing-up expenses must meet all the following conditions. The expenses: Must be for work done during the 90-day period ending on the day you sign the contract of sale with the buyer; Must be paid no later than 30 days after the date of sale; Cannot be deductible in arriving at your taxable in-come; Must not be used in figuring the amount realized; and Must not be capital expenditures or improvements.
	  Home Sale \ N397
Cost of new home
	The cost of your new home includes costs incurred within the replacement period (beginning 2 years before and ending 2 years after the date of sale) for the following items: Buying or building the home; Rebuilding the home; and Capital improvements or additions.
	Help Sched A \ H270
Schedule A - itemized deductions
	Schedule A is used to report your itemized deductions.
	  Sched A \ N271
Subscriptions
	Amounts paid for subscriptions to magazines or services that are directly related to the production or collection of taxable income.  (example: subscriptions to investment publications, stock newsletters, etc.).
	  Sched A \ N272
Gambling losses
	Gambling losses, but only to the extent of gambling winnings reported on Form 1040. Note: not subject to the 2% AGI of limitation.
	  Sched A \ N273
Medicine and drugs
	Prescription medicines, eyeglasses, contact lenses, hearing aids. Over-the-counter medicines are not deductible.
	  Sched A \ N274
Medical travel and lodging
	Lodging expenses while away from home to receive medical care in a hospital or a medical care facility related to a hospital. Do not include more than $50 a night for each eligible person. Ambulance service and other travel costs to get medical care.
	  Sched A \ N275
State income taxes
	State income taxes paid this year for a prior year. Include any part of a prior year refund that you chose to have credited to this years state income taxes.
	  Sched A \ N276
Real estate taxes
	Include taxes (state, local, or foreign) you paid on real estate you own that was not used for business, but only if the taxes are based on the assessed value of the property. Do not include taxes charged for improvements that tend to increase the value of your property (for example, an assessment to build a new sidewalk).
	  Sched A \ N277
Other taxes
	Other taxes paid not included under state and local income taxes, real estate taxes, or personal property taxes. You may want to take a credit for the foreign tax instead of a deduction.
	  Sched A \ N280
Cash charity contributions
	Contributions or gifts by cash or check you gave to organizations that are religious, charitable, educational, scientific, or literary in purpose. You may also deduct what you gave to organizations that work to prevent cruelty to children or animals. For donations of $250 or more, you must have a statement from the charitable organization showing the amount donated and the value of goods or services you received.
	  Sched A \ N281
Tax preparation fees
	Fees you paid for preparation of your tax return, including fees paid for filing your return electronically.
	  Sched A \ N282
Investment management fees
	Investment interest is interest paid on money you borrowed that is allocable to property held for investment. It does not include any interest allocable to passive activities or to securities that generate tax-exempt income.

	  Sched A \ N283
Home mortgage interest (1098)
	Home mortgage interest and points reported to you on Form 1098. The interest could be on a first or second mortgage, home equity loan, or refinanced mortgage.
	  Sched A \ N284
Points paid (no 1098)
	Generally, you must deduct points you paid to refinance a mortgage over the life of the loan. If you used part of the proceeds to improve your main home, you may be able to deduct the part of the points related to the improvement in the year paid. See Pub. 936 Use this line for points not reported on Form 1098.
	  Sched A \ N484
Doctors, dentists, hospitals
	Insurance premiums for medical and dental care, medical doctors, dentists, eye doctors, surgeons, X-ray, laboratory services, hospital care, etc. See IRS Pub 502.
	  Sched A \ N486
Misc., subject to 2% AGI limit
	Safety equipment, small tools, and supplies you needed for your job; Uniforms required by your employer and which you may not usually wear away from work; subscriptions to professional journals; job search expenses; certain educational expenses. You may need to file Form 2106.
	  Sched A \ N485
Non-cash charity contributions
	
The fair market value of donated property, such as used clothing or furniture.
	  Sched A \ N522
State estimated tax, quarterly
	State estimated tax payments made this year.
	  Sched A \ N523
Misc., no 2% AGI limit
	Other miscellaneous itemized deductions that are not reduced by 2% of adjusted gross income, such as casualty and theft losses from income-producing, amortizable bond premium on bonds acquired before October 23, 1986, federal estate tax on income in respect to a decedent, certain unrecovered investment in a pension, impairment-related work expenses of a disabled person.
	  Sched A \ N535
Personal property taxes
	Enter personal property tax you paid, but only if it is based on value alone. Example: You paid a fee for the registration of your car. Part of the fee was based on the car s value and part was based on its weight. You may deduct only the part of the fee that is based on the car s value.
	  Sched A \ N544
Local income taxes
	Local income taxes that were not withheld from your salary, such as local income taxes you paid this year for a prior year.

	  Sched A \ N545
Home mortgage interest (no 1098)
	Home mortgage interest paid, for which you did not receive a Form 1098 from the recipient. The interest could be on a first or second mortgage, home equity loan, or refinanced mortgage.
	Help Sched B \ H285
Schedule B - interest and dividend income
	Schedule B is used to report your interest and dividend income.
	^ Sched B \ N286
Dividend income, Ordinary
	Ordinary dividends from mutual funds, stocks, etc., are reported to you on a 1099-DIV.  Note: these are sometimes called short term capital gain distributions. Do not include (long term) capital gain distributions or non-taxable dividends here, these go on Sched D
	< Sched B \ N287
Interest income
	Taxable interest includes interest you receive from bank accounts, credit unions, loans you made to others. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N288
Interest income, US government
	Interest on U.S. obligations, such as U.S. Treasury bills, notes, and bonds issued by any agency of the United States. This income is exempt from all state and local income taxes. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N289
Interest income, State and municipal bond
	Interest on bonds or notes of states, counties, cities, the District of Columbia, or possessions of the United States is generally free of federal income tax (but you may pay state income tax). There are several categories of interest, be sure you select the correct one!
	< Sched B \ N290
Interest income, tax-exempt private activity bond
	Interest income from a qualified tax-exempt private activity bond is not taxable if it meets all requirements. This income is included on your Schedule B as non-taxable interest income. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N487
Dividend income, non-taxable
	Some mutual funds pay shareholders non-taxable dividends. The amount of non-taxable dividends are indicated on your monthly statements or Form 1099-DIV.
	< Sched B \ N489
Interest income, non-taxable
	Non-taxable interest income other than from bonds or notes of states, counties, cities, the District of Columbia, or a possession of the United States, or from a qualified private activity bond. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N490
Interest income, taxed only by fed
	Interest income that is taxed on your federal return, but not on your state income tax return - other than interest paid on U.S. obligations. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N491
Interest income, taxed only by state
	Interest income that is not taxed on your federal return, but is taxed on your state income tax return - other than interest income from state bonds or notes, the District of Columbia, or a possession of the United States. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N492
Interest income, OID bonds
	Interest income from Original Issue Discount (OID) bonds will be reported to you on Form 1099-OID. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N524
Interest income, Seller-financed mortgage
	Interest the buyer paid you on a mortgage or other form of seller financing, for your home or other property and the buyer used the property as a personal residence. There are several categories of interest, be sure you select the correct one!
	< Sched B \ N615
Fed tax withheld, dividend income
	The amount of federal income taxes withheld from dividend income. This is usually reported on Form 1099-DIV.
	< Sched B \ N616
Fed tax withheld, interest income
	The amount of federal income taxes withheld from interest income. This is usually reported on Form 1099-INT.
	Help Sched C \ H291
Schedule C - self-employment income
	Schedule C is used to report income from self-employment. Use a separate Schedule C to report income and expenses from different businesses.
	  Sched C \ N293
Gross receipts or sales
	The amount of gross receipts from your trade or business. Include amounts you received in your trade or business that were properly shown on Forms 1099-MISC.
	  Sched C \ N294
Meals and entertainment
	Total business meal and entertainment expenses. Business meal expenses are deductible only if they are (a) directly related to or associated with the active conduct of your trade or business, (b) not lavish or extravagant, and (c) incurred while you or your employee is present at the meal.
	  Sched C \ N296
Returns and allowances
	Credits you allow customers for returned merchandise and any other allowances you make on sales.
	  Sched C \ N297
Wages paid
	The total amount of salaries and wages for the tax year. Do not include amounts paid to yourself.
	  Sched C \ N298
Legal and professional fees
	Accountant’s or legal fees for tax advice related to your business and for preparation of the tax forms related to your business.
	  Sched C \ N299
Rent/lease vehicles, equip.
	The amount paid to rent or lease vehicles, machinery, or equipment, for your business. If you leased a vehicle for a term of 30 days or more, you may have to reduce your deduction by an amount called the inclusion amount. See Pub. 463.
	  Sched C \ N300
Rent/lease other business property
	The amounts paid to rent or lease real estate or  property, such as office space in a building.
	  Sched C \ N301
Supplies (not from Cost of Goods Sold)
	The cost of supplies not reported under Cost Of Goods Sold.
	  Sched C \ N302
Other business expenses
	Other costs not specified on other lines of Schedule C, such as: Clean-fuel vehicles and refueling property; Donations to business organizations; Educational expenses; Environmental cleanup costs; Impairment-related expenses; Interview expense allowances; Licenses and regulatory fees; Moving machinery; Outplacement services; Penalties and fines you pay for late performance or nonperformance of a contract; Subscriptions to trade or professional publications.
	  Sched C \ N303
Other business income
	The amounts from finance reserve income, scrap sales, bad debts you recovered, interest (such as on notes and accounts receivable), state gasoline or fuel tax refunds you got this year, prizes and awards related to your trade or business, and other kinds of miscellaneous business income.
	  Sched C \ N304
Pubblicità
	The amounts paid for advertising your trade or business in newspapers, publications, radio or television. Also include the cost of brochures, business cards, or other promotional material.
	  Sched C \ N305
Bad debts from sales/services
	Include debts and partial debts from sales or services that were included in income and are definitely known to be worthless.
	  Sched C \ N306
Car and truck expenses
	You can deduct the actual expenses of running your car or truck, or take the standard mileage rate.
	  Sched C \ N307
Commissions and fees
	The amounts of commissions or fees paid to independent contractors (non employees) for their services.
	  Sched C \ N308
Employee benefit programs
	Contributions to employee benefit programs that are not an incidental part of a pension or profit-sharing plan. Examples are accident and health plans, group-term life insurance, and dependent care assistance programs.
	  Sched C \ N309
Depletion
	The amounts for depletion. If you have timber depletion, attach Form T.  See Pub. 535.
	  Sched C \ N310
Insurance, other than health
	Premiums paid for business insurance. Do not include amounts paid for employee accident and health insurance. nor amounts credited to a reserve for self-insurance or premiums paid for a policy that pays for your lost earnings due to sickness or disability. See Pub. 535.
	  Sched C \ N311
Interest expense, mortgage
	The interest you paid to banks or other financial institutions for which you received a Form 1098, for a mortgage on real property used in your business (other than your main home).
	  Sched C \ N312
Interest expense, other
	The interest you paid for which you did not receive a Form 1098 (perhaps someone else did, and you are liable too), for a mortgage or other loans for your business.
	  Sched C \ N313
Office expenses
	The cost of consumable office supplies such as business cards, computer supplies, pencils, pens, postage stamps, rental of postal box or postage machines, stationery, Federal Express and UPS charges, etc.
	  Sched C \ N314
Pension/profit sharing plans
	You can set up and maintain the following small business retirement plans for yourself and your employees, such as: SEP (Simplified Employee Pension) plans; SIMPLE (Savings Incentive Match Plan for Employees) plans; Qualified plans (including Keogh or H.R. 10 plans). You deduct contributions you make to the plan for yourself on Form 1040.
	  Sched C \ N315
Repairs and maintenance
	The cost of repairs and maintenance. Include labor, supplies, and other items that do not add to the value or increase the life of the property. Do not include the value of your own labor. Do not include amounts spent to restore or replace property; they must be capitalized.
	  Sched C \ N316
Taxes and licenses
	Include the following taxes: State and local sales taxes imposed on you as the seller of goods or services; Real estate and personal property taxes on business assets; Social security and Medicare taxes paid to match required withholding from your employees’ wages; Also, Federal unemployment tax paid; Federal highway use tax.
	  Sched C \ N317
Travel
	Expenses for lodging and transportation connected with overnight travel for business while away from your tax home.
	  Sched C \ N318
Utilities
	The costs of electricity, gas, telephone, etc. for your business property.
	  Sched C \ N493
Cost of Goods Sold - Purchases
	If you are a merchant, use the cost of all merchandise you bought for sale. If you are a manufacturer or producer, this includes the cost of all raw materials or parts purchased for manufacture into a finished product. You must exclude the cost of merchandise you withdraw for your personal or family use.
	  Sched C \ N494
Cost of Goods Sold - Labor
	Labor costs are usually an element of cost of goods sold only in a manufacturing or mining business. In a manufacturing business, labor costs that are properly allocable to the cost of goods sold include both the direct and indirect labor used in fabricating the raw material into a finished, salable product.
	  Sched C \ N495
Cost of Goods Sold - Materials/supplies
	Materials and supplies, such as hardware and chemicals, used in manufacturing goods are charged to cost of goods sold. Those that are not used in the manufacturing process are treated as deferred charges. You deduct them as a business expense when you use them.
	  Sched C \ N496
Cost of Goods Sold - Other costs
	Other costs incurred in a manufacturing or mining process that you charge to your cost of goods sold are containers, freight-in, overhead expenses.
	Help Sched D \ H320
Schedule D - capital gains and losses 
	Schedule D is used to report gains and losses from the sale of capital assets.
	# Sched D \ N321
Short Term gain/loss - security
	Short term gain or loss from the sale of a security. Not yet implemented in GnuCash.
	# Sched D \ N323
Long Term gain/loss - security
	Long term gain or loss from the sale of a security. Not yet implemented in GnuCash.
	^ Sched D \ N488
Dividend income, capital gain distributions
	Sometimes called long term capital gain distributions. These are from mutual funds, other regulated investment companies, or real estate investment trusts.  These are reported on your monthly statements or Form 1099-DIV. Note: short term capital gain distributions are reported on Sched B as ordinary dividends
	# Sched D \ N673
Short/Long Term gain or loss
	Short term or long term gain or loss from the sale of a security; for use when only the date sold and net sales amount are available and the date acquired and cost basis information is not available and will be separately added in the tax software.
	Help Sched E \ H325
Schedule E - rental and royalty income
	Schedule E is used to report income or loss from rental real estate, royalties, and residual interest in REMIC’s. Use a different copy for each rental or royalty. Use the Schedule K-1 categories for partnership rental income and loss amounts.
	  Sched E \ N326
Rents received
	The amounts received as rental income from real estate (including personal property leased with real estate) but you were not in the real estate business. (If you are in the business of renting personal property, use Schedule C.)
	  Sched E \ N327
Royalties received
	Royalties received from oil, gas, or mineral properties (not including operating interests); copyrights; and patents.
	  Sched E \ N328
Pubblicità
	Amounts paid to advertise rental unit(s) in newspapers or other media or paid to realtor’s to obtain tenants.
	  Sched E \ N329
Auto and travel
	The ordinary and necessary amounts of auto and travel expenses related to your rental activities, including 50% of meal expenses incurred while traveling away from home.
	  Sched E \ N330
Cleaning and maintenance
	The amounts paid for cleaning services (carpet, drapes), cleaning supplies, locks and keys, pest control, pool service, and general cost of upkeep of the rental property.
	  Sched E \ N331
Commissioni
	The amounts paid as Commissions to realtor’s or management companies to collect rent.
	  Sched E \ N332
Assicurazione
	Insurance premiums paid for fire, theft, liability.
	  Sched E \ N333
Legal and professional fees
	The amounts of fees for tax advice and the preparation of tax forms related to your rental real estate or royalty properties.
	  Sched E \ N334
Mortgage interest expense
	Interest paid to banks or other financial institutions for a mortgage on your rental property, and you received a Form 1098.
	  Sched E \ N335
Other interest expense
	Interest paid for a mortgage on your rental property, not paid to banks or other financial institutions or you did not receive a Form 1098.
	  Sched E \ N336
Repairs
	You may deduct the cost of repairs made to keep your property in good working condition. Repairs generally do not add significant value to the property or extend its life.
	  Sched E \ N337
Supplies
	Miscellaneous items needed to maintain the property, such as: brooms, cleaning supplies, nails, paint brushes, etc.
	  Sched E \ N338
Imposte
	The amounts paid for real estate and personal property taxes. Also include the portion of any payroll taxes you paid for your employees.
	  Sched E \ N339
Utilities
	The costs of electricity, gas, telephone, etc. for your rental property.
	  Sched E \ N341
Other expenses
	Other expenses that are not listed on other tax lines of Schedule E.  These might include the cost of gardening and/or snow removal services, association dues, bank charges, etc.
	  Sched E \ N502
Management fees
	The amount of fees to a manager or property management company to oversee your rental or royalty property.
	Help Sched F \ H343
Schedule F - Farm income and expense
	Schedule F is used to report farm income and expense. Use a different copy of Schedule F for each farm you own.
	  Sched F \ N344
Labor hired
	The amounts you paid for farm labor. Do not include amounts paid to yourself.  Count the cost of boarding farm labor but not the value of any products they used from the farm. Count only what you paid house-hold help to care for farm laborers.
	  Sched F \ N345
Repairs and maintenance
	Amounts you paid for repairs and maintenance of farm buildings, machinery, and equipment. You can also include what you paid for tools of short life or minimal cost, such as shovels and rakes.
	  Sched F \ N346
Interest expense, mortgage
	The interest you paid to banks or other financial institutions for which you received a Form 1098, for a mortgage on real property used in your farming business (other than your main home). If you paid interest on a debt secured by your main home, and any proceeds from that debt were used in your farming operation, refer to IRS Pub 225.
	  Sched F \ N347
Interest expense, other
	The interest you paid for which you did not receive a Form 1098 (perhaps someone else did, and you are liable too), for a mortgage or other loans for your farm business.
	  Sched F \ N348
Rent/lease land, animals
	Amounts paid to rent or lease property such as pasture or farm land.
	  Sched F \ N349
Rent/lease vehicles, equip.
	The business portion of your rental cost, for rented or leased vehicles, machinery, or equipment. But if you leased a vehicle for a term of 30 days or more, you may have to reduce your deduction by an inclusion amount. For details, see the instructions for Schedule C (Form 1040).
	  Sched F \ N350
Feed purchased
	The cost of feed for your livestock. Generally, you cannot currently deduct expenses for feed to be consumed by your livestock in a later tax year. See instructions for Schedule F.
	  Sched F \ N351
Seeds and plants purchased
	The amounts paid for seeds and plants purchased for farming.
	  Sched F \ N352
Fertilizers and lime
	The cost of fertilizer, lime, and other materials applied to farm land to enrich, neutralize, or condition it. You can also deduct the cost of applying these materials. However, see Prepaid Farm Supplies, in Pub 225, for a rule that may limit your deduction for these materials.
	  Sched F \ N353
Supplies purchased
	Livestock supplies and other supplies, including bedding, office supplies, etc.
	  Sched F \ N355
Vet, breeding, and medicine
	The costs of veterinary services, medicine and breeding fees.
	  Sched F \ N356
Gasoline, fuel, and oil
	The costs of gas, fuel, oil, etc. for farm equipment.
	  Sched F \ N357
Storage and warehousing
	Amounts paid for storage and warehousing of crops, grains, etc.
	  Sched F \ N358
Imposte
	Real estate and personal property taxes on farm business assets; Social security and Medicare taxes you paid to match what you are required to withhold from farm employees’ wages and any Federal unemployment tax paid; Federal highway use tax.
	  Sched F \ N359
Insurance, other than health
	Premiums paid for farm business insurance, such as: fire, storm, crop, theft and liability protection of farm assets.  Do not include premiums for employee accident and health insurance.
	  Sched F \ N360
Utilities
	Amounts you paid for gas, electricity, water, etc., for business use on the farm. Do not include personal utilities. You cannot deduct the base rate (including taxes) of the first telephone line into your residence, even if you use it for business.
	  Sched F \ N361
Freight and trucking
	The costs of freight or trucking of produce or livestock.
	  Sched F \ N362
Conservation expenses
	Your expenses for soil or water conservation or for the prevention of erosion of land used in farming. To take this deduction, your expenses must be consistent with a plan approved by the Natural Resources Conservation Service (NRCS) of the Department of Agriculture.
	  Sched F \ N363
Pension/profit sharing plans
	Enter your deduction for contributions to employee pension, profit-sharing, or annuity plans. If the plan included you as a self-employed person, see the instructions for Schedule C (Form 1040).
	  Sched F \ N364
Employee benefit programs
	Contributions to employee benefit programs, such as accident and health plans, group-term life insurance, and dependent care assistance programs. Do not include contributions  that are a incidental part of a pension or profit-sharing plan.
	  Sched F \ N365
Other farm expenses
	Include all ordinary and necessary farm expenses not deducted elsewhere on Schedule F, such as advertising, office supplies, etc. Do not include fines or penalties paid to a government for violating any law.
	  Sched F \ N366
Chemicals
	Chemicals used in operating your farm, such as insect sprays and dusts.
	  Sched F \ N367
Custom hire expenses
	Amounts you paid for custom hire (machine work) (the machine operator furnished the equipment).  Do not include amounts paid for rental or lease of equipment you operated yourself.
	  Sched F \ N372
Agricultural program payments
	Government payments received for: price support payments, market gain from the repayment of a secured Commodity Credit Corporation (CCC) loan for less than the original loan amount, diversion payments, cost-share payments (sight drafts), payments in the form of materials (such as fertilizer or lime) or services (such as grading or building dams). Reported on Form 1099-G.
	  Sched F \ N373
CCC loans reported/election
	Generally, you do not report CCC loan proceeds as income. However, if you pledge part or all of your production to secure a CCC loan, you may elect to report the loan proceeds as income in the year you receive them, instead of the year you sell the crop.
	  Sched F \ N374
CCC loans forfeited or repaid
	The amount forfeited or repaid with certificates, even if you reported the loan proceeds as income.  See IRS Pub 225.
	  Sched F \ N375
Crop insurance proceeds received
	You generally include crop insurance proceeds in the year you receive them. Treat as crop insurance proceeds the crop disaster payments you receive from the federal government.
	  Sched F \ N376
Crop insurance proceeds deferred
	If you use the cash method of accounting and receive crop insurance proceeds in the same tax year in which the crops are damaged, you can choose to postpone reporting the proceeds as income until the following tax year. A statement must also be attached to your return.  See IRS Pub 225.
	  Sched F \ N377
Other farm income
	Illegal Federal irrigation subsidies, bartering income, income from discharge of indebtedness, state gasoline or fuel tax refund, the gain or loss on the sale of commodity futures contracts, etc.
	  Sched F \ N368
Sales livestock/product raised
	Amounts you received from the sale of livestock, produce, grains, and other products you raised.
	  Sched F \ N369
Resales of livestock/items
	Amounts you received from the sales of livestock and other items you bought specifically for resale. Do not include sales of livestock held for breeding, dairy purposes, draft, or sport.  These are reported on Form 4797, Sales of Business Property.
	  Sched F \ N370
Custom hire income
	The income you received for custom hire (machine work).
	  Sched F \ N371
Total cooperative distributions
	Distributions received from a cooperative. This includes patronage dividends, non patronage distributions, per-unit retain allocations, and redemption of non qualified notices and per unit retain allocations. Reported on Form 1099-PATR.
	  Sched F \ N378
Cost of resale livestock/items
	The cost or other basis of the livestock and other items you actually sold.
	  Sched F \ N543
Car and truck expenses
	The business portion of car or truck expenses, such as, for gasoline, oil, repairs, insurance, tires, license plates, etc.
	Help Sched H \ H565
Schedule H - Household employees
	Schedule H is used to report Federal employment taxes on cash wages paid this year to household employees.  Federal employment taxes include social security, Medicare, withheld Federal income, and Federal unemployment (FUTA) taxes.
	^ Sched H \ N567
Cash wages paid
	For household employees to whom you paid $1,100 (as of 1999) or more each of cash wages that are subject to social security and Medicare taxes. To find out if the wages are subject to these taxes, see the instructions for Schedule H.
	^ Sched H \ N568
Federal tax withheld
	Federal income tax withheld from total cash wages paid to household employees during the year.
	Help Sched K-1 \ H446
Schedule K-1 - partnership income, credits, deductions
	Schedule K-1 is used to report your share of a partnership’s income, credits, deductions, etc.  Use a separate copy of Schedule K-1 for each partnership.
	# Sched K-1 \ N448
Ordinary income or loss
	Your share of the ordinary income (loss) from the trade or business activities of the partnership. This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)
	# Sched K-1 \ N449
Rental real estate income or loss
	The income or (loss) from rental real estate activities engaged in by the partnership. This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)
	# Sched K-1 \ N450
Other rental income or loss
	The income or (loss) from rental activities, other than the rental of real estate.  This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)
	  Sched K-1 \ N451
Interest income
	The amount of interest income the partnership reported to you on Schedule K-1. (You report this on Schedule B)
	  Sched K-1 \ N452
Dividends, ordinary
	The amount of dividend income the partnership reported to you on Schedule K-1. (You report this on Schedule B)
	# Sched K-1 \ N453
Net ST capital gain or loss
	The short-term gain or (loss) from sale of assets the partnership reported to you on K-1. (You report this on Schedule D)
	# Sched K-1 \ N454
Net LT capital gain or loss
	The long-term gain or (loss) from the sale of assets the partnership reported to you on Schedule K-1. (You report this on Schedule D)
	  Sched K-1 \ N455
Guaranteed partner payments
	A guaranteed payments the partnership reported to you on Schedule K-1. (You report this on Schedule E)
	# Sched K-1 \ N456
Net Section 1231 gain or loss
	The gain or (loss) from sale of Section 1231 assets the partnership reported to you on Schedule K-1. (You report this on Form 4797)
	  Sched K-1 \ N527
Royalties
	The amount of the royalty income the partnership reported to you on Schedule K-1. (You report this on Schedule E)
	  Sched K-1 \ N528
Tax-exempt interest income
	The amount of tax-exempt interest income the partnership reported to you on Schedule K-1. (You report this on Form 1040)
	Help W-2 \ H458
Form W-2 - Wages earned and taxes withheld
	Form W-2 is used by your employer to report the amount of wages and other compensation you earned as an employee, and the amount of federal and state taxes withheld and fringe benefits received. Use a separate copy of Form W-2 for each employer.
	^ W-2 \ N267
Reimbursed moving expenses, self
	Qualified moving expense reimbursements paid directly to you by an employer.
	^ W-2 \ N460
Salary or wages, self
	The total wages, tips, and other compensation, before any payroll deductions, you receive from your employer.
	^ W-2 \ N461
Federal tax withheld, self
	The amount of Federal income tax withheld from your wages for the year.
	^ W-2 \ N462
Social Security tax withheld, self
	The amount of social security taxes withheld from your wages.
	^ W-2 \ N463
Local tax withheld, self
	The amount of local taxes withheld from your wages.
	^ W-2 \ N464
State tax withheld, self
	The amount of state taxes withheld from your wages.
	^ W-2 \ N465
Dependent care benefits, self
	The amount dependent care benefits, including the fair market value of employer-provided or employer-sponsored day-care facilities you received.
	^ W-2 \ N480
Medicare tax withheld, self
	The amount of Medicare taxes withheld from your wages.
	^ W-2 \ N506
Salary or wages, spouse
	The total wages, tips, and other compensation, before any payroll deductions, your spouse receives from your spouse’s employer.
	^ W-2 \ N507
Federal tax withheld, spouse
	The amount of Federal income tax withheld from your spouse’s wages for the year.
	^ W-2 \ N508
Social Security tax withheld, spouse
	The amount of social security taxes withheld from your spouse’s wages.
	^ W-2 \ N509
Local tax withheld, spouse
	The amount of local taxes withheld from your spouse’s wages.
	^ W-2 \ N510
Medicare tax withheld, spouse
	The amount of Medicare taxes withheld from your spouse’s wages.
	^ W-2 \ N511
State tax withheld, spouse
	The amount of state taxes withheld from your spouse’s wages.
	^ W-2 \ N512
Dependent care benefits, spouse
	The amount dependent care benefits, including the fair market value of employer-provided or employer-sponsored day-care facilities your spouse received.
	^ W-2 \ N546
Reimbursed moving expenses, spouse
	Qualified moving expense reimbursements paid directly to your spouse by your spouse’s employer.
	Help W-2G \ H547
Form W-2G - gambling winnings
	Form W-2G is used to report certain gambling winnings.
	^ W-2G \ N549
Gross winnings
	The amount of gross winnings from gambling.  This may include winnings from horse racing, dog racing, jai alai, lotteries, keno, bingo, slot machines, sweepstakes, and wagering pools. If the amount is large enough, it will be reported on Form W-2G.
	^ W-2G \ N550
Federal tax withheld
	The amount of federal income taxes withheld from gross gambling winnings.
	^ W-2G \ N551
State tax withheld
	The amount of state income taxes withheld from gross gambling winnings.






Source:
	https://github.com/Gnucash/gnucash/blob/maint/src/tax/us/txf-help.scm



Ripristina avvisi...



GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi. Gli avvisi possono essere abilitati in modo selettivo.

Changing the Language



La lingua dell’interfaccia di GnuCash non è direttamente modificabile dalle preferenze del programma.
Il metodo per cambiare lingua del programma dipende dal sistema operativo in cui GnuCash viene eseguito.
	Linux
	In genere è necessario impostare le variabili di sistema LANGUAGE e LANG prima di avviare GnuCash. Per farlo occorre aprire una finestra di terminale ed eseguire il seguente comando:
LANGUAGE=ll_LL LANG=ll_LL gnucash
ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per l’italiano ecc...)
Nota
In alcuni sistemi (per esempio Ubuntu) la codifica può far parte del nome, come ll_LL.UTF-8.


	MacOSX
	Per utilizzare una traduzione diversa da quella selezionata automaticamente, è possibile eseguire il seguente comando in Terminal.app:
defaults write $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app) AppleLanguages "(de, en)"
È possibile usare qualsiasi codice di lingua si desideri, in luogo di Tedesco (de) e Inglese (en). Comunque, se il file per la traduzione non è presente, il comando non funzionerà.
Per reimpostare i valori originali, eseguire:
defaults delete $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app)

	Finestre™
	Se si sta eseguendo GnuCash 2.4.0 (o successivo) su Windows, è possibile impostare la lingua dell’interfaccia modificando il file environment con un editor di testo (per esempio Notepad). Di norma questo file è installato nella cartella c:\Programmi\gnucash\etc\gnucash. Modificare il file in modo che le ultime righe siano come le seguenti:

	  
# If you wish GnuCash to use a different language, uncomment the two parameters
# below and set LANG to your preferred locale
LANG=ll_LL
LANGUAGE={LANG}

	  
ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per l’italiano ecc...)



Suggerimento
Maggiori e più aggiornate informazioni relative all’argomento possono essere reperite sulla pagina delle impostazioni della lingua nel wiki di GnuCash.


Appendice A. Suggerimenti e consigli utili su GnuCash


			GnuCash Version 2.6.11 + Finance::Quote Version 1.38, February 2016
			
			
		



Sommario
This chapter gives you some background informations about
			Finance::Quote.
		

Finance::Quote Sources



There are 3 types of sources of which the first - currency - is
			hardcoded and responsible to fetch ISO currencies.
			The other two can be selected in the security editor.
		
Finance::Quote Sources - Currency source



Tabella A.1. Currency source for Finance::Quote
	
								GnuCash
									Name
								

								
								Finance::Quote Name

								
								Note

							
	
								Valuta

								
								currency

								
								 In 2012 happened a modification on the website.
									Make shure, you updated F::Q to version 1.18.
								

							





Fonti delle quotazioni - fonti individuali



Tabella A.2. Fonti individuali per le quotazioni
	
								GnuCash
									Name
								

								
								Finance::Quote Name

								
								URL, Notes

							
	
								Amsterdam Euronext eXchange, NL

								
								aex

								
								http://www.aex.nl

								includes Futures and Options

							
	
								American International Assurance, HK

								
								aiahk

								
								http://www.aia.com.hk

							
	
								Association of Mutual Funds In India, IN

								
								amfiindia

								
								http://www.amfiindia.com

							
	
								Athens Stock Exchange, GR

								
								asegr

								
								http://www.ase.gr

							
	
								Australian Stock Exchange, AU

								
								asx

								
								http://www.asx.com.au

							
	
								BAMOSZ funds, HU

								
								bamosz

								
								http://www.bamosz.hu

							
	
								BMO NesbittBurns, CA

								
								bmonesbittburns

								
								http://bmonesbittburns.com

							
	
								Bucharest Stock Exchange (Bursa de Valori Bucuresti), RO

								
								bsero

								
								http://www.bvb.ro

							
	
								Budapest Stock Exchange (BET), ex-BUX, HU

								
								bse or bet

								
								http://www.bet.hu

							
	
								Citywire Funds, GB

								
								citywire

								
								http://citywire.co.uk

							
	
								Colombo Stock Exchange, LK

								
								cse

								
								http://www.cse.lk
								

							
	
								Cominvest Asset Management, ex-Adig, DE

								
								cominvest

								
								http://www.cominvest-am.de

								Obsolete, update: http://eggert.org/software/Comdirect.pm
								

							
	
								Deka Investments, DE

								
								deka

								
								http://www.deka.de

							
	
								DWS, DE

								
								dwsfunds

								
								http://www.dws.de

							
	
								Equinox Unit Trusts, ZA

								
								za_unittrusts

								
								http://www.equinox.co.za

							
	
								Fidelity Investments, US

								
								fidelity_direct

								
								http://www.fidelity.com

							
	
								Finance Canada

								
								financecanada

								
								http://finance.canada.com

							
	
								Financial Times Funds service, GB

								
								ftfunds

								
								http://funds.ft.com

							
	
								Finanzpartner, DE

								
								finanzpartner

								
								http://www.finanzpartner.de

							
	
								First Trust Portfolios, US

								
								ftportfolios_direct

								
								http://www.ftportfolios.com

							
	
								Fund Library, CA

								
								fundlibrary

								
								http://www.fundlibrary.com

							
	
								GoldMoney spot rates, JE

								
								goldmoney

								
								http://www.goldmoney.com

							
	
								HElsinki stock eXchange, FI

								
								hex

								
								http://www.hex.com

							
	
								Man Investments, AU

								
								maninv

								
								http://www.maninvestments.com.au

							
	
								Morningstar, GB

								
								mstaruk

								
								http://morningstar.co.uk

							
	
								Morningstar, JP

								
								morningstarjp

								
								http://www.morningstar.co.jp

							
	
								Morningstar, SE

								
								morningstar

								
								http://www.morningstar.se

							
	
								Motley Fool, US

								
								fool

								
								http://www.fool.com

							
	
								New Zealand stock eXchange, NZ

								
								nzx

								
								http://www.nzx.com

							
	
								Paris Stock Exchange/Boursorama, FR

								
								bourso

								
								http://www.boursorama.com

							
	
								Paris Stock Exchange/LeRevenu, FR

								
								lerevenu

								
								http://bourse.lerevenu.com

							
	
								Platinum Asset Management, AU

								
								platinum

								
								http://www.platinum.com.au

							
	
								SIX Swiss Exchange Funds, CH

								
								sixfunds

								
								http://www.six-swiss-exchange.com

							
	
								SIX Swiss Exchange Shares, CH

								
								sixshares

								
								http://www.six-swiss-exchange.com

							
	
								Skandinaviska Enskilda Banken funds, SE

								
								seb_funds

								
								http://www.seb.se

								Consult http://taz.vv.sebank.se/cgi-bin/pts3/pow/Fonder/kurser/kurslista_body.asp for all available funds.

							
	
								Sharenet, ZA

								
								za

								
								http://www.sharenet.co.za

							
	
								StockHouse Canada, CA

								
								stockhousecanada_fund

								
								http://www.stockhouse.ca

							
	
								TD Waterhouse Canada, CA

								
								tdwaterhouse

								
								http://www.tdwaterhouse.ca

							
	
								TD Efunds, CA

								
								tdefunds

								
								http://www.stockhouse.ca

							
	
								TIAA-CREF, US

								
								tiaacref

								
								http://www.tiaa-cref.org

								Also here were changes, which require at least F::Q 1.18.
								

							
	
								Toronto Stock eXchange, CA

								
								tsx

								
								http://www.TMXmoney.com

							
	
								T. Rowe Price, US

								
								troweprice_direct

								
								http://www.troweprice.com

							
	
								Trustnet, GB

								
								trustnet

								
								http://www.trustnet.co.uk

							
	
								Union Investment, DE

								
								unionfunds

								
								http://www.union-invest.de

							
	
								US Treasury Bonds, US

								
								usfedbonds

								
								http://www.publicdebt.treas.gov

							
	
								US Govt. Thrift Savings Plan, US

								
								tsp

								
								http://www.tsp.gov

							
	
								Vanguard, US

								
								vanguard

								
								part of yahoo_us module

							
	
								VWD, DE (unmaintained)

								
								vwd

								
								
									See https://lists.gnucash.org/pipermail/gnucash-user/2008-February/023686.html
								

							
	
								Yahoo USA

								
								yahoo

								
								http://finance.yahoo.com

							
	
								Yahoo Asia

								
								yahoo_asia

								
								http://sg.finance.yahoo.com

							
	
								Yahoo Australia

								
								yahoo_australia

								
								http://au.finance.yahoo.com

							
	
								Yahoo Brasile

								
								yahoo_brasil

								
								http://br.finance.yahoo.com

							
	
								Yahoo Europa

								
								yahoo_europe

								
								http://finance.uk.yahoo.com

							
	
								Yahoo Nuova Zelanda

								
								yahoo_nz

								
								http://nz.finance.yahoo.com

							
	
								Yahoo Finance through JSON call

								
								yahoo_json

								
								

							
	
								Zuerich Investments (outdated)

								
								zifunds

								
								

							





Finance::Quote Sources - Multiple sources



Tabella A.3. Fonti multiple per le quotazioni
	
								Nome

							
	Asia (Yahoo, ...)
	Australia (ASX, Yahoo, ...)
	Brasile (Yahoo, ...)
	Canada (Yahoo, ...)
	Canada Mutual (Fund Library, ...)
	Dutch (AEX, ...)
	Europa (Yahoo, ...)
	Grecia (ASE, ...)
	India Mutual (AMFI, ...)
	Fidelity (Fidelity, ...)
	Finland (HEX, ...)
	First Trust (First Trust, ...)
	France (Boursorama, ...)
	Nasdaq (Yahoo, ...)
	Nuova Zelanda (Yahoo, ...)
	NYSE (Yahoo, ...)
	Romania (bsero, ...)
	T. Rowe Price
	U.K. Unit Trusts
	USA (Yahoo, Fool ...)




Sources:
				src/engine/gnc-commodity.c:gnc_quote_source (commit 05da881, which was
				adjusted for Finance::Quote 1.38),
      GnuCash-Wiki,
				bugzilla, mailing list archive.
			



Yahoo Specifics



Sommario
Yahoo offers quotes from many exchanges and markets. If you are
				not asking for US markets, you has to specify where to look. A
				typical Yahoo symbol has the form <ISIN><markets suffix>.
			

Tabella A.4. Yahoo Codes for Exchanges and Markets
	
							Country 

							
							Exchange 

							
							Suffix 

							
							Delay 

						
	
							Argentina 

							
							Buenos Aires Stock Exchange 

							
							.BA 

							
							30 min 

						
	
							Australia 

							
							Australian Stock Exchange 

							
							.AX 

							
							20 min 

						
	
							Austria 

							
							Vienna Stock Exchange 

							
							.VI 

							
							15 min 

						
	
							Brazil 

							
							BOVESPA - Sao Paolo Stock Exchange 

							
							.SA 

							
							15 min 

						
	
							Canada 

							
							Toronto Stock Exchange 

							
							.TO 

							
							15 min 

						
	
							Canada 

							
							TSX Venture Exchange 

							
							.V 

							
							15 min 

						
	
							Chile 

							
							Santiago Stock Exchange 

							
							.SN 

							
							15 min 

						
	
							China 

							
							Shanghai Stock Exchange 

							
							.SS 

							
							30 min 

						
	
							China 

							
							Shenzhen Stock Exchange 

							
							.SZ 

							
							30 min 

						
	
							Denmark 

							
							Copenhagen Stock Exchange 

							
							.CO 

							
							15 min 

						
	
							France 

							
							Euronext 

							
							.NX 

							
							15 min 

						
	
							France 

							
							Paris Stock Exchange 

							
							.PA 

							
							15 min 

						
	
							Germany 

							
							Berlin Stock Exchange 

							
							.BE 

							
							15 min 

						
	
							Germany 

							
							Bremen Stock Exchange 

							
							.BM 

							
							15 min 

						
	
							Germany 

							
							Dusseldorf Stock Exchange 

							
							.DU 

							
							15 min 

						
	
							Germany 

							
							Frankfurt Stock Exchange 

							
							.F 

							
							15 min 

						
	
							Germany 

							
							Hamburg Stock Exchange 

							
							.HM 

							
							15 min 

						
	
							Germany 

							
							Hanover Stock Exchange 

							
							.HA 

							
							15 min 

						
	
							Germany 

							
							Munich Stock Exchange 

							
							.MU 

							
							15 min 

						
	
							Germany 

							
							Stuttgart Stock Exchange 

							
							.SG 

							
							15 min 

						
	
							Germany 

							
							XETRA Stock Exchange 

							
							.DE 

							
							15 min 

						
	
							Greece 

							
							Athens Stock Exchange 

							
							.AT 

							
							15 min 

						
	
							Hong Kong 

							
							Hong Kong Stock Exchange 

							
							.HK 

							
							15 min 

						
	
							India 

							
							Bombay Stock Exchange 

							
							.BO 

							
							15 min 

						
	
							India 

							
							National Stock Exchange of India 

							
							.NS 

							
							Real-time** 

						
	
							Indonesia 

							
							Jakarta Stock Exchange 

							
							.JK 

							
							10 min 

						
	
							Israel 

							
							Tel Aviv Stock Exchange 

							
							.TA 

							
							20 min 

						
	
							Italy 

							
							Milan Stock Exchange 

							
							.MI 

							
							20 min 

						
	
							Japan 

							
							Nikkei Indices 

							
							N/A 

							
							30 min 

						
	
							Mexico 

							
							Mexico Stock Exchange 

							
							.MX 

							
							20 min 

						
	
							Netherlands 

							
							Amsterdam Stock Exchange 

							
							.AS 

							
							15 min 

						
	
							New Zealand 

							
							New Zealand Stock Exchange 

							
							.NZ 

							
							20 min 

						
	
							Norway 

							
							Oslo Stock Exchange 

							
							.OL 

							
							15 min 

						
	
							Russia 

							
							Moscow Interbank Currency Exchange (MICEX) 

							
							.ME 

							
							15 min 

						
	
							Singapore 

							
							Singapore Stock Exchange 

							
							.SI 

							
							20 min 

						
	
							South Korea 

							
							Korea Stock Exchange 

							
							.KS 

							
							20 min 

						
	
							South Korea 

							
							KOSDAQ 

							
							.KQ 

							
							20 min 

						
	
							Spain 

							
							Barcelona Stock Exchange 

							
							.BC 

							
							15 min 

						
	
							Spain 

							
							Bilbao Stock Exchange 

							
							.BI 

							
							15 min 

						
	
							Spain 

							
							Madrid Fixed Income Market 

							
							.MF 

							
							15 min 

						
	
							Spain 

							
							Madrid SE C.A.T.S. 

							
							.MC 

							
							15 min 

						
	
							Spain 

							
							Madrid Stock Exchange 

							
							.MA 

							
							15 min 

						
	
							Sweden 

							
							Stockholm Stock Exchange 

							
							.ST 

							
							15 min 

						
	
							Switzerland 

							
							Swiss Exchange 

							
							.SW 

							
							30 min 

						
	
							Taiwan 

							
							Taiwan OTC Exchange 

							
							.TWO 

							
							20 min 

						
	
							Taiwan 

							
							Taiwan Stock Exchange 

							
							.TW 

							
							20 min 

						
	
							United Kingdom 

							
							FTSE Indices 

							
							N/A 

							
							15 min 

						
	
							United Kingdom 

							
							London Stock Exchange 

							
							.L 

							
							20 min 

						
	
							United Kingdom 

							
							London Stock Exchange 

							
							.IL 

							
							20 min 

						
	
							United States of America 

							
							BATS Exchange 

							
							N/A 

							
							Real-time 

						
	
							United States of America 

							
							Chicago Board of Trade 

							
							.CBT 

							
							10 min 

						
	
							United States of America 

							
							Chicago Mercantile Exchange 

							
							.CME 

							
							10 min 

						
	
							United States of America 

							
							Dow Jones Indexes 

							
							N/A 

							
							Real-time 

						
	
							United States of America 

							
							NASDAQ Stock Exchange 

							
							N/A 

							
							Real-time* 

						
	
							United States of America 

							
							New York Board of Trade 

							
							.NYB 

							
							30 min 

						
	
							United States of America 

							
							New York Commodities Exchange 

							
							.CMX 

							
							30 min 

						
	
							United States of America 

							
							New York Mercantile Exchange 

							
							.NYM 

							
							30 min 

						
	
							United States of America 

							
							New York Stock Exchange 

							
							N/A 

							
							Real-time* 

						
	
							United States of America 

							
							NYSE Mkt 

							
							N/A 

							
							Real-time* 

						
	
							United States of America 

							
							OTC Bulletin Board Market 

							
							N/A 

							
							Real-time* 

						
	
							United States of America 

							
							OTC Markets Group 

							
							N/A 

							
							15 min 

						
	
							United States of America 

							
							S & P Indices 

							
							N/A 

							
							Real-time 

						




Source:
			http://help.yahoo.com/l/us/yahoo/finance/quotes/fitadelay.html
			queried at 2012-09-22.

TIAA-CREF Specifics



Sommario

				TIAA-CREF Annuities are not listed on any exchange, unlike their
				mutual funds
				TIAA-CREF provides unit values via a cgi on their
				website. The cgi returns
				a csv file in the format
				


					

bogus_symbol1,price1,date1

bogus_symbol2,price2,date2

..etc.

					

				


				where bogus_symbol takes on the following values for the various
				annuities:
			

Nota
The symbols are case-sensitive and changed their capitalization
				in the last time.
			

Tabella A.5. Pseudo simboli da utilizzare per le quotazioni TIAA-CREF
	
							Nome

							
							Symbol

							
							bogus

						
	
							CREF Bond Market Account

							
							CREFbond

							
							41081991

						
	
							CREF Equity Index Account

							
							CREFequi

							
							41082540

						
	
							CREF Global Equities Account

							
							CREFglob

							
							41081992

						
	
							CREF Growth Account

							
							CREFgrow

							
							41082544

						
	
							CREF Inflation-Linked Bond Account

							
							CREFinfb

							
							41088773

						
	
							CREF Money Market Account

							
							CREFmony

							
							41081993

						
	
							CREF Social Choice Account

							
							CREFsoci

							
							41081994

						
	
							CREF Stock Account

							
							CREFstok

							
							41081995

						
	
							TIAA Real Estate Account

							
							TIAAreal

							
							41091375

						
	
							TIAA-CREF Bond Fund (Retirement)

							
							TIDRX

							
							4530828

						
	
							TIAA-CREF Bond Index Fund (Retirement)

							
							TBIRX

							
							20739662

						
	
							TIAA-CREF Bond Plus Fund (Retirement)

							
							TCBRX

							
							4530816

						
	
							TIAA-CREF Emerging Markets Equity Fund (Retirement)

							
							TEMSX

							
							26176543

						
	
							TIAA-CREF Emerging Markets Equity Index Fund (Retirement)
							

							
							TEQSX

							
							26176547

						
	
							TIAA-CREF Equity Index Fund (Retirement)

							
							TIQRX

							
							4530786

						
	
							TIAA-CREF Global Natural Resources Fund (Retirement)

							
							TNRRX

							
							39444919

						
	
							TIAA-CREF Growth & Income Fund (Retirement)

							
							TRGIX

							
							312536

						
	
							TIAA-CREF High Yield Fund (Retirement)

							
							TIHRX

							
							4530821

						
	
							TIAA-CREF Inflation-Linked Bond Fund (Retirement)

							
							TIKRX

							
							4530829

						
	
							TIAA-CREF International Equity Fund (Retirement)

							
							TRERX

							
							302323

						
	
							TIAA-CREF International Equity Index Fund (Retirement)
							

							
							TRIEX

							
							300269

						
	
							TIAA-CREF Large-Cap Growth Fund (Retirement)

							
							TILRX

							
							4530785

						
	
							TIAA-CREF Large-Cap Growth Index Fund (Retirement)

							
							TRIRX

							
							299525

						
	
							TIAA-CREF Large-Cap Value Fund (Retirement)

							
							TRLCX

							
							301332

						
	
							TIAA-CREF Large-Cap Value Index Fund (Retirement)

							
							TRCVX

							
							304333

						
	
							TIAA-CREF Lifecycle 2010 Fund (Retirement)

							
							TCLEX

							
							302817

						
	
							TIAA-CREF Lifecycle 2015 Fund (Retirement)

							
							TCLIX

							
							302393

						
	
							TIAA-CREF Lifecycle 2020 Fund (Retirement)

							
							TCLTX

							
							307774

						
	
							TIAA-CREF Lifecycle 2025 Fund (Retirement)

							
							TCLFX

							
							313994

						
	
							TIAA-CREF Lifecycle 2030 Fund (Retirement)

							
							TCLNX

							
							307240

						
	
							TIAA-CREF Lifecycle 2035 Fund (Retirement)

							
							TCLRX

							
							309003

						
	
							TIAA-CREF Lifecycle 2040 Fund (Retirement)

							
							TCLOX

							
							300959

						
	
							TIAA-CREF Lifecycle 2045 Fund (Retirement)

							
							TTFRX

							
							9467597

						
	
							TIAA-CREF Lifecycle 2050 Fund (Retirement)

							
							TLFRX

							
							9467596

						
	
							TIAA-CREF Lifecycle 2055 Fund (Retirement)

							
							TTRLX

							
							34211330

						
	
							TIAA-CREF Lifecycle Index 2010 Fund (Retirement)

							
							TLTRX

							
							21066482

						
	
							TIAA-CREF Lifecycle Index 2015 Fund (Retirement)

							
							TLGRX

							
							21066496

						
	
							TIAA-CREF Lifecycle Index 2020 Fund (Retirement)

							
							TLWRX

							
							21066479

						
	
							TIAA-CREF Lifecycle Index 2025 Fund (Retirement)

							
							TLQRX

							
							21066485

						
	
							TIAA-CREF Lifecycle Index 2030 Fund (Retirement)

							
							TLHRX

							
							21066435

						
	
							TIAA-CREF Lifecycle Index 2035 Fund (Retirement)

							
							TLYRX

							
							21066475

						
	
							TIAA-CREF Lifecycle Index 2040 Fund (Retirement)

							
							TLZRX

							
							21066473

						
	
							TIAA-CREF Lifecycle Index 2045 Fund (Retirement)

							
							TLMRX

							
							21066488

						
	
							TIAA-CREF Lifecycle Index 2050 Fund (Retirement)

							
							TLLRX

							
							21066490

						
	
							TIAA-CREF Lifecycle Index 2055 Fund (Retirement)

							
							TTIRX

							
							34211328

						
	
							TIAA-CREF Lifecycle Index Retirement Income Fund
								(Retirement)
							

							
							TRCIX

							
							21066468

						
	
							TIAA-CREF Lifecycle Retirement Income Fund (Retirement)
							

							
							TLIRX

							
							9467594

						
	
							TIAA-CREF Lifestyle Aggressive Growth Fund (Retirement)
							

							
							TSARX

							
							40508431

						
	
							TIAA-CREF Lifestyle Conservative Fund (Retirement)

							
							TSCTX

							
							40508433

						
	
							TIAA-CREF Lifestyle Growth Fund (Retirement)

							
							TSGRX

							
							40508437

						
	
							TIAA-CREF Lifestyle Income Fund (Retirement)

							
							TLSRX

							
							40508427

						
	
							TIAA-CREF Lifestyle Moderate Fund (Retirement)

							
							TSMTX

							
							40508460

						
	
							TIAA-CREF Managed Allocation Fund (Retirement)

							
							TITRX

							
							4530825

						
	
							TIAA-CREF Mid-Cap Growth Fund (Retirement)

							
							TRGMX

							
							305499

						
	
							TIAA-CREF Mid-Cap Value Fund (Retirement)

							
							TRVRX

							
							315272

						
	
							TIAA-CREF Money Market Fund (Retirement)

							
							TIEXX

							
							4530771

						
	
							TIAA-CREF Real Estate Securities Fund (Retirement)

							
							TRRSX

							
							300081

						
	
							TIAA-CREF S&P 500 Index Fund (Retirement)

							
							TRSPX

							
							306105

						
	
							TIAA-CREF Short-Term Bond Fund (Retirement)

							
							TISRX

							
							4530818

						
	
							TIAA-CREF Small-Cap Blend Index Fund (Retirement)

							
							TRBIX

							
							314644

						
	
							TIAA-CREF Small-Cap Equity Fund (Retirement)

							
							TRSEX

							
							299968

						
	
							TIAA-CREF Social Choice Equity Fund (Retirement)

							
							TRSCX

							
							300078

						
	
							TIAA-CREF Bond Fund (Institutional)

							
							TIBDX

							
							307276

						
	
							TIAA-CREF Bond Index Fund (Institutional)

							
							TBIIX

							
							20739664

						
	
							TIAA-CREF Bond Plus Fund (Institutional)

							
							TIBFX

							
							4530820

						
	
							TIAA-CREF Emerging Markets Equity Fund (Institutional)
							

							
							TEMLX

							
							26176540

						
	
							TIAA-CREF Emerging Markets Equity Index Fund
								(Institutional)
							

							
							TEQLX

							
							26176544

						
	
							TIAA-CREF Enhanced International Equity Index Fund
								(Institutional)
							

							
							TFIIX

							
							9467603

						
	
							TIAA-CREF Enhanced Large-Cap Growth Index Fund
								(Institutional)
							

							
							TLIIX

							
							9467602

						
	
							TIAA-CREF Enhanced Large-Cap Value Index Fund
								(Institutional)
							

							
							TEVIX

							
							9467606

						
	
							TIAA-CREF Equity Index Fund (Institutional)

							
							TIEIX

							
							301718

						
	
							TIAA-CREF Global Natural Resources Fund (Institutional)
							

							
							TNRIX

							
							39444916

						
	
							TIAA-CREF Growth & Income Fund (Institutional)

							
							TIGRX

							
							314719

						
	
							TIAA-CREF High Yield Fund (Institutional)

							
							TIHYX

							
							4530798

						
	
							TIAA-CREF Inflation-Linked Bond Fund (Institutional)

							
							TIILX

							
							316693

						
	
							TIAA-CREF International Equity Fund (Institutional)

							
							TIIEX

							
							305980

						
	
							TIAA-CREF International Equity Index Fund (Institutional)
							

							
							TCIEX

							
							303673

						
	
							TIAA-CREF Large-Cap Growth Fund (Institutional)

							
							TILGX

							
							4530800

						
	
							TIAA-CREF Large-Cap Growth Index Fund (Institutional)
							

							
							TILIX

							
							297809

						
	
							TIAA-CREF Large-Cap Value Fund (Institutional)

							
							TRLIX

							
							300692

						
	
							TIAA-CREF Large-Cap Value Index Fund (Institutional)

							
							TILVX

							
							302308

						
	
							TIAA-CREF Lifecycle 2010 Fund (Institutional)

							
							TCTIX

							
							4912376

						
	
							TIAA-CREF Lifecycle 2015 Fund (Institutional)

							
							TCNIX

							
							4912355

						
	
							TIAA-CREF Lifecycle 2020 Fund (Institutional)

							
							TCWIX

							
							4912377

						
	
							TIAA-CREF Lifecycle 2025 Fund (Institutional)

							
							TCYIX

							
							4912384

						
	
							TIAA-CREF Lifecycle 2030 Fund (Institutional)

							
							TCRIX

							
							4912364

						
	
							TIAA-CREF Lifecycle 2035 Fund (Institutional)

							
							TCIIX

							
							4912375

						
	
							TIAA-CREF Lifecycle 2040 Fund (Institutional)

							
							TCOIX

							
							4912387

						
	
							TIAA-CREF Lifecycle 2045 Fund (Institutional)

							
							TTFIX

							
							9467607

						
	
							TIAA-CREF Lifecycle 2050 Fund (Institutional)

							
							TFTIX

							
							9467601

						
	
							TIAA-CREF Lifecycle 2055 Fund (Institutional)

							
							TTRIX

							
							34211329

						
	
							TIAA-CREF Lifecycle Index 2010 Fund (Institutional)

							
							TLTIX

							
							21066484

						
	
							TIAA-CREF Lifecycle Index 2015 Fund (Institutional)

							
							TLFIX

							
							21066498

						
	
							TIAA-CREF Lifecycle Index 2020 Fund (Institutional)

							
							TLWIX

							
							21066480

						
	
							TIAA-CREF Lifecycle Index 2025 Fund (Institutional)

							
							TLQIX

							
							21066486

						
	
							TIAA-CREF Lifecycle Index 2030 Fund (Institutional)

							
							TLHIX

							
							21066495

						
	
							TIAA-CREF Lifecycle Index 2035 Fund (Institutional)

							
							TLYIX

							
							21066477

						
	
							TIAA-CREF Lifecycle Index 2040 Fund (Institutional)

							
							TLZIX

							
							21066474

						
	
							TIAA-CREF Lifecycle Index 2045 Fund (Institutional)

							
							TLXIX

							
							21066478

						
	
							TIAA-CREF Lifecycle Index 2050 Fund (Institutional)

							
							TLLIX

							
							21066492

						
	
							TIAA-CREF Lifecycle Index 2055 Fund (Institutional)

							
							TTIIX

							
							34211326

						
	
							TIAA-CREF Lifecycle Index Retirement Income Fund
								(Institutional)
							

							
							TRILX

							
							21066463

						
	
							TIAA-CREF Lifecycle Retirement Income Fund (Institutional)
							

							
							TLRIX

							
							9467595

						
	
							TIAA-CREF Lifestyle Aggressive Growth Fund (Institutional)
							

							
							TSAIX

							
							40508428

						
	
							TIAA-CREF Lifestyle Conservative Fund (Institutional)
							

							
							TCSIX

							
							40508425

						
	
							TIAA-CREF Lifestyle Growth Fund (Institutional)

							
							TSGGX

							
							40508434

						
	
							TIAA-CREF Lifestyle Income Fund (Institutional)

							
							TSITX

							
							40508450

						
	
							TIAA-CREF Lifestyle Moderate Fund (Institutional)

							
							TSIMX

							
							40508443

						
	
							TIAA-CREF Managed Allocation Fund (Institutional)

							
							TIMIX

							
							4530787

						
	
							TIAA-CREF Mid-Cap Growth Fund (Institutional)

							
							TRPWX

							
							297210

						
	
							TIAA-CREF Mid-Cap Value Fund (Institutional)

							
							TIMVX

							
							316178

						
	
							TIAA-CREF Money Market Fund (Institutional)

							
							TCIXX

							
							313650

						
	
							TIAA-CREF Real Estate Securities Fund (Institutional)
							

							
							TIREX

							
							303475

						
	
							TIAA-CREF S&P 500 Index Fund (Institutional)

							
							TISPX

							
							306658

						
	
							TIAA-CREF Short-Term Bond Fund (Institutional)

							
							TISIX

							
							4530784

						
	
							TIAA-CREF Small-Cap Blend Index Fund (Institutional)

							
							TISBX

							
							309018

						
	
							TIAA-CREF Small-Cap Equity Fund (Institutional)

							
							TISEX

							
							301622

						
	
							TIAA-CREF Social Choice Equity Fund (Institutional)

							
							TISCX

							
							301897

						
	
							TIAA-CREF Tax-Exempt Bond Fund (Institutional)

							
							TITIX

							
							4530819

						
	
							TIAA-CREF Bond Fund (Retail)

							
							TIORX

							
							4530794

						
	
							TIAA-CREF Bond Index Fund (Retail)

							
							TBILX

							
							20739663

						
	
							TIAA-CREF Bond Plus Fund (Retail)

							
							TCBPX

							
							4530788

						
	
							TIAA-CREF Emerging Markets Equity Fund (Retail)

							
							TEMRX

							
							26176542

						
	
							TIAA-CREF Emerging Markets Equity Index Fund (Retail)
							

							
							TEQKX

							
							26176545

						
	
							TIAA-CREF Equity Index Fund (Retail)

							
							TINRX

							
							4530797

						
	
							TIAA-CREF Global Natural Resources Fund (Retail)

							
							TNRLX

							
							39444917

						
	
							TIAA-CREF Growth & Income Fund (Retail)

							
							TIIRX

							
							4530790

						
	
							TIAA-CREF High Yield Fund (Retail)

							
							TIYRX

							
							4530830

						
	
							TIAA-CREF Inflation-Linked Bond Fund (Retail)

							
							TCILX

							
							313727

						
	
							TIAA-CREF International Equity Fund (Retail)

							
							TIERX

							
							4530827

						
	
							TIAA-CREF Large-Cap Growth Fund (Retail)

							
							TIRTX

							
							4530791

						
	
							TIAA-CREF Large-Cap Value Fund (Retail)

							
							TCLCX

							
							302696

						
	
							TIAA-CREF Lifecycle Retirement Income Fund (Retail)

							
							TLRRX

							
							9467600

						
	
							TIAA-CREF Lifestyle Aggressive Growth Fund (Retail)

							
							TSALX

							
							40508429

						
	
							TIAA-CREF Lifestyle Conservative Fund (Retail)

							
							TSCLX

							
							40508432

						
	
							TIAA-CREF Lifestyle Growth Fund (Retail)

							
							TSGLX

							
							40508435

						
	
							TIAA-CREF Lifestyle Income Fund (Retail)

							
							TSILX

							
							40508438

						
	
							TIAA-CREF Lifestyle Moderate Fund (Retail)

							
							TSMLX

							
							40508453

						
	
							TIAA-CREF Managed Allocation Fund (Retail)

							
							TIMRX

							
							4530817

						
	
							TIAA-CREF Mid-Cap Growth Fund (Retail)

							
							TCMGX

							
							305208

						
	
							TIAA-CREF Mid-Cap Value Fund (Retail)

							
							TCMVX

							
							313995

						
	
							TIAA-CREF Money Market Fund (Retail)

							
							TIRXX

							
							4530775

						
	
							TIAA-CREF Real Estate Securities Fund (Retail)

							
							TCREX

							
							309567

						
	
							TIAA-CREF Short-Term Bond Fund (Retail)

							
							TCTRX

							
							4530822

						
	
							TIAA-CREF Small-Cap Equity Fund (Retail)

							
							TCSEX

							
							297477

						
	
							TIAA-CREF Social Choice Equity Fund (Retail)

							
							TICRX

							
							4530792

						
	
							TIAA-CREF Tax-Exempt Bond Fund (Retail)

							
							TIXRX

							
							4530793

						
	
							TIAA-CREF Bond Fund (Premier)

							
							TIDPX

							
							21066506

						
	
							TIAA-CREF Bond Index Fund (Premier)

							
							TBIPX

							
							21066534

						
	
							TIAA-CREF Bond Plus Fund (Premier)

							
							TBPPX

							
							21066533

						
	
							TIAA-CREF Emerging Markets Equity Fund (Premier)

							
							TEMPX

							
							26176541

						
	
							TIAA-CREF Emerging Markets Equity Index Fund (Premier)
							

							
							TEQPX

							
							26176546

						
	
							TIAA-CREF Equity Index Fund (Premier)

							
							TCEPX

							
							21066530

						
	
							TIAA-CREF Global Natural Resources Fund (Premier)

							
							TNRPX

							
							39444918

						
	
							TIAA-CREF Growth & Income Fund (Premier)

							
							TRPGX

							
							21066461

						
	
							TIAA-CREF High Yield Fund (Premier)

							
							TIHPX

							
							21066501

						
	
							TIAA-CREF Inflation-Linked Bond Fund (Premier)

							
							TIKPX

							
							21066500

						
	
							TIAA-CREF International Equity Fund (Premier)

							
							TREPX

							
							21066466

						
	
							TIAA-CREF International Equity Index Fund (Premier)

							
							TRIPX

							
							21066462

						
	
							TIAA-CREF Large-Cap Growth Fund (Premier)

							
							TILPX

							
							21066499

						
	
							TIAA-CREF Large-Cap Value Fund (Premier)
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Appendice B. GNU Free Documentation License

Versione 1.1, marzo 2000

Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.




0. PREAMBLE



The purpose of this License is to make a manual, textbook, or other written document «free» in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.
This License is a kind of «copyleft», which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.
We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.


1. APPLICABILITY AND DEFINITIONS



This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The «Document», below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as «you».
A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.
A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.
The «Invariant Sections» are certain  Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.
The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.
A «Transparent» copy of the  Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.
The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING



You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.
You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY



If you publish printed copies of the Document numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.
If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.
If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy of the Document, free of added material, which the general network-using public has access to download anonymously at no charge using public-standard network protocols. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.
It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS



You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:
	A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

	B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has less than five).

	C. State on the Title Page the name of the publisher of the Modified Version, as the publisher.

	D. Preserve all the copyright notices of the Document.

	E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

	F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

	G. Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given in the Document’s license notice.

	H. Include an unaltered copy of this License.

	I. Preserve the section entitled «History», and its title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled «History» in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

	J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the «History» section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

	K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

	L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

	M. Delete any section entitled «Endorsements». Such a section may not be included in the Modified Version.

	N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant Section.



If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other section titles.
You may add a section entitled «Endorsements», provided it contains nothing but endorsements of your Modified Version by various parties--for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.
You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.
The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version .

5. COMBINING DOCUMENTS



You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice.
The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.
In the combination, you must combine any sections entitled «History» in the various original documents, forming one section entitled «History»; likewise combine any sections entitled «Acknowledgements», and any sections entitled «Dedications». You must delete all sections entitled «Endorsements.»

6. COLLECTIONS OF DOCUMENTS



You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all other respects.
You may extract a single document from such a collection, and dispbibute it individually under this License, provided you insert a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS



A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation is called an «aggregate», and this License does not apply to the other self-contained works thus compiled with the Document , on account of their being thus compiled, if they are not themselves derivative works of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION



Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing  Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License provided that you also include the original English version of this License. In case of a disagreement between the translation and the original English version of this License, the original English version will prevail.

9. TERMINATION



You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE



The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.
Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License «or any later version» applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the Free Software Foundation.

Addendum



To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices just after the title page:
Copyright Cristian Marchi, 2011
Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.1 or any later version published by the Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy of the license is included in the section entitled «GNU Free Documentation License».


If you have no Invariant Sections, write «with no Invariant Sections» instead of saying which ones are invariant. If you have no Front-Cover Texts, write «no Front-Cover Texts» instead of «Front-Cover Texts being LIST»; likewise for Back-Cover Texts.
If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software license, such as the  GNU General Public License, to permit their use in free software.
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